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Preface
1. About This Guide

The PaperCut NG User Guide covers the setup, management and configuration of Paper-
Cut NG.

For information of how to configure and install PaperCut NG, see the Quick Start Guide in
Chapter 3, Quick Tour, and the accompanying sections like Chapter 12, Configuring Sec-
ondary Print Servers and Locally Attached Printers. Prior to installing the application please
take a few moments to read key sections of this manual. In addition, people new to print/
internet control may also find the accompanying implementation guide available from the
PaperCut Software website useful in managing the deployment process.

The latest version of this manual in HTML and a printable PDF format are available from
the PaperCut Software Pty Ltd website at http://www.papercut.biz/.

2. Expectations & Prerequisites

PaperCut NG is a network based server application. Experience with basic network con-
cepts such and server administration and network connectivity is expected. Prior to in-
stalling or evaluating PaperCut NG you should be familiar with:

• The concept of sharing printers and print servers

• Understanding of client-server relationships

• Understanding of basic security concepts such as permissions, groups and users.

3. Terminology used in this document

To make reading this manual easier, the names of all the screens, tabs and actions from
PaperCut NG are marked up in a different font. The User Details screen for instance.

A sub-screen or tab is indicated with an arrow. User Details → Adjustments means: se-
lect Adjustments & Charges tab from the User Details screen.

User Interface Buttons are indicated like this: Press OK to continue.

System output and keyboard input is indicated with a different font as well.

Field labels are indicated like this Username.

Important

Important notes are marked like this.
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Tip

Tips provide useful advice to make your life easier.

Caution

Indicate situations where you have to be careful what you are doing.

Warning

Where extreme care has to be taken.

4. Notice

While every effort has been taken to ensure the accuracy and usefulness of this guide, we
cannot be held responsible for the occasional inaccuracy or typographical error. If you do
find an error, please let the PaperCut Software Development Team know.

Information in this document is subject to change without notice. The names of companies,
products, people, characters, and data mentioned herein are fictitious and are in no way in-
tended to represent any real individual, company, product, or event, unless otherwise
noted. No part of this document may be reproduced or transmitted in any form without the
express written permission of PaperCut Software Pty Ltd.

PaperCut is a trademark of PaperCut Software Pty Ltd.

(c) Copyright 1999-2006 PaperCut Software Pty Ltd. All rights reserved.
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Chapter 1. Introduction
1.1. What is PaperCut NG?

PaperCut NG is a comprehensive solution designed to manage and control an organiza-
tion's print usage. The expectations of management and control vary from organization to
organization, so PaperCut NG is designed for flexibility to ensure organizations of all types,
ranging from schools, universities and businesses, can utilize the system for their own re-
quirements and purposes. Possible implementations can include:

• Silent activity monitoring

• Visible activity monitoring and expense tracking

• Quota/allowance enforcement

• Up-front user pays systems or pay-per-print systems

In addition PaperCut NG provides system administrators with a kit of tools to manage print-
er including:

• Advanced print document/job filtering

• Detailed logging and reporting

1.1.1. Benefits

Some of the key benefits of PaperCut NG are:

• Transfer accountability to users or departments by individually tracking activity.

• Creates responsibility and environmental awareness by drawing users' attention to their
own activities.

• Reduces overall printing cost by virtue of either making users aware of their own activ-
ity, enforcing reasonable quotas, or recovering full costs from end-users.

• Discourages overuse of IT resources.

• Improve efficiency by allowing administrators to "encourage" use of underutilized print-
ers and/or servers.

• Improve network reliability by implementing rules to prevent printer queue jams, queue
hogging, and inappropriate printing types.

1.1.2. Key Features

Some of the key features of PaperCut NG are:

• Track all printing activity by user, client, printer and document metadata.
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• Enforce per user quotas, allowances or budgets

• Full differential print cost/charging system allowing different costs to be assigned on a
per printer basis with advanced options to charge different amounts based on docu-
ment type.

• Hardware neutral solution support all major printer types and operating systems. No
hardware vendor lock-in!

• Both cross-platform and multi-platform support. Run a mix of Windows and/or Linux
print servers and support clients ranging from Windows, Mac, Linux and Unix.

• Provides end-users with management options such as funds transfers, usage tracking
and reporting.

• Provides end-users with advanced options to allocate print jobs to shared accounts,
cost centers, faculties or departments.

• Single sign-on user authentication with native integration with Active Directory or the
system's underlying user management. (no separate passwords to manage!)

• Flexible hold/release queue support with Release Station software allowing administrat-
ors to implement approved and secure printing environments.

• Service Oriented Architecture utilizing the latest software design methods including, test
driven development, XML Web Services and layered architecture. This ensures scalab-
ility and stability by design.

• Advanced reporting and charts available in standard formats including PDF, Excel, and
HTML. All reports accessible from anywhere on the network via a standard web
browser.

• Ability to run on top of leading 3rd party Relational Database Management Systems
(RDMS) including Microsoft SQL Server and PostgreSQL Database.

• Enterprise level security and encryption based on SSL.

• Open architecture with source code access and API documentation.

1.1.3. System Requirements

PaperCut NG supports the following server platforms:

• Microsoft Windows Server 2003

• Microsoft Windows 2000 (Pro and Server)

• Microsoft Windows XP (Pro)

• Macintosh OS X 10.4+ with Java 5 support (both PowerPC and Intel supported)

• Most modern Linux Operating Systems including:

• Red Hat Enterprise Linux (AS 3.0, ES 3.0, AS 4.0, ES 4.0)

• Novell SuSE Linux (8.2, 9.0+)

• Fedora Core

• Debian (3.1+)
With print queues hosted via:

• Samba based print queues

• CUPS based print queues

Servers and clients must use user ID/username based authentication (e.g. Active Direct-
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ory, Windows NT, LDAP, or local system accounts).

Sites with more than 500 users should consider a server class system with more than
512MB of RAM and 500 MB of free disk space.

PaperCut NG supports approximately 90% of printers on the market. Where possible we
recommend printers that support one of the two major printer language standard - Post-
script or PCL. Up-to-date information on printer compatibility is covered on the PaperCut
Software website knowledge base at: PaperCut Knowledgebase Printer Information
[http://www.papercut.biz/kb/Main/SupportedPrinters]

On workstation clients:

• All supported Microsoft Windows platforms (Windows 98 and later)

• Macintosh OSX (Java 5.0 required for optional client tool)

• Most modern Linux Operating Systems (Java 5.0 required for optional client tool)

1.2. How does PaperCut NG work?

Before explaining how PaperCut NG works at a technical and end-user level, the reader
should be familiar with the following key concepts.

1.2.1. Key Concepts

1.2.1.1. Print Server

A print server is a system responsible for hosting print queues and sharing printer re-
sources to desktop clients/workstations. Users on the workstations submit print jobs to a
print server rather then directly to the printer itself. A print server may be a dedicated serv-
er but on most networks this server may also perform other tasks such as file serving.

1.2.1.2. Print Queue

A print queue is first-in-first-out queue listing all jobs pending on a given printer.

1.2.1.3. User ID/Username

In a multi-user environment, users log on to a network or computer using a username and
password. These are often managed by services such as Active Directory or LDAP. The
username is known as the user's identity. PaperCut NG uses this identity to track printing.

1.2.1.4. Client/Server Model

Client software is a small program that runs on each workstation and communicates with a
server. The printing process on most networks works on a client/server model with clients
(workstations) submitting jobs to a server. PaperCut NG also uses optional client software
to help provide information to end-users. This also runs in a client/server model.

1.2.1.5. Application Server

An application server is a server program responsible for centrally processing “business lo-
gic” and providing services to end-users. PaperCut NG uses the application server model
to provide a “business logic” unit for calculating user costs and providing a web browser in-
terface to end-users.
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1.2.1.6. Information Provider

A provider is a software component or program responsible for providing information to an
Application Server. PaperCut NG uses providers to submit print queue/job information to its
application server. This information provider is called the Print Provider. Other importation
providers included with PaperCut NG include user directory and authentication providers.

1.2.1.7. Web Application Interface

A web application is a software program that interacts with end-users via a web browser.
Examples range from Google, Microsoft SharePoint, Hotmail, Internet banking and router
management consoles. PaperCut NG provides a web-based interface for system adminis-
tration and management. Web applications offer administration flexibility by allowing ac-
cess from any location on the network and avoid the need for installation of separate soft-
ware.

1.2.2. Understanding the print process flow

To help explain what PaperCut NG is and how it works we'll introduce the system by ex-
ample.

The student's perspective:

1. Matt is a student at a local high school. He has logged onto the network using his
username, matt.j.smith, and is surfing the Internet. He would like to print out a
web page for his school assignment.

2. The network administrator has allocated Matt a printing credit budget of $10.00 a
month. He can see his current account balance of $4.50 in the PaperCut Client Tool
window.

Figure 1.1. The user client tool

3. Matt prints the web page. 5 pages come out of the printer.

4. The network administrator has set a cost-per-page inside PaperCut on the printer at
$0.10. Matt's 5 page document costs $0.50.

5. Matt's account balance is now at $4.00. He may continue to print until his account
drops to zero.

The teacher's perspective:

1. John is a science and mathematics teacher at the same local high school.

2. John needs to print out a presentation consisting of 122 page science worksheet for
his next class.
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3. The network administrator has granted John access to charge to either his personal
account or to either the Science Department or Math Department's shared accounts.

4. John presses the Print button in the application.

5. The PaperCut client tool displays a popup and presents John with information about
the print jobs and requests an account selection.

6. John selects the science department's shared account from the list.

Figure 1.2. The User Client account selection popup

7. The print job is charged to the science department's account.

The technical perspective:

1. When the teacher, John, prints his 150 page print jobs, his workstation transfers the
print job to the server and places it in the print queue.

Figure 1.3. The Windows print queue

2. The PaperCut Print Provider intercepts the print job in the queue prior to printing and
analyzes the information determining:
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a. Who printed the document

b. The number of pages in the document

c. Other information such as duplex, grayscale mode, paper size, etc.

3. The Print Provider submits the job's information to the Application Server to process
the “business logic”.

4. The Application Server determines that John needs to select the account to charge. It
notifies the Client Software on John's desktop.

5. The Client Software displays the Popup requesting the account.

6. After John selects the client account, the Application Server is notified of John selec-
tion.

7. The Application Server charges the appropriate account, logs the job and instructs the
Print Provider to transfer the document onto the printer.

1.2.3. Architecture Overview

PaperCut NG was developed using the latest software development strategies, a strong in-
fluence being Service Oriented Architecture (SOA). The Print Provider, Application Server
and Client Software all communication uses XML based web services over HTTP.

Figure 1.4. PaperCut NG Architecture - an advanced configuration

A more detailed explanation of the architecture and how it relates to a multi-server installa-
tion can be found in subsequent sections.

1.3. The Top-Ten Hidden Features!
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Much of PaperCut NG flexibility and usefulness comes not from the features you can see,
but from the advanced hidden features. PaperCut NG is packed full of handy tools, utilities
and options and you will read about these throughout this guide. To provide a quick over-
view now, the most popular hidden features are:

1.3.1. One: Remote Administration

PaperCut NG is a 100% web based application. Full system administration can be per-
formed from anywhere on the network via a standard web browser - no special admin soft-
ware is required! To access the administration section, point a browser at the server on
port 9191:

http://[server_name]:9191/admin

Encrypted SSL/HTTPS access is also available on port 9192:

https://[server_name]:9192/admin

Access is granted to the built-in admin, or to any user that has been granted administrator
level access.

1.3.2. Two: Secondary Servers and Local Printers

PaperCut NG is an enterprise level application designed to be managed and control from a
central location. Multi-server environments are common in large organizations and Paper-
Cut NG handles them with ease. All servers are configured to report back to the central Ap-
plication Server. This ensures that all management, logging and control is centralized on
the one location. These secondary servers simply run a light weight monitoring component
and communicate to the central server via XML Web Services calls.

Would you like to run some of your printers on an alternate operating system such as
Linux? Again, no problem! PaperCut NG supports mixed or heterogeneous networks as
well!

You can also use PaperCut NG to manage local desktop printers directly attached to a
workstation! Just treat the workstation as a Secondary Server and install the monitoring
component as normal!

See Chapter 12, Configuring Secondary Print Servers and Locally Attached Printers for
more information.

1.3.3. Three: Customizable Web Interface

Did you know that the end-user interface can be quickly customized to make it look like an
official part of your organization's infrastructure? With some simple HTML, you can make
PaperCut NG end-user interface look just like your existing web site or intranet site.

See Section 13.2, “Customizing the User web pages” for more information.

1.3.4. Four: XML Web Services and Command-line Control

It seems like everything these days is Web Services enabled. Not to be outdone, PaperCut

Introduction

7



NG exposes dozens of API's via secured XML Web Services. This provides advanced ad-
ministrators and developers with the ability to programmatically remotely control, integrate
and manage the application. The possibilities are endless... some of our users now have
their library fines hooked into the PaperCut NG system!

In addition to the Web Services API's, system administrators may hook into the inner work-
ings of PaperCut NG via our advanced server-command application. This simple, but
powerful command-line tool provides command based access to dozens of system func-
tions. Maybe you have batch files or scripts managing back-ups, account creation or sys-
tem maintenance. With server-command you can quickly integrate PaperCut NG into
your existing infrastructure. Some ideas:

1. Schedule "online" backups to coordinate with your existing backup processes. No
need to take the system down to take a data snapshot.

2. Create users in PaperCut NG automatically and as part of your exist user creation
scripts.

3. Automatically schedule user/group synchronization with Active Directory or another
environment. Have full control of how and when synchronization takes place.

See Section A.3, “The XML Web Services API” and Section A.1, “Server Commands
(server-command)” for more information.

1.3.5. Five: Release Station Support

Do you have problems with users forgetting to collect their print jobs or other users acci-
dentally picking up the wrong document? With PaperCut NG's secure print release station
support, administrators can alleviate many of these problems. PaperCut NG's hold/release
queues are also ideally suited to an education environments and Internet Cafes where per-
print-approval or pay-per-print is required.

See Chapter 9, Print Release Stations for more information.

1.3.6. Six: Text Print Logs

PaperCut NG maintains a real-time tab-delimited text log listing all printing activity in de-
tails. The system already includes advanced analysis tools such as reports, statistics and
graphs, however many organizations would like to use the data for their own ad-hoc ana-
lysis. The real-time text print logs can be tapped and extract into applications such as ex-
ternal databases, scripts and even Microsoft Excel.

See Section 13.3, “Data Access and Custom Reports” for more information.

1.3.7. Seven: 3rd Party Database Support

PaperCut NG ships with its own preconfigured and self-maintaining database. The system
however is database independent and can be run on top of a number of leading database
systems. Maybe you have an existing Microsoft SQL Cluster and would like to take advant-
ages of this infrastructure. No problem! PaperCut NG can be quickly configured to hook in-
to your preferred database.

See Chapter 15, Deployment on an External RDBMS for more information.

1.3.8. Eight: Zero-install Client Deployment
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PaperCut NG is implemented using 100% server-side logic and no client software is re-
quired. A simple lightweight client tool is however provided so end-users have access to
advanced features such as shared accounts and the option of viewing their account bal-
ance in a popup window.

Deploying client software can be a time consuming and fiddly process. To streamline the
process PaperCut NG allows its client to be run directly off a network share - no need to in-
stall locally, or mess around with deployment tools! Just set the executable as a startup
program.

See Chapter 6, User Client for more information.

1.3.9. Nine: Shared Accounts

Many organizations would like to track their printing on more than a per-user level. With the
Shared Accounts feature, users can allocate jobs to cost areas such as Faculties, Depart-
ments, Cost Centers, or Pools. Shared accounts are selected via a simple customizable
popup window. Access is control via integrated network group membership or PIN's.

See Chapter 7, Shared Accounts for more information.

1.3.10. Ten: The Development Team

Software is only as good as the development process. PaperCut NG is developed in an
open and transparent fashion by a small development team. Suggestions and feedback
are encouraged and source code access is provided to our customers. The team works
closely with key system users to architect new features. A member of the development
team is online for 8 hours a day and is always happy to chat. Come visit us on our Live
Web Chat page!

See the PaperCut Software website http://www.papercut.biz/ for more information.

1.4. Quick Start Guide (for Windows)

PaperCut NG can be set up in just a few minutes on any conforming system currently host-
ing a printer. This quick start guide walks through the installation process step-by-step. An
outline of the main tasks include:

1. Checking system requirements

2. Downloading and installing PaperCut NG

3. Running the configuration wizard

4. Printing a test document and verifying charging has occurred

5. Accessing and printing from another workstation

Important

This guide assumes that you are using Windows Server 2003. The process is
similar for other Windows operating systems. Separate documentation exists
for Linux (see Section 1.5, “Quick Start Guide (for Linux)”) and Mac (see Sec-
tion 1.6, “Quick Start Guide (for Mac Servers)”).

If you're upgrading from a previous PaperCut NG version, please refer to the
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directions outlined in Appendix E, Upgrading From a Previous Version.

1.4.1. Step 1 - Checking system requirements

Before installing PaperCut NG for either evaluation or production use, the system adminis-
trator should take a few minutes to verify system requirements.

Is the operating system version supported and patches up-to-date? Take a few minutes to
verify the system is current and supported (see Section 1.1.3, “System Requirements”).

Are printer(s) installed and hosted on this system? PaperCut NG needs to be installed on
the system directly hosting the printer(s). The printer should be installed as a "Local Print-
er" with a connection method such as TCP/IP Port, LPR, or JetDirect or directly connected
to the system via USB or LPT Port.

In a multi-user environment, printers are often shared with other network users. Other
workstations should connect to these printers as "Network Printers". Ensure workstations
are configured to print to the shared print queues. For example a Windows workstation
may connect to a printer via a path like: \\[samba_server]\[printer].

If the printers are currently not installed and configured, this task should be performed and
verified now before preceding further.

Figure 1.5. Network printer configuration

Important

If you are running the PaperCut NG server or clients on Windows XP
(Professional or Home edition), please see Appendix B, Troubleshooting &
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Technical FAQ's.

1.4.2. Step 2 - Downloading and installing PaperCut NG

PaperCut NG may be downloaded from http://www.papercut.biz/. After the download is
complete, run the setup wizard as an administrator level user.

Figure 1.6. Setup wizard

Install PaperCut NG onto a hard drive with adequate free disk space.

1.4.3. Step 3 - Running the configuration wizard

After the installation has completed you will be presented with an option to open the config-
uration wizard. The configuration wizard must be completed before the system can be ac-
cessed.
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Figure 1.7. PaperCut NG Configuration wizard

The configuration stages are explained below.

1.4.3.1. Administrator Password

This is the master password for the main admin account. This password is independent of
the operating system or domain passwords. Keep knowledge of this password secure!

Tip

Treat this password like your router/modem management passwords. It is in-
dependent of your domain accounts and needs to be kept secure.

1.4.3.2. Default Print Cost

This is the default cost-per-page assigned to the printers. This setting can be changed on a
per printer basis after installation. Choosing a sensible cost now will help minimize future
setup. For example in the USA, a value of $0.05 would be appropriate for many standard
black & white printers.

1.4.3.3. Initial User Credit

Users can be assigned an initial starting credit. This ensures they have funds in their ac-
count as soon as the system is enabled. An option also exists to control what happens
when users run out of credit/quota. If you are evaluating PaperCut NG it might be appropri-
ate not to disable printing when a users funds run out. This way you can be assured that
user printing is not disrupted during the evaluation. These settings may be changed after
setup.

1.4.3.4. User/group synchronization

PaperCut NG extracts user information out of the system, domain or Active Directory. If
you're using a Windows Server running Active Directory, select the Active Directory option.
This offers access to Organization Units, Nested Groups and other AD features.
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During evaluation, most sites will opt to import all users from the system/domain into Pa-
perCut NG. An option also exists to import a subset of users from a given group. This op-
tion is pertinent when it is known that only a subset of users will only ever use the printers.

Figure 1.8. User sync configuration wizard page

After completing the configuration wizard you will be presented with a user synchronization
status screen. After this is complete the interface will offer an option to Login. Take some
time to log in and browse the interface. There are many options and now is a good time to
have a look at some of the key areas of the application. Take some time to explore!

1.4.4. Step 4 - Printing a test document and verifying charging has occurred

It is now time to test the system.

1. Print a test document such as a web page or basic document.

2. Navigate to the printer section and select the Print Log tab.

3. Navigate to the Printers → Print Log tab.

4. Your print job should now be listed in the log.

5. Your user account should also be charged an appropriate amount.

1.4.5. Step 5 - Accessing and printing from another workstation

If running PaperCut NG on a multi-computer network, it is appropriate to test the system
from another workstation.

1. Log onto a remote workstation as a standard user. Check that the printer shared on
the print server is set up and listed under Start → Printers.

2. Print a test document such as a web page or a Microsoft Word document.

3. Start the client tool by opening a file explorer (Windows Explorer) and navigating to:
\\[servername]\pcclient. Replace [servername] with the network name as-
sociated with the server.

4. Run the program pc-client.exe. The account balance window should display.
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Figure 1.9. User client

5. Click on the Details link. The web browser should open. Alternatively you may open a
standard web browser to the URL http://[servername]:9191/user. Enter the
user's username and password. You are now in the user section.

6. Click on the print history section. Your test print job should be listed.

Important

The client tool is optional and not required for monitoring or charging. It
provides:

• A quick overview of the user's account balance

• A way to access user pages with one click

• Deliver messages to the users

• Advanced features such as the account selection popup

The client is usually set to run automatically when the user logs into the sys-
tem. Setup and deployment is covered in detail later in this manual (See Sec-
tion 6.1, “User Client Deployment”).

1.4.6. Step 6 - Configure print queue permissions (Optional)

When using release stations or account selection popups it is recommended to secure the
print queue so that users do not have permission to pause/resume documents in the
queue. This allows PaperCut NG to have full control of documents without interference
from users. To do this:

1. Log onto the server hosting the printers as an Administrator.

2. Open the printer configuration screen: Start → Printers

3. Right-click a printer and select Properties.

4. Select the Security tab.

5. Select the CREATOR OWNER user and uncheck the Manage Documents permis-
sion. See Figure 1.10, “Configuring Windows print queue permissions”

6. Press the OK button.

7. Perform these steps for each of the monitored printers.
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Figure 1.10. Configuring Windows print queue permissions

1.4.7. What next?

This concludes the Quick Start Guide (for Windows). You may like to take some time to ex-
plore the features of PaperCut NG before continuing reading at Chapter 2, Implementation
by Example or Chapter 3, Quick Tour.

1.5. Quick Start Guide (for Linux)

Important

The following section assumes the reader has knowledge of general Unix/
Linux system management including using the command-line, creating users,
editing configuration files and understanding file permissions.

PaperCut NG can be set up on a conforming Linux system currently hosting printers. This
quick start guide walks through the installation process step-by-step. An outline of the main
tasks include:

1. Check system requirements

2. Create the host user account

3. Download and install

4. Run the configuration wizard

5. Configure printers
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6. Print a test document and verify charging has occurred

7. Share client software to workstations

8. Access and print from another workstation

The quick start guide provides a basic overview of the installation and configuration pro-
cedure. For a detailed explanation of the process and an understanding of the underlying
steps, please see Chapter 17, PaperCut NG on Linux.

1.5.1. Step 1 - Checking system requirements

Before proceeding with the installation the system administrator should take a few mo-
ments to verify system requirements. Is the operating system version supported and are
patches up-to-date? Take a few minutes to verify the system is current and supported (see
Section 1.1.3, “System Requirements”).

Are printer(s) installed and hosted on this system and are they exposed to the network
either via CUPS or Samba? Administrators should ensure that the print queues are set up
and working as expected before attempting to install PaperCut NG.

In a multi-user environment, printers are often shared with other network users. Other
workstations should connect to these printers as "Network Printers". Ensure workstations
are configured to print to the shared print queues. For example a Windows workstation
may connect to a samba exposed printer via \\[samba_server]\[printer].

If the printers are currently not installed and configured, this task should be performed and
verified before proceeding further.

1.5.2. Step 2 - Creating the host user account

PaperCut NG runs and installs under a non-privileged user account called "papercut". The
installation location is denoted by the papercut user's home directory. Create a user ac-
count on this system called papercut. This is usually done by logging in as root and at
the command prompt entering:

shell> useradd -d /home/papercut papercut

The syntax for useradd and groupadd may differ slightly on different versions of Linux.
They may also be called adduser and addgroup.

The user's home directory (the -d option) denotes the install location. /home/papercut
is the recommended location. Administrators may however also consider alternate install
locations depending on personal preference. Alternates including:

• /usr/local/papercut

• /opt/papercut

Important

This quick start guide assumes the install location is /home/papercut. If an
alternate home location is defined, some of the paths listed in subsequent sec-
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tions will require modification.

1.5.3. Step 3 - Downloading and installing

PaperCut NG is supplied as a self-extracting and self-installing archive. Log on as the
newly created papercut user and download and execute the installer:

shell> su - papercut
shell> wget [download url from PaperCut Software website]
shell> sh ./pcng-setup-linux-i686.sh

Follow the installation instructions and enter the root password when requested.

Important

Ensure you login as the user papercut so that the user's environment is
sourced so the home directory (install location) is correctly defined.

Figure 1.11. The Linux install process

1.5.4. Step 4 - Running the configuration wizard

After the installation has completed, open a web browser on any network connected sys-
tem and connect to http//[server_name]:9191/admin. The configuration wizard will
display. The configuration wizard must be completed before the system can be accessed.

Important
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The Application Server listens for connections on port 9191 and 9192 (SSL).
Ensure that any local IP filtering software such as iptables is not configured
to block any local network traffic on this port. Some desktop style Linux distri-
butions may have strict IPTables filtering enabled by default.

Figure 1.12. PaperCut NG Configuration wizard

The configuration stages in the configuration wizard are explained below.

1.5.4.1. Administrator Password

This is the master password for the main admin account. This password is independent of
the operating system or domain passwords. Keep knowledge of this password secure!

Tip

Treat this password like your router/modem management passwords. It is in-
dependent of your domain accounts and needs to be kept secure.

1.5.4.2. Default Print Cost

This is the default cost-per-page assigned to the printers. This setting can be changed on a
per printer basis after installation. Choosing a sensible cost now will help minimize future
setup. For example in the USA, a value of $0.05 would be appropriate for many standard
black & white printers.

1.5.4.3. Initial User Credit

Users can be assigned an initial starting credit. This ensures they have funds in their ac-
count as soon as the system is enabled. An option also exists to control what happens
when users run out of credit or exceed their quota. If you are evaluating PaperCut NG it
might be appropriate not to disable printing when a user's funds run out. This way you can
be assured that user printing is not disrupted during the evaluation. These settings may be
changed after setup.
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1.5.4.4. User/group synchronization

PaperCut NG imports user information out of the system or domain. On a Linux system
three options are normally available:

• Unix Standard (e.g. PAM, nsswitch, passwd/group)

• Samba

• LDAP

Select Unix Standard if the user accounts are setup and defined on the local system as
standard Unix accounts or mapped into the system from a central directory service such as
LDAP or eDirectory via nsswitch.conf and PAM. Most large established networks will use
this option.

Select Samba if the central user directory is a Windows Domain. The Samba option is only
available if Samba is installed on the system. The Samba option is appropriate on medium
to small networks currently operating in a Windows Domain environment.

The Samba option requires additional information such as the name of a domain server,
and login credentials for an Administrator level account. This information is requested on
the subsequent wizard screen. Take care to ensure this information is complete and cor-
rect.

More information on user/group synchronization on Linux is available in Chapter 17, Paper-
Cut NG on Linux.

During evaluation, most sites will opt to import all users from the system/domain into Pa-
perCut NG. An option also exists to import a subset of users from a given group. This op-
tion is pertinent when it is known that only a subset of users will only ever use the printers.

Figure 1.13. User sync configuration wizard page

After completing the configuration wizard you will be presented with a user synchronization
status screen. After this is completed, the interface will offer an option to Login. Take
some time to log in and browse the interface. There are many options and now is a good
time to have a look at some of the key areas of the application. Take some time to explore!
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1.5.5. Step 5 - Configuring Printers

1.5.5.1. CUPS

If the print queues are managed and controlled via CUPS, the Device URI on each printer
should be modified so the papercut backend is incorporated into the print process. This
can be done either via the CUPS web admin interface or by manually editing the CUPS
printers.conf file.

1. Open the printers.conf (e.g. /etc/cups/printers.conf)

2. Prefix the DeviceURL for each printers with "papercut:". For example:

DeviceURI socket://192.168.1.200:9100

Would become:

DeviceURI papercut:socket://192.168.1.200:9100

3. Restart cupsd so the new configuration is detected (e.g. /etc/init.d/cupsd re-
load)

1.5.5.2. Samba

If the print queues are exposed to network workstations using Samba (Samba Website)
[http://www.samba.org/], and a print system other than CUPS is used (e.g. BSD, LPRNG,
SYSV, etc.) the smb.conf needs some additional configuration. The "print command"
needs to be replaced with a PaperCut NG command.

1. Open the smb.conf (e.g. /etc/samba/smb.conf)

2. Under the [globals] section insert the line:

print command=/home/papercut/providers/print/linux-i686/samba-print-provider
-u "%u" -J "%J" -h "%h" -m "%m" -p "%p" -s "%s"
-a "[standard print command]" &

(IMPORTANT: The above information should appear all on a single line.
Note the use of the & (ampersand) on the end of the line.)

where [standard print command] is the command that would normally called for
printing. Typical examples of commands usually used for printer are listed below:

Type Command

BSD, AIX, QNX, LPRNG or PLP lpr -r -P%p %s

SYSV or HPUX lp -c -d%p %s; rm %s

Table 1.1. Standard print commands
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More information on standard print commands is available under the Samba docu-
mentation installed on your system (see man smb.conf).

1.5.6. Step 6 - Print a test document and verify charging has occurred

To detect and register the printer with the PaperCut NG system, a test print job needs to be
performed on each printer (printers are added to the system on first print). Perform a test
print on each printer and verify that it is now listed in the PaperCut NG interface under the
Printers. Perform a number of test prints to verify that multi-page documents are account-
ing as expected. Repeat this process for each printer.

1.5.7. Step 7 - Sharing client software

PaperCut NG includes optional client software. The client software can be run on worksta-
tions to provide users with popup messages, feedback on their account balance, and ac-
cess to advanced features such as shared accounts.

Client software is usually made available to workstations by "sharing" the client directory in
a read-only form. Common sharing methods on Linux system include:

• Samba - to share files to Windows based workstations.

• NFS - to share to Linux/Unix based workstations.

To share the client directory using Samba:

1. Log into the system as root

2. Open the Samba configuration file smb.conf in a text editor. (e.g. /
etc/samba/smb.conf)

3. Define a new share as follows:

[pcclient]
comment = PaperCut Client
read only = yes
public = yes
path = /home/papercut/client

4. Save the file and restart Samba to apply the changes. (e.g. /etc/init.d/samba
restart)

1.5.8. Step 8 - Accessing and printing from another workstation

The following section assumes the remote system is a Microsoft Windows based worksta-
tion.

1. Log onto a remote workstation as a standard user. Check that the printer shared on
the print server is set up and listed under Start → Printers.

2. Print a test document such as a web page or a Microsoft Word document.

3. Start the client tool by opening a file explorer (Windows Explorer) and navigating to:
\\[servername]\pcclient. Replace [servername] with the network name as-
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sociated with the server.

4. Run the program pc-client.exe. The account balance window should display.

Figure 1.14. User client

5. Click on the Details link. The web browser should open. Alternatively you may open a
standard web browser to the URL http://[servername]:9191/user. Enter the
user's username and password. You are now in the user section.

6. Click on the print history section. Your test print job should be listed.

Important

The client tool is optional and not required for monitoring or charging. It
provides:

• A quick overview of the user's account balance

• A way to access to user pages with one client

• Deliver messages to the users

• Advanced features such as the account selection popup

The client is usually set to run automatically when the user logs into the sys-
tem. Setup and deployment is covered in detail later in this manual (See Sec-
tion 6.1, “User Client Deployment”).

Tip

Further information on setting up and configuring PaperCut NG on Linux is
available in Chapter 17, PaperCut NG on Linux.

1.5.9. What next?

This concludes the Quick Start Guide (for Linux). You may like to take some time to ex-
plore the features of PaperCut NG before continuing reading at Chapter 2, Implementation
by Example or Chapter 3, Quick Tour.

1.6. Quick Start Guide (for Mac Servers)
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Important

The following section assumes the reader has knowledge of general Mac OS
X server management. Although the installation process is graphical, know-
ledge of the command-line, creating users, editing configuration files and an
understanding file permissions would be of assistance.

PaperCut NG can be set up on a conforming Macintosh system currently hosting printers.
This quick start guide walks through the installation process step-by-step. An outline of the
main tasks include:

1. Check system requirements

2. Create the host user account

3. Download and install

4. Run the configuration wizard

5. Configure printers

6. Print a test document and verify charging has occurred

7. Share client software to workstations

8. Access and print from another workstation

The quick start guide provides a basic overview of the installation and configuration pro-
cedure. For a detailed explanation of Mac printing in detail, please see Chapter 19, Mac
Printing in Detail.

1.6.1. Step 1 - Checking system requirements

Before proceeding with the installation the system administrator should take a few mo-
ments to verify system requirements. Is the operating system version supported and are
patches up-to-date? Take a few minutes to verify the system is current and supported (see
Section 1.1.3, “System Requirements”). A system prerequisite is Java version 5.0 or high-
er. If Java 5 is not already installed, the installer is available from the Apple website at: ht-
tp://www.apple.com/support/downloads/java2se50release3.html.

Administrators should ensure that the print queues are set up and working as expected be-
fore attempting to install PaperCut NG.

In a multi-user environment, printers are often shared over the network. On Mac servers,
print queues are shared via CUPS using IPP (Internet Printing Protocol). It is important that
other workstations on the network print to the server's print queues rather than connecting
directly to the printer. On a Apple Mac workstation, an IPP printer should be added pointing
to the server's IP address. The standard procedure can be summarize as follows:

1. Install the printers on the server using the manufacture's suggested procedure. For
convience, give the printer a simple name without spaces. Network printers connected
via JetDirect (socket) or LPR are recommended. Test local printing directly from the
server.

2. Ensure printer sharing is enabled. System administrators running firewalls should also
confirm that port 631 (the standard CUPS port) is accessible from the local network.

3. Add the printer(s) on the workstation(s) using the Printer Setup Utility. Select IP
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Printer and the IPP - Internet Printing Protocol. Enter your server name/IP and the
name of the printer setup in point 1.

4. Print form the workstation and confirm that printing is logged in PaperCut NG.

If the printers are currently not installed and configured, this task should be performed and
verified before proceeding further.

1.6.2. Step 2 - Creating the host user account (optional)

PaperCut NG runs under a non-privileged user account called "papercut". This invisible
system account is created automatically upon first install. Advanced system administrators
may however have a preference to create this account manually. If you fall into this cat-
egory, create the papercut account now prior to installation.

1.6.3. Step 3 - Downloading and installing

PaperCut NG is supplied as a standard disk image containing the installer. Log on as an
admin level account. Download and double-click Mac installer. Double-click on the installer
package named PaperCut NG Standard Installation.pkg. Follow the directions
on the screen. The installation process will take between two and five minutes depending
on the speed of the system.

The default install location is /Applications/PaperCut NG

Figure 1.15. The Mac installer

Important

Make sure you're installing the correct package. The similarly named Paper-
Cut NG Secondary Server Installation.pkg only installs part of the
application and is designed for more advanced networks.

1.6.4. Step 4 - Running the configuration wizard

After the installation has completed, the installer will open a web browser at the address
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http//[server_name]:9191/admin. If the browser does not open, double-click on the
file located at /Applications/PaperCut NG/Admin Login.URL. The browser will
display the configuration wizard and must be completed before the system can be ac-
cessed.

Important

The Application Server listens for connections on port 9191. Ensure that any
local IP firewall is configured to allow local network traffic on ports 9191 and
9192 (SSL). The Mac firewall settings are located under System Preferences
→ Sharing → Firewall.

Figure 1.16. PaperCut NG Configuration wizard

The configuration stages in the configuration wizard are explained below.

1.6.4.1. Administrator Password

This is the master password for the main admin account. This password is independent of
the operating system or domain passwords. Keep knowledge of this password secure!

Tip

Treat this password like your router/modem management passwords. It is in-
dependent of your network domain or local system accounts and needs to be
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kept secure.

1.6.4.2. Default Print Cost

This is the default cost-per-page assigned to the printers. This setting can be changed on a
per printer basis after installation. Choosing a sensible cost now will help minimize future
setup. For example in the USA, a value of $0.05 would be appropriate for many standard
black & white printers.

1.6.4.3. Initial User Credit

Users can be assigned an initial starting credit. This ensures they have funds in their ac-
count as soon as the system is enabled. An option also exists to control what happens
when users run out of credit or exceed their quota. If you are evaluating PaperCut NG it
might be appropriate not to disable printing when a user's funds run out. This way you can
be assured that user printing is not disrupted during the evaluation. These settings may be
changed after setup.

1.6.4.4. User/group synchronization

PaperCut NG imports user information out of the system or domain. Three options are
available on the Mac:

• Mac Standard (PAM, Local NetInfo, etc.)

• LDAP

• Samba

Select Mac Standard if the user accounts are setup and defined on the local system as
standard Unix accounts or mapped into the system from a central directory service such as
LDAP. Most large established networks will use this option.

The LDAP option is appropriate for large networks with existing LDAP domains. This in-
cludes networks running Mac OS X Server with Open Directory, and Windows domains
running Active Directory.

More information on LDAP is available in Section 10.2.2, “Using LDAP for user synchroniz-
ation”.

The Samba option is appropriate on medium to small networks currently operating in a
Windows Domain environment.

The Samba option requires additional information such as the name of a domain server,
and login credentials for an Administrator level account. This information is requested on
the subsequent wizard screen. Take care to ensure this information is complete and cor-
rect.

During evaluation, most sites will opt to import all users from the system/domain into Pa-
perCut NG. An option also exists to import a subset of users from a given group. This op-
tion is pertinent when it is known that only a subset of users will only ever use the printers.
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Figure 1.17. User sync configuration wizard page

After completing the configuration wizard you will be presented with a user synchronization
status screen. After this is completed, the interface will offer an option to Login. Take
some time to log in and browse the interface. There are many options and now is a good
time to have a look at some of the key areas of the application. Take some time to explore!

1.6.5. Step 5 - Configuring Printers

PaperCut NG works by hooking into the CUPS print system. The hook is implemented on a
per printer basis and by default all printers are monitored. If the system currently hosts
printers in a "production environment", it may be advisable to only initially enable monitor-
ing on a single printer. After successful initial testing, the monitoring can be re-enabled on
all other printers.

The simplest way to enable/disable monitoring on a printer is to execute the command
script at /Applications/PaperCut NG/Configure CUPS.command. This script al-
lows the administrator to enable/disable PaperCut NG on selected printers. Please read
the script's instructions carefully and also ensure that the Print Setup Utility is closed/quit
when running this script.

Note

At the technical level, Macs use the Common Unix Print System (CUPS). Pa-
perCut NG tracks printing by integrating with CUPS. (For system administrat-
ors familiar with CUPS, PaperCut NG integrates by wrapping or proxying the
CUPS backend). The Configure CUPS.command script simply edits the file
/etc/cups/printers.conf and prefixes the DeviceURI with "paper-
cut:", enabling monitoring on the selected printer.

System administrators with command-line UNIX experience may prefer to edit
the printers.conf directly with a text editor.

1.6.6. Step 6 - Print a test document and verify charging has occurred

To detect and register the printer with the PaperCut NG system, a test print job needs to be
performed on each printer (printers are added to the system on first print). Perform a test
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print on each printer and verify that it is now listed in the PaperCut NG interface under the
Printers. Perform a number of test prints to verify that multi-page documents are account-
ing as expected. Repeat this process for each printer.

1.6.7. Step 7 - Sharing client software

PaperCut NG includes optional client software. The client software can be run on worksta-
tions to provide users with popup messages, feedback on their account balance, and ac-
cess to advanced features such as shared accounts.

Client software is usually made available to workstations by "sharing" the /
Applications/PaperCut NG/client folder in a read-only form. Common sharing
methods on Mac system include:

• AFP - used to share to other Mac Systems. Mac OS X Server tools such as the Work-
group Manager or other 3rd party tools such as SharePoint may help with sharing the
client directory via AFP.

• Samba - used to share files to Windows based workstations. Mac OS X Server tools
such as the Workgroup Manager or other 3rd party tools such as SharePoint may help
with sharing the client directory via Samba.

Advanced system administrators may be comfortable sharing this directory by hand-
editing the /etc/smb.conf file. The following configuration will share the directory in
read-only form:

[pcclient]
path = /Applications/PaperCut NG/client
comment = PaperCut Client
public = yes
only guest = yes
read only = yes

• NFS - to share to Linux/Unix based workstations.

1.6.8. Step 8 - Accessing and printing from another workstation

The following section assumes the remote system is a Mac based workstation.

1. Log onto a remote workstation as a standard user. Check that the workstation has the
monitored printer available under Applications → Utilities → Printer Setup Utility.

2. Print a test document such as a web page or a text document.

3. Start the client tool by opening the Finder and browsing to the share set up in the pre-
vious step. For example, Network → [servername] → pcclient.

4. Run the application PCClient.app. The account balance window should display.
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Figure 1.18. User client

5. Click on the Details link. The web browser should open. Alternatively you may open a
standard web browser to the URL http://[servername]:9191/user. Enter the
user's username and password. You are now in the user section.

6. Click on the print history section. Your test print job should be listed.

Important

The client tool is optional and not required for monitoring or charging. It
provides:

• A quick overview of the user's account balance

• A way to access to user pages with one client

• Deliver messages to the users

• Advanced features such as the account selection popup

The client is usually set to run automatically when the user logs into the sys-
tem. Setup and deployment is covered in detail later in this manual (See Sec-
tion 6.1, “User Client Deployment”).

1.6.9. What next?

This concludes the Quick Start Guide (for Mac Servers). You may like to take some time to
explore the features of PaperCut NG before continuing reading at Chapter 2, Implementa-
tion by Example or Chapter 3, Quick Tour.
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Chapter 2. Implementation by
Example

PaperCut NG is a feature-packed application designed to meet the print management re-
quirements of all types of organizations. It's unlikely that any single organization would use
or need all the features in PaperCut NG. The key to a successful implementation is with
identifying the features that are most needed, and utilizing them in the correct manner.

This chapter covers common implementation scenarios in a case study form. It discusses
the requirements common to the scenario, and how these requirements are satisfied using
key features. The aim of this chapter is to guide implementers towards identifying and util-
izing the most appropriate features.

Locate the scenario that's the closest fit to your organization. It may also be beneficial to
read other scenarios that might apply to your situation. For example, a large business may
benefit from some of the ideas presented in the small business case and so on.

2.1. Scenario: The Small School

Fast River School has a student population of 200 and caters to students in Kindergarten
through 6th grade. A teacher is responsible for each class. The school has a two com-
puters in each class room and a small computer lab for older students. All computers are
networked. A single server acts as a domain controller and a file and print server. The stu-
dents in each year level log on to the computers using the username and password alloc-
ated to their class.

2.1.1. Requirements

1. Each grade level has a monthly printing budget of $50.

2. If the budget is exceeded, teachers may discuss additional funding with the school
principal.

3. Student use of color printers should be approved by teachers.

4. The teacher for each grade level should have access to activity reports in order to
track the class's printing volume.

5. The school principle needs a summary report of class printing activity at the end of
each semester.

2.1.2. Implementation

2.1.2.1. Initial Installation

PaperCut NG should be installed on the school's file and print server. The initial installation
process is covered in Section 1.4, “Quick Start Guide (for Windows)”.

2.1.2.2. Requirement 1

The monthly budget can be automated by applying a $50.00 monthly quota to the [All
Users] group. The domain login accounts used for each year level are automatically
placed in the [All Users] group. See the following areas for more information:
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• Section 4.1, “Groups in PaperCut NG”

• Section 4.2, “Setting up quota allocations”

2.1.2.3. Requirement 2

Teachers can be warned when their class's balance has reached a low balance limit. The
notification can be via email. The notification option is located under: Options → Notifica-
tions → Low Balance Notifications. Enable the email option for email notifications.

2.1.2.4. Requirement 3

The system administrator can set up the printers so only selected users (i.e. teachers) can
approve jobs issued to color printers. By selecting the Only managers can release option
on a given printer, jobs are held in a queue. Teachers can then approve the student print
jobs by accessing the web based release software accessed via the URL:

http://server_name:9191/release

Where server_name is the name of the organization's print server.

2.1.2.5. Requirement 4

Teachers can view print activity and account balance by connecting a web browser to:

http://server_name:9191/user

Where server_name is the name of the organization's print server. Access to the end-
user pages is covered in Section 3.5, “Interface Levels”.

2.1.2.6. Requirement 5

Summary reports can quickly be generated by any user with PaperCut NG's system admin-
istrator access. Granting administrator access and running reports is discussed in Sec-
tion 3.6, “Assigning Administrator Level Access”.

2.2. Scenario: The Large School

North Shore High has a student population of 2000 students. Their network consists of:

• Three student Windows PC labs and one Macintosh lab with other computers scattered
around the school for student use.

• A mixture of Mac and Windows laptops used by staff.

• A Windows Active Directory environment hosted on a number of servers.

• Printers are hosted on two separate Windows servers.

• Some teaching staff have desktop printers attached locally to their workstations.

• Each lab has a black and white laser printer.

• Two high-end color copier/printers and large format printers are located in a print room
situated away from the computer labs.

Students have their own login account and small home directories for storage.

Implementation by Example
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2.2.1. Requirements

1. The system must support the mixed Mac and Windows environment.

2. The system should support multiple print servers and locally attached desktop printers.

3. The school would like to experiment with hosting printers on a Linux system with the
aim of using Linux for print serving tasks to help save on future Windows licensing
costs.

4. Students are to be granted a small $5 a month printing budget. Final year students
have a $10 a month allowance.

5. If students need additional printing, they must purchase it. The payment process
should be simple and easy to manage.

6. Jobs issued to printers situated in the print room should be held in a queue and only
printed on the physical printers after the user has arrived at the room to collect the job.

7. Staff members should have the option of charging printing to department accounts or
to a small personal account, depending on the type of print job.

2.2.2. Implementation

2.2.2.1. Initial Installation

The mixture of operating systems and multiple-servers makes this a complex installation.
Prior to deployment, it is advisable for the network manager and/or network administrator
to plan the deployment and familiarize themselves with the PaperCut NG software.

2.2.2.2. Requirement 1

PaperCut NG is a cross platform solution designed for all major operating systems. Given
the existence of an existing domain environment, the installation of Windows systems is
typically straightforward. The Macs however can be set up in a number of different ways.
Network administrators should consult Chapter 19, Mac Printing in Detail.

2.2.2.3. Requirement 2

Multi-server installations are commonplace on larger networks. One system needs to be
nominated as the primary PaperCut NG server. This system is responsible for running the
"brains" of the system and storing all data. The other servers, secondary servers, report
back to the central primary server via XML Web Services. The system architecture, deploy-
ment considerations, and recommendations are outlined in Section 12.5, “Multiple Print
Servers”.

2.2.2.4. Requirement 3

Linux is becoming ever popular in the server space. First web hosting, and now common
file and print services are being serviced with the Linux operating system. PaperCut NG is
available for Windows, Mac and Linux systems. Not only that, its architecture allows all
three systems to run side-by-side sharing a common central server. This school may ex-
periment with hosting printers on Linux by running a Linux based secondary server along-
side their main Windows servers. See Section 12.3, “Configuring a Linux Secondary Print
Server” for additional information.

2.2.2.5. Requirement 4

Implementation by Example
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Quotas or allowances are allocated to users on a per-group basis. By adding network do-
main groups to PaperCut NG that represent the respective student groups, system admin-
istrators can automate the allocation process. See Section 4.2, “Setting up quota alloca-
tions” for further information.

2.2.2.6. Requirement 5

The purchase of additional quota/credit is best managed by the TopUp/Pre-Paid Card sys-
tem. The system reduces the data entry and management requirements associated with
manual transactions. More information on TopUp/Pre-Paid Card cards is covered in
Chapter 11, TopUp/Pre-Paid Cards.

2.2.2.7. Requirement 6

Print release in the print room is best achieved with the release station. By running a spe-
cial full-screen application on a dedicated terminal in this room, students can release their
jobs once they arrive at the room. The release station and secure printing in general is
covered in detail at Chapter 9, Print Release Stations.

2.2.2.8. Requirement 7

Tracking and allocating staff printing to departments is best achieved by using Shared Ac-
counts. When set up, teaching staff are presented with a popup window asking them to se-
lect an account to charge. Account access can be controlled via domain group member-
ship or via PINs. More information on shared accounts is available at Chapter 7, Shared
Accounts.

2.3. Scenario: The University

West Face University has a student population of 10,000 full-time students and off-campus
and part-time students. IT services are centrally control the network, however individual
faculties and departments also offer and manage some of the specialist IT infrastructure.
All major operating systems are in used on both the workstations and servers.

2.3.1. Requirements

1. Centrally managed printers are hosted in a clustered print server environment. The
solution needs to support clustering.

2. IT services wants to provide the option for department labs to also have their printers
controlled via the central system.

3. Client software needs to be optional. It would be preferable for students to have ac-
cess to their account details via a web browser.

4. The design of the web interface should be customizable.

5. The system must be secure and support SSL-based encryption.

6. The system should run on top of a database system and allow data access to facilitate
custom reports using packages such as Crystal Reports.

7. An open source system would be preferable.

2.3.2. Implementation

2.3.2.1. Initial Installation
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University-wide deployments can be quite involved. Most large universities that have de-
ployed PaperCut NG have worked closely with the PaperCut NG development team during
implementation. A lot can be gained by arranging a teleconference or similar with the de-
velopment team. We're always happy to help our larger customers deploy the ideal solu-
tion.

2.3.2.2. Requirement 1

PaperCut NG supports clustering at all application layers including the print server, the
database server, and the application server on both Microsoft Windows and Linux. Setting
up PaperCut NG in Microsoft Clustering Services is covered in Chapter 16, Microsoft
Cluster Environments. The PaperCut NG development team has experience using Linux-
HA (High-Availability Linux) and other tools to support customers who use Linux.

2.3.2.3. Requirement 2

Printers and labs hosted by individual faculties and departments outside the central IT ser-
vices area can optionally be joined into the campus-wide system via PaperCut NG's sec-
ondary server support. Central IT staff can approve these secondary servers via IP ad-
dress and grant selected staff administrator level access to the system's admin web inter-
face on a case-by-case basis. See Chapter 12, Configuring Secondary Print Servers and
Locally Attached Printers for more information on secondary servers.

2.3.2.4. Requirement 3

PaperCut NG's client software is optional in a basic charging/quota environment. Users
can access their accounts and view their account balance, transaction and printing history,
and use advanced tools such as TopUp/Pre-Paid Cards and transfers. More information on
the web-based users tools is available at Section 3.5, “Interface Levels”.

2.3.2.5. Requirement 4

The design and layout of the end-user web interface can quickly be changed using HTML
and Cascading Style Sheets. Customizing the end-user web design is covered in Sec-
tion 13.2, “Customizing the User web pages”.

2.3.2.6. Requirement 5

PaperCut NG provides secure connections for report access and administration via SSL-
based encryption. Larger universities often have their own certificate signing procedure for
SSL based servers. PaperCut NG can even accept these signed certificates. SSL-based
encryption is set up by default and is accessed via a URL such as:

https://[server_name]:9192/admin

Information on using a custom SSL certificate is covered in Section A.4, “SSL/HTTPS Key
Generation”.

2.3.2.7. Requirement 6

Hosting the PaperCut NG system on top of an external database system such as Mi-
crosoft's SQL Server offers a number of advantages including easy data access, better
performance and scalability, and the ability to take advantage of existing backup pro-
cesses. More information on external RDMS support is available at Chapter 15, Deploy-
ment on an External RDBMS.

Implementation by Example

34



The data structure is simple and administrators with report writing skills will quickly be able
to access the data for custom reporting via tools such as MS Access or Crystal Reports.

2.3.2.8. Requirement 7

PaperCut NG is a commercial system with commercial level support. However unlike many
other commercial applications, PaperCut Software Pty Ltd does offer source code access.
A number of universities have used the source code access for:

• auditing - verifying that the software is secure.

• customization - knowing how the application works and how to implement add-ons.

Large universities should also look at the large school scenario. Features such as shared
accounts and secure printing are also applicable to many university environments.

2.4. Scenario: The Small Business

Northwoods Inc. is a small eight-person real-estate agent serving the local area. Their net-
work consists of eight Windows XP workstations connected on a Workgroup based net-
work. Wireless network access is also provided to agents with laptops. Staff work on a
freelance basis and management would like to track and charge for color printer use on a
monthly basis.

2.4.1. Requirements

1. The system must be easy to set up and maintain as there is no full-time IT staff.

2. The system must work in a Windows workgroup environment.

3. Staff are to have unlimited access (i.e. no budgets).

4. Managers need access to view real-time reports.

5. Data should be able to be exported to Excel on a monthly basis for billing.

2.4.2. Implementation

2.4.2.1. Initial Installation

One system on the network needs to be allocated the task of hosting the printer and the
PaperCut NG application. Users will print via this system so it needs to be left on most for
most of the time. An existing file server is ideal, however someone's desktop system will
also suffice.

2.4.2.2. Requirement 1

PaperCut NG is well known for its ease-of-use. It is a self-maintaining system with a simple
to use web-based interface. Apart from the initial set up, and the recommendation to incor-
porate the application's data into a backup procedure, no further technical administration
and support is required.

2.4.2.3. Requirement 2

Workgroup environments are common on small networks. They differ from a domain envir-
onment in that they are not centrally authenticated via a server. Users may use a system
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that automatically logs in as "a user" or maybe they just log in locally on their workstations.
See Chapter 20, Running in a Workgroup Environment for more information on the ways in
which PaperCut NG can be installed in a workgroup environment.

2.4.2.4. Requirement 3

All users can be set up as "unrestricted". In this mode, users can start of with a zero bal-
ance and count down as they print. Their balance indicates their printing value to date.

2.4.2.5. Requirement 4

PaperCut NG records data in real-time. Full print logs and reports are available at any time
and can be accessed using a standard web browser. The manager can log into the admin-
istration interface and access the reports at any time.

2.4.2.6. Requirement 5

All reports and activity lists can be exported to Microsoft Excel. To access the Excel data,
click on the small Excel icon located next to the report name, or the icon at the bottom of
the print log.

2.5. Scenario: The Medium to Large Business

SandComp is a large manufacturing company consisting of 3000 employees spread over 4
sites. All sites are connected via a fast Wide Area Network (WAN). Printers are hosted on
local servers with the largest site hosting printers in a Microsoft Cluster environment.

2.5.1. Requirements

1. Must support a Microsoft Cluster environment.

2. Must centrally store print data on a server located at the main office.

3. Must not cause disruption if the WAN link goes down between offices.

4. The consulting division needs to be able to track printing by project so costs can be
passed back to their clients.

5. The finance department needs secure print release on their shared printers stored in
the utility room.

2.5.2. Implementation

2.5.2.1. Initial Installation

The implementation of PaperCut NG in this environment would best be managed using
staggered or step-by-step approach. First, the software should be installed and tested on
the central offices' clustered environment, then rolled out to the other offices, and finally the
secure printing and client popups should be implemented. A staggered approach is likely to
minimize disruption allowing network administrators to focus on the tasks at hand.

2.5.2.2. Requirement 1

PaperCut NG supports Microsoft Clustering Services. The installation process is docu-
mented at Chapter 16, Microsoft Cluster Environments.
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2.5.2.3. Requirement 2

The print servers at the remote locations can be installed as secondary servers reporting
back to the primary server. All data will be stored in one location. The services communic-
ate using XML Web Services and only consume a few bytes per print job. Hence the sys-
tem will work well over the WAN.

2.5.2.4. Requirement 3

PaperCut NG has a fail-open design. This means that if a failure occurs, such as the net-
work fails between servers, printing will continue as normal.

2.5.2.5. Requirement 4

The consulting division can make use of the share accounts feature to track their printing
by client. More information on shared accounts is available in Chapter 7, Shared Accounts.

2.5.2.6. Requirement 5

Secured print release can be facilitated by setting up a terminal (a low-end PC will do) in
the finance department's utility room. When a member of the finance department prints to a
shared printer, their document will hold in the queue until that member goes to the utility
room and releases the print job with his or her username and password. This process en-
sures that documents stay secure and can't be "accidentally" collected by other people.

2.6. Scenario: The Public Library or Internet Cafe/Kiosk

The Sandy Beach Cafe is a typical Internet cafe offering Internet access, faxing, printing
and other services. This business has 50 computers and two printers. A black & white laser
printer called "Black and White Printer" and a high-end color inkjet system named as "Color
Printer". They would like to implement a pay-per-print system that meets the following pro-
cess and requirements:

2.6.1. Requirements

1. The customer prints the job to the appropriate printer.

2. At the front desk, the customer pays a staff member for the print job.

3. The staff member releases the job for printing.

4. The customer collects the print job.

2.6.2. Implementation

PaperCut NG's release station software is ideally suited to the Internet cafe scenario. More
information on the release station is available at Chapter 9, Print Release Stations. Paper-
Cut NG provides both an application interface for release station managers (i.e. desk staff)
as well as a convenient web browser-based interface. To summarize a typical implementa-
tion:

1. The PaperCut NG server software is installed on the system hosting the printers. An
existing server or desktop system will suffice.

2. Workstations are configured to print to the printers shared on the system set up in step
1.

3. Inside the PaperCut NG admin interface, the printers should have the manager only
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release option selected.

4. Desk staff can view and control pending print jobs, their cost, and other details via the
web based release interface accessible at the URL:

http://server_name:9191/release
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Chapter 3. Quick Tour
This section will guide you through the main areas of the application and cover some com-
mon management tasks.

3.1. Navigation

Before we jump in and start our tour of PaperCut NG it is important to take some time to
understand the application's navigation tools. The subsequent sections detail the major
user interface elements.

3.1.1. Tabs

Figure 3.1. Application navigation tabs

Application areas are grouped into tabs that logically separate parts of the system. Select-
ing a tab displays the controls and information related to that area. Users will be familiar
with the concept of tabs from many other applications.

3.1.2. Actions

Figure 3.2. The Actions area. Click to perform the action.

Throughout the application, the Actions area lists a number of tasks or actions that can be
performed. The Actions list is always located in the top left-hand corner of the application
window. Actions are adaptive and the list of actions changes depending on the area of the
application being viewed.

3.1.3. Buttons
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Figure 3.3. Buttons to validate and save settings

Changes made to options, user settings or configurations are only validated and applied
after submitting the change. Screens that you can save in the application will have the fol-
lowing buttons located at the bottom:

• Apply - Validate and save the changes and return to this location/object

• OK - Validate and save the changes and return to the data list ready to select and edit
another object.

• Cancel - Don't save and changes.

3.1.4. Crumb Trail

Figure 3.4. The crumb trail highlighting the location

The crumb trail serves two purposes. It maps out the navigation path followed by the user
and provides a way to navigate up (back) the navigation path. For example, while editing a
user's account, the crumb trail provides a hyperlink up one level back to the User List.

3.1.5. Status Messages
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Figure 3.5. A red status message indicating a validation error

Important status messages are displayed in the top section of the application window. Mes-
sages relating to an error or requiring user intervention are displayed in red. Standard mes-
sages are displayed in green and cautions in yellow.

3.1.6. Fields

Figure 3.6. A field highlighted indicating a validation error

Configuring printers, users or settings are often done via text fields. Changes made to
fields are validated after pressing OK or Apply buttons. If the field fails validation, the of-
fending data is marked with a red asterisk. Typical validation errors include invalid number
or currency formats.

3.2. Sections

Quick Tour

41



The PaperCut NG administration interface is grouped into task oriented sections. These
are denoted by the tabs at the top of the screen. The sections are:

Figure 3.7. Application navigation tabs

3.2.1. Users

• View a list of all users

• View and change a user's credit balance

• View a user's statistics and charts

• List a user's printing activity

• Change user privileges and settings

• Related sections:

• Section 3.3, “Basic User Operations”

• Chapter 4, Advanced User Management

3.2.2. Groups

• Add/Remove domain or network groups required for user management

• Define rules controlling how new users are created

• Perform bulk user operations

• Control user quota allocations

• Related sections:

• Section 4.1, “Groups in PaperCut NG”

• Chapter 4, Advanced User Management

3.2.3. Accounts

• View, edit and create shared accounts

• View and change the shared accounts credit balance

• List all charges against shared accounts

• Set account access security

• Related sections:

• Chapter 7, Shared Accounts

• Chapter 6, User Client
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3.2.4. Printers

• View and edit printer costs and settings

• Define printer filter rules and restrictions

• View all recent print jobs

• View printer statistics and charts

• Related sections:

• Section 3.4, “Basic Printer Operations”

• Chapter 5, Advanced Printer Management

3.2.5. Reports

• Access to standard reports for viewing, export and printing

• Run “one click” reports for quick overviews

• Run reports over Ad-hoc date ranges

• Related sections:

• Section 3.7, “Charting, Statistics, Reports and Logs”

• Chapter 8, Reports

3.2.6. Cards

• Managed TopUp/Pre-Paid Cards (also known as vouchers)

• View card use and activity

• Download and install the card creation wizard

• Import new cards

• Related sections:

• Chapter 11, TopUp/Pre-Paid Cards

3.2.7. Options

• Access general system settings

• Control administrator access and security

• Perform network user and group synchronization tasks

• Perform backup snapshots

• Related sections:

• Chapter 10, System Management
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• Appendix A, Tools (Advanced)

3.2.8. Application Log

• View system audit, security and application events

• Related sections:

• Chapter 10, System Management

3.2.9. About

• List version and build information

• Access update news

• Install and view license information

• Related sections:

• Chapter 14, Licensing and Support

3.3. Basic User Operations

The user section is dedicated to user management. Common user oriented tasks include
assigning additional credit to users, viewing a user's activity, and controlling user priv-
ileges.

Users in PaperCut NG can be assigned either:

• Restricted access where access to resources is denied once their credit drops to zero
(or to the system overdraft limit).

• Unrestricted access meaning the user is never denied access.

To change a user's restriction privileges:

1. Log in as the built-in admin user.

2. Click on the Users section.

3. Select the user from the list (or enter the user name in the quick find).

4. Scroll down to the Account Details section.

5. Click on the Restricted checkbox.

6. Click on the Apply button to save the change. A save success message will appear.

To increase a user's account balance by $10.00:

1. Select the user from the list (or enter the user name in the quick find).

2. Select the Adjustments and Charges tab.

3. Enter $10.00 in the adjustment field.
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4. Enter a comment to associate with the transaction.

5. Click the Apply button.

Figure 3.8. Adjusting a user's credit up $10.00

To view a user's transaction and print history:

1. Select the user from the list (or enter the user name in the quick find).

2. Select the Transaction History tab to view the user's transaction.

3. Select the Print History tab to view the user's recent print activity.

3.4. Basic Printer Operations

All printers managed by PaperCut NG are configured under the Printers section. Printer
configuration may include:

• Setting a cost-per-pages or defining more complex charging rules.

• Defining advanced filter and restriction rules. For example, configuring a printer to deny
jobs of a selected size or automatically removing duplicate documents.

• Controlling the enabled/disabled status via time-latches.
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To define a basic cost-per-page of $0.10:

1. Log in as the build-in admin user.

2. Select the Printers section.

3. Click on the printer who's page cost is to be defined.

4. Enter a page cost of $0.10 under the configuration section.

5. Press the Apply button to save the change.

To define an advanced cost model offering a 40% discount for duplex (double sided) print-
ing:

1. Under the Printers section, select the printer whose cost model is to be modified.

2. Click on the Advanced Charging tab.

3. Select a charge type of by category.

4. Enter 40% in the duplex discount field and select Percent less from the dropdown list.

5. Click the Apply button to save the change.

Figure 3.9. A 40% discount applied to double-sided printing

Filters provide administrators with access to a set of rules to control what type of docu-
ments are allowed access to the printer. Filter rules can be used for a variety of tasks such
as:

• Enforcing good printing practices

• Preventing queue jamming and hogging

• Ensure printers are used for the purpose they are designed for

Filter options include:

• Control by the jobs cost
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• Control by a document's page count

• Denying jobs based on their color mode

• Filtering by document name

• Automatically denying and deleting duplicate documents

Example - To apply a filter preventing jobs over 100 pages:

1. Under the Printers section, select the printer to which the filter should be applied.

2. Click on the Filters tab.

3. Scroll to the Page Count section.

4. Click and select the deny jobs based on number of pages.

5. Enter in 100 in the maximum filed.

Figure 3.10. Printer Filters and Restrictions

To disable a printer for the next hour using a time latch:

1. Under the Printers section select the printer to lock or disable.

2. On the Summary tab, scroll to the Configuration section.

3. Select Disable for next hour from the drop-down list.

4. Click the Apply button to save the change.
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Figure 3.11. A printer disabled for 1 hour

3.5. Interface Levels

PaperCut NG provides two layers of system access, Admin and User.

3.5.1. Admin Access

Admin access provides access to the system for administration and management. This
level is usually only granted to selected individuals in the organization, such as network ad-
ministrators or management staff.

3.5.2. User Access

End users are granted access to a set of basic web pages providing them with access to:

• View their account balance

• List recent account activity

• Use tools such as TopUp/Pre-Paid Cards and funds transfers to other users

The User Inquiry Tool (PaperCut NG User Client Software) compliments the web pages by
providing users with a quick view of their current account balance.

Important

Access to the user area, like the admin area, requires authentication - that is
the user must enter their network username and password. Authentication is
required because user information such as print history is confidential. Access
to the user's funds transfer feature also needs to be protected. This is particu-
larly important in schools. Students can be rest assured that if they leave their
workstation for a few minutes another student can't transfer their account bal-
ance to themselves!

To access the user pages via the User Inquiry Tool:

1. Start the client software if it is not already running. On the server this may be started
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via the Client Start menu item. See the client software section for details on how to
start this on a remote workstation or desktop.

Figure 3.12. The user client tool

2. Click the Details... link. The web browser will open.

3. Enter your username and password and click Login.

4. The user page pages will display.

To access the user pages directly via a web browser:

1. Open a standard web browser.

2. Enter the URL http://[servername]:9191/user where [server_name] is the
network name assigned to the system running PaperCut NG. The login screen will ap-
pear.

3. Enter your username and password and click Login.

3.6. Assigning Administrator Level Access

PaperCut NG sets up one administrator account called “admin”. This is the master admin-
istrator account, with access to all features, whose password is assigned during the config-
uration wizard. In large organizations it is likely that administrator level access will need to
be granted to more than one person. One solution is to give all persons the master pass-
word; however the recommended approach is to assign administrator rights to these indi-
vidual's network user accounts. The advantages of this approach are:

• They can access the administration pages using their own username and password.
(they don't have to remember another password!)

• Different levels of administrator access can be assigned to the user. PaperCut NG in-
cludes an advanced set of Access Control Lists (ACL) allowing different administrators
access to different functions and areas of the application.

• Most activity is audited so changes can be supervised by identity.

To assign admin rights to a user with login name mary:

1. Log in to the system as the built in admin user.

2. Select the Options section.

3. Scroll down to the Security section. And click the edit link next to the Admin users
field.
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4. Enter mary into the Add new user field and click Add.

5. By default mary will have access to all features. To change this, click on the show/
hide details link to the right of mary's entry.

6. Click on the Apply button to save the change.

7. Verify that Mary can now log into the administrator section either via:

a. The Admin Logon link on the server.

b. Using a web browser at http://[server_name]:9191/admin

Figure 3.13. The list of users granted admin access

Important

PaperCut NG allows different levels of administrator access to be defined via
access control list. The access list is presented as a series of checkboxes en-
abling or disabling access to selected features or application areas.

For security reasons it is advisable to:
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• Grant the user's own accounts administrator level rights rather than have
them use the general built-in admin account.

• Grant the administrator the minimum level rights need for them to perform
their job.

• ACL configuration can be complex. Always test that the ACL rights as-
signed work as expected by asking the administrator to log in and verify
that they can access the required program functions.

3.7. Charting, Statistics, Reports and Logs

One of the key features of PaperCut NG is the advanced charting, statistics, reporting and
logging. This information can be used by administrators to:

• Determine which printers are most used

• Spot areas where printers may be inappropriate for the task.

• View user and printer trends over time.

3.7.1. Charts

Charts are ideal for obtaining a quick visual overview. All users and printers have a line
chart displaying activity over the last 30-days.

Figure 3.14. User 30-day account balance history

The Charts Tab under the Printers section hosts a set comparison charts allowing adminis-
trators to compare printers side by side.
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Figure 3.15. Printer utilization chart

Under each individual printer the Statistics section provides information on all jobs printed
on a given printer.

Figure 3.16. Print page history for a single printer

3.7.2. Reports

Reports provide a tabular data display, often in a printable format, of system information
ranging from activity histories, summaries, transaction details, etc. Reports are typically run
to print a summary of user activity, printer activity, or group or account activity. To stream-
line access to common reports, PaperCut NG provides a series of predefined one-click re-
port links under the Reports section. Most reports can be generated over a variety of com-
mon date ranges or user defined date ranges.
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Standard reports include:

• User Reports

• Print summary statistics grouped by user

• Quick list of the most active print users

• Printer Reports

• Summary of print activity grouped by printer

• Quick lists of the most active/busiest printers

• Group Reports

• Summary of print activity grouped by network group (Note: The group needs to be
defined under the Groups section.)

• Share Account Reports

• Summary of print activity grouped by shared account charged

• Print Log Reports

• Detailed lists of all print jobs over a given period

• Quick list of the largest print jobs

Figure 3.17. Printer report in PDF

Standard reports are provided in a variety of output formats including, HTML, PDF and MS
Excel. PDF reports are ideal for printing. HTML versions of the reports are provided for
systems without a PDF viewer.

Tip

In addition to the standard reports, administrators can run other reports on ad-
hoc data by using the Export/Print option available under most of the data
lists. This is covered further in the subsequent report section (See Chapter 8,
Reports).
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3.7.3. Logging

The PaperCut NG activity logging can be classed into the following areas:

3.7.3.1. Usage Logging

Usage logging records information about usage events such as printing. Information in-
cludes:

• The date of the use

• Who performed the use

• Details of the type of user including, cost and other attributes

Figure 3.18. Printer usage log

3.7.3.2. Transaction Logging

All modifications or deductions to an account (user or shared) are recorded in the transac-
tion log. Information recorded includes:

• The date of the transaction

• Who performed the transaction

• Any comment or note associated with the transaction (if performed by a user)

Figure 3.19. User account transaction log

3.7.3.3. Application Activity Logging

The Application Log records system events messages such as:

• User logins
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• Security errors such as incorrect password attempts

• Backup times and scheduled tasks

• Any system errors or warning

It is similar to the operating system's event log. It is recommended that system administrat-
ors view this log on a daily basis for the first week and weekly thereafter.
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Chapter 4. Advanced User
Management

This section covers some of the more advanced user management tasks. On large net-
works managing users on an individual basis is not practical. Management needs to be
handled either via a level of automation, or manually at group level. Some common user
management tasks that typically consume time on a large network include:

• Allocating user credit or quotas.

• Creating new user accounts

• Performing administration tasks such as allocating additional allowances or applying
different privileges.

PaperCut NG offers a number of features to help automate these tasks.

4.1. Groups in PaperCut NG

Groups are collections of users. PaperCut NG uses the network domain or computer's
groups, meaning administrators can take advantage of the existing network structure.
Groups in PaperCut are used in the following ways:

1. To control how quota/credit is allocated to users on a regular basis.

2. To automate the addition of new (future) user accounts.

3. To assist with making modifications to user accounts by group.

4. For group based reporting.

PaperCut NG mirrors (caches) domain network group memberships for performance reas-
ons. Hence changes in group membership made at the domain level may not be immedi-
ately reflected in PaperCut. The group membership can be refreshed at any time via the
User/Group Sync option under the Options section. Groups are mirror/cached for two
reasons:

• For fast reporting and search performance.

• To ensure PaperCut NG is a good network application and does not overload domain
controllers with group membership requests.

Many large networks may contain hundred of groups and/or organizational units. In many
cases only a small percentage of these groups are pertinent to PaperCut NG management.
To ensure administrators are not overwhelmed with all groups, PaperCut NG only lists the
groups selected as relevant by the administrator.

To add a group to PaperCut NG:

• Navigate to the Group section.

• Select the Add/Remove Group link at the bottom of the groups list.

• Select the group(s) required on the left-hand-side and click the Add arrow.

• Click the OK button to add the group(s).
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Figure 4.1. Adding/removing groups

PaperCut NG includes one built-in group called the [all users] group. This group is not
related to any existing network group and simply is a "catch all" group that represents all
users list in the PaperCut system. It is similar to the "Everyone" special group in Windows.

4.2. Setting up quota allocations

In many organizations PaperCut NG is used to control and restrict users to sensible use by
allocating a quota or allowance (a budget). For example a user may be allocated $10.00 a
week. This type of control is particularly popular in schools and universities. The process of
quota allocation can be automated via the Groups section.

To allocate a $10.00 a week to members of the Students group:

1. Navigate to the Group section

2. Add the Student group via Add/Remove Group if not already listed.

3. Select the Student group

4. Under the Quota Scheduling section, select a period of Weekly and enter 10.00 in
the Schedule amount.

5. Click the Apply button to save the change.
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Figure 4.2. The Group Details screen

Credit will be assigned to group members at just past 12:00am (midnight) on the day of the
schedule. Administrators can verify that this has taken place by inspecting log entries in the
Application event log and/or users' transaction logs.

Task Time

Daily Allocations Applied at 12:10am every day (7 days a
week).

Weekly Allocations Applied at 12:20am on Sunday.

Monthly Allocations Applied at 12:30am on the first day of the
month.

Table 4.1. Quota schedule times

One potential issue associated with quota allocation in some organizations (for example
Schools or Universities) is that users can "bank up" their quota allowance over time leading
to excessive use at periods of the year such as the end of semester. The Only allow ac-
cumulation up to option can be used to implement a "use it or lose it" policy!

4.2.1. Advanced User Quota Management

Some organizations may require scheduling quota allocations for periods other than those
available above. For example, an education organization may like to schedule quota alloc-
ation per term, semester (period) or academic year, which may not have set dates. This
can be achieved by a manual update when necessary though Bulk user actions ... in the
Users or Groups tab. More information is available in Section 4.4, “Bulk User Operations”.

It is also possible to automate the allocation of user quota through the use of Server Com-
mands (see Section A.1, “Server Commands (server-command)”) or XML Web Services
(see Section A.3, “The XML Web Services API”).
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4.2.2. Automated Quota Allocation Example

One way to automate quota allocation is through the use of Server Commands. Following
is an example of how to use Server Commands to automate quota allocation in a Microsoft
Windows environment:

North Shore High would like to automate their quota allocation on a per-term basis. There
are four terms in a year, and terms do not necessarily start on the same date every year.
Junior students are to receive $5 per term printing budget, and senior students are to re-
ceive $10 per term. The domain has the groups junior-students and senior-stu-
dents to reflect the students' grade.

Using the information from Section A.1, “Server Commands (server-command)”, we can
see that the Server Command adjust-user-account-balance-by-group will meet
the needs of this situation. Create a batch file with a name like as-
sign_term_quotas.bat with content similar to the following (depending on your envir-
onment):

cd "C:\Program Files\PaperCut NG\server\bin\win"
server-command adjust-user-account-balance-by-group "junior-students" \

+5.00 "$5 term budget for junior students"
server-command adjust-user-account-balance-by-group "senior-students" \

+10.00 "$10 term budget for senior students"

Note: backslash indicates text should appear on the same line.

Running this script will allocate $5 to all members of the group junior-students, and
$10 to all members of the group senior-students. The script can then be scheduled to
run at the specified dates by the use of a tool such as Windows Task Scheduler ( Control
Panel → Scheduled Tasks → Add Scheduled Task).

4.3. New User Creation Rules

It is inevitable that new users will be added to your network in the future. To streamline ac-
count setup, PaperCut NG offers the option of having new users automatically assigned
initial settings such as starting credit, privilege level, and other settings based on their
group membership. Users are automatically added to PaperCut NG when either:

• The user sends his or her first print job

• Overnight during user/group synchronization

• When a manual user/group synchronization is performed

Taking the time to configure initial settings rules means one less job for administrators to
perform! The group based control offers maximum flexibility and ensures that it's possible
to have a different set of initial settings rules for different types of users. This flexibility is
particularly important in an academic environment where students of different year levels
need different settings.

For example an administrator may wish for new users belonging members of the Senior
Students group to be allocated $10 starting credit and restricted access, while all
other students receive $5.00 starting credit.

New user creation rules are controlled under the Groups → Group Details → New User
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Settings section.

Figure 4.3. Initial settings applied to new users

Important

Changes made to new user settings are in the Groups section only affect
users NOT yet listed in the system. (i.e. future users). Any users already listed
in the system are not affected. To modify settings or credit on existing users,
see bulk user actions in the following section.

Tip

Initial settings can become confusing when a user belongs to more than one
group. PaperCut NG uses the following logic to allocate initial settings:

• The user obtains a starting credit that is the sum of all the matching groups
(the special [all-users] group is ignored).

• If any of the matching groups has unrestricted access, the user will in-
herit unrestricted status.

• If any of the matching groups has account selection popup settings, the
user will inherited the ON settings.

• If the user does NOT belong to any matching group, they will inherit the
settings applied to the special [all-users] group.

4.4. Bulk User Operations

A bulk user operation refers to an operation that is applied to more than one user. This op-
eration was referred to in previous PaperCut releases as "Group level functions". Bulk user
operations are best described by example.

John is a network administrator at a local high school. A number of students from each
year level have been placed on the school newspaper committee. The head teacher has
requested that John allocated an extra $10.00 of printing credit to these students. The stu-
dents are all in a network group called "NewspaperCommittee". John performs this opera-
tion as follows:

1. Clicked the Bulk user actions link under the Users section.
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2. Selected NewspaperCommittee as the group to perform the action on.

3. Selected the Adjust credit by option and entered $10.00 in the amount field.

4. Entered a transaction comment of "extra allowance for newspaper committee role".

5. Clicked the OK button to apply the change.

The bulk user operation applies changes to all users in the selected group. Settings under
the Groups section or shared accounts are not affected.

Warning

Group level operations are one-way and cannot be undone. Always carefully
consider the operation before proceeding. If you are unsure of the function or
behaviour, performing a backup prior to undertaking the operation is advised.

Other bulk user operations available under Bulk user actions include:

• Adjust or set the users' credit (perform a transaction).

• Change the users' restriction status

• Modify account selection popup options

• Reset the users' count statistics

4.5. Batch User Import and Update

The batch import and update feature allows the administrator to import users, user informa-
tion and optionally update existing users details by reading data from a simple text file. In
addition to being able to create users, it enables administrators to update the following user
data:

• Credit balance

• Restriction status

• Full name

• Email address

• Department

• Office

• Card Number

• Notes

Examples of where the batch user import feature is useful include:

• To set the user email addresses that are stored in another system (like a student man-
agement system).

• When moving user balances from previous PaperCut editions to PaperCut NG

• When importing user and balance data from another external system
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For more information on using the batch import to import data from previous PaperCut edi-
tions, please see Appendix F, Upgrading from PaperCut Quota.

Tip

PaperCut NG is designed to import user information from the underlying sys-
tem or network domain. The batch import feature is not designed to replace
this but rather complement it by allowing importing of user data from other sys-
tems our sources.

To perform a batch import:

1. Manually inspect your file in a text editor and ensure it's in the prescribed tab-delimited
format as detailed at Section 4.5.1, “Batch User Import File Format”.

2. Navigate to the Users section.

3. Click the Batch import ... action (on the left).

4. Click Browse to select the file to import. (The format of the file is described in Sec-
tion 4.5.1, “Batch User Import File Format”).

5. Choose whether you want the import to create new users if they do not already exist. If
you clear this checkbox, lines that contain users that do not exist will be ignored and
only existing users will be updated.

6. Press the Import button.

7. Upon completion you will be told how many users were updated and how many users
were created.

Caution

Batch imports are a major operation modifying data on mass. Best practice
suggests:

• Always run a backup before preceding with the import.

• First experiment/test the import process with a small batch of users before
moving onto the full batch.

4.5.1. Batch User Import File Format

The import file is in tab delimited format and contains the following fields in the given order.

Field Description

Username The user's username

Credit Balance The user's credit balance

Restricted Status The user's restricted status. (Y/N)
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Field Description

Full Name The user's full name

Email The user's email address

Department The user's department or faculty

Office The user's office or location

Card Number The user's identity card number

Notes Notes about the user.

Table 4.2. User Import File Format

Tip

A simple way to create a tab delimited file is to create a spreadsheet in Mi-
crosoft Excel, and then save it in the Text (Tab delimited) format.

4.5.1.1. Import File Format Examples

The following lines shows importing all the above fields. (The fields are separated by tabs).

matt 20.00 Y Matt Johnson mattj@email.com Science Dept Head office \
103251 NoteA

john 25.00 N John Jackson jj@domain.com Administration Other office \
963254 NoteB

Note: backslash indicates text should appear on the same line.

The following lines shows importing user email addresses only. NOTE: That the tabs still
exist for balance, restriction, full name fields, but each entry is blank.

matt mattj@email.com
john jj@domain.com

The following lines shows importing the credit balance and full name for the first user and
the credit balance and email address for the second user. NOTE: That the tabs characters
still exist for blank fields.

matt 10.00 Matt Johnson
john 15.00 jj@domain.com
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4.6. Disabling user printing with time latches

PaperCut NG allows printing to be disabled for particular users using time-based locks.
These time latches allow a user's printing to be disabled for a predetermined amount of
time. After this time has passed, the user's printing is re-enabled without the need for
manual intervention. Some examples of where time latches may be useful include:

• Student discipline - Under some circumstances it might be useful to disallow printing for
a student who has been misbehaving in class, abusing computer resources or for other
disciplinary reasons. The user's printing can be disabled for the duration of a class, or
indefinitely. Once the time period has passed, printing will automatically be enabled for
this user.

• Classroom Management - Using the bulk user actions screen, printing can be disabled
for a group of users. This can be useful to stop a classroom from printing for a period of
time.

• User Management - If a employee or student is away for an extended period of time
and may return, printing can be disabled so that their details and balance is unchanged
but no-one can use their account for printing.

The disable printing option is located on each user on the user details screen.

Figure 4.4. User printing disabled using a time-latch

4.7. User Management Quick Reference

How do I add credit to a user?

Select the user from the groups list, and click on the adjust link next to the credit or select
the Adjustment & Charges tab.

How do I add a new user to the system?

PaperCut NG will automatically add users to the system the first time they print. If your new
user initial settings rules are defined correctly under groups section, the user will automat-
ically be created with the designated starting credit and settings.

If you have added a large batch of new users, you can force the addition of these users im-
mediately via the User/group synchronization option under the Options section.

How should I make a change to more than one user?
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If you need to make a change to more than one user, consider using the Bulk user ac-
tions link located under either the User or Groups section. This allows bulk modification of
user settings based on their network group membership.

How do I grant administrator access to a trusted person to manage a group of
users?

Administrator level access can be granted to trusted individuals. See Section 3.6,
“Assigning Administrator Level Access”. By using advanced access control rights, adminis-
trators can be limited to a subset of users (a group) via the option Limit access to users
only in group.
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Chapter 5. Advanced Printer
Management

This section covers some of the more advanced printer management tasks. Advanced
printer management can be grouped into the following high-level concepts:

• Activity monitoring

• Encouraging appropriate use

• Managing the addition of new printers

This section addresses these management areas and covers tools available in PaperCut
NG to assist administrators.

5.1. The Template Printer

The Information Technology field is a rapidly moving environment. Change is driven by two
main forces:

• Business and end-user requirements

• Technology advances

It is change that often consumes a network administrator's time. PaperCut NG endeavors
to alleviate some of the more mundane tasks via automation. The New User Initial Set-
tings section under Groups assists with the creation of new user accounts. The addition of
new printers, although less common, is also inevitable. PaperCut NG helps administrators
streamline new print setup using a concept of a template. A template is a pattern or initial
condition used as a starting point. PaperCut NG has a special virtual printer called the
[template printer]. This is not a real printer, but a special printer used as a template
for printers added in the future.

The [template printer] is best described by an example:

1. Jane is a network administrator at a local business. She has implemented a print
policy across all printers as follows:

a. The page cost for a standard page is $0.10.

b. Double sided printing is encouraged with a 40% discount.

c. A filter exists on all printers to prevent jobs of over 100 pages. This prevents
users from holding up the queues with large single jobs.

2. Jane has set up her policy on all existing printers and then adjusted settings on a print-
er-by-printer basis depending on the type and functions.

3. She has also set up this policy on the [template printer].

4. Two months later Jane adds 4 new printers. No change in PaperCut NG needs to take
place as the printers automatically set themselves up based on the settings in the
[template printer].

5. When Jane has spare time later in the month she fine tunes printer configuration as
required.

66



As the example shows, the template printer not only helps alleviate future configuration
work, but also ensures a consistent policy is applied on printers by default. It brings Paper-
Cut NG one step closer to the "zero-administration" goal.

It is recommended the administrators take a few minutes to configure the template printer
on any network of more than 100 users.

Figure 5.1. The Template Printer

5.2. Copying Printer Settings

Another way to quickly configure printers and have a consistent charging policy is to copy
printer settings (costs, filters, etc.) from one printer to another.

Warning

Copying settings to printers is a one-way operation and cannot be undone. Al-
ways carefully consider the operation before proceeding. If you are unsure of
the function or behavior, performing a backup prior to undertaking the opera-
tion is advised.

To copy printer settings from one printer to another:

1. Navigate to the Printers tab.

2. Select the printer you wish to copy the printer settings from. The Printer Details
screen appears.

3. Click the Copy settings to other printers action link.

4. Choose which settings to copy. There is a choice of the cost and the filter settings.

5. Select the printers to copy the settings to.

6. Press Copy to perform the copy.
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Figure 5.2. Copy settings from one printer to others

5.3. Disabling printers with time latches

A new feature introduced in PaperCut NG is time latch based locks. Time latches allow a
printer to be disabled for a predetermined amount of time. After the disable time has ex-
pired, the printer is re-enabled without the need for manual intervention. Some examples of
where time latches may be useful include:

• Printer maintenance - A printer may be consistently jamming and require maintenance.
The administrator can lock the printer for 24 hours until the maintenance is performed.
Users receive a notification message if they try to use the locked printer.

• Classroom management in schools - A teacher may wish to disable printer use to force
students to focus on their work for the duration of the class. The printer can be locked
for the duration of the class. After the class has finished the printer is re-enabled auto-
matically ready for the next class.

The disable option is located on each printer under the printer configuration area.

Figure 5.3. Printer disabled using a time-latch
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5.4. Managing printing using differential charging

In a quota-based or charged environment, one of the most important tools at the adminis-
trator's disposal is the ability to charge different amounts for different types of documents
or on different types of printers. Printers are designed for a particular task and a particular
work rate. For example an inkjet color printer is ideal for photos or the occasional color
page but should not be used print 1000-page black and white documents when the heavy
duty laser printer is located just down the corridor.

PaperCut NG allows administrators to:

• Charge different cost-per-page amounts for each printer

• Charge different amounts based on the type of document including:

• Discounts for black and white printing

• Discounts for double-sided or duplex printing

• Different amounts based on the size of the page

Administrators can use differential charging to encourage users to use the correct printer
and printer settings for the task at hand. This ensures maximum utilization of the resources
available.

Example: David is a network administrator at a local university. The printer comparison
charts in PaperCut NG suggest that one of the printers on the 4th floor in the computer sci-
ence wing is only used half as much as other printers. Upon investigation he finds that stu-
dents prefer to use the closer printer located in the corridor outside the lab. David decides
to relocate the printer at the end of semester. In the meantime he encourages its use by re-
ducing the price thereby taking load off the other printers.

5.4.1. Charging modes available

PaperCut NG offers a very powerful array of charging rule possibilities. To help simplify
configuration, charging options are divided into modes.

5.4.1.1. Simple Mode

Simple mode is the default mode and is appropriate to all types of printers. It allows admin-
istrators to define a simple cost-per-page setting only. For example if the cost per page
was defined at $0.10, 50 pages would cost $5.00.

5.4.1.2. Charging by Category

Category based charging is the most commonly used mode for printers that support ad-
vanced print attributes including:

• Duplex or double-sided printing

• Color or Black & White printing modes

• Multiple paper trays offering standard and large sizes

Category based charging allows administrators to define costs based on the document's
attributes. Black and white (grayscale) documents can be granted a discount over full col-
or. An option also exists to discount and encourage double-sided printing. Discounts can
be applied either as fixed amounts or as a percentage of document cost.
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A practical example, Mary has a color printer that supports letter and legal paper and du-
plex. She would like to define rules to:

• Charge $1.00 per page for letter (standard size) color printing.

• Charge $0.40 per page if the users select grayscale (black & white) - a $0.60 discount
for grayscale

• Charge an extra $0.80 if they use large legal size paper

• Offer a 50% discount for duplex to encourage double sided printing.

To accomplish this complex set of charging rules, Mary should setup the Advanced char-
ging options for the particular printer as defined in the screenshot below.

Figure 5.4. Advanced differential charging example

5.4.1.3. Charging by Paper Sizes

The charging by paper size mode is designed for printers with multiple trays and a variety
of available paper sizes. Administrators have full flexibility to define cost for each of the pa-
per sizes support by the printer. For example, printing a letter size page would cost less
than printing a legal size page. This mode includes options to enable discounts for gray-
scale and/or duplex jobs. Discounts can be applied either as fixed amounts or as a per-
centage of document cost.

5.4.1.4. Charging by Paper Area

This mode is designed for plan printers, plotters or printers that support a variety of paper
sizes. For example, many engineering firms use these types of printers for plotting CAD
design diagrams. Charging by area allows the cost of the print job to be a function of the
paper area.

5.5. Using filters and restrictions

PaperCut NG offers advanced filter options to provide network administrators with the abil-
ity to filter or restrict print jobs using a set of rules. Filtering options available include:

• Detect and delete duplicate print jobs

• Define the maximum cost of a single print job
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• Define the maximum number of pages allowed in a single print job

• Filter documents based on the file extension or name

• Allow only selected paper sizes

• Set a printer to allow only color or black and white documents

Each printer has its own set of restrictions. The rules can either apply to all users or re-
stricted users only (the filter scope). You access these settings by selecting the appropri-
ate printer in the charging list and clicking the Filters tab.

Figure 5.5. Some of the available printer filters and restrictions

The printer restrictions provide network administrators with advanced control over printer
usage. Some common examples include:

5.5.1. Reduce printer jams

Many printers expect print jobs to be on single size of paper, or maybe two sizes if the
printer has multiple paper trays. A non-standard size will cause the printer to enter a manu-
al load state causing the queue to halt. PaperCut NG Filters section allows Administrators
select the allowed sizes. Non-standard sizes are automatically deleted before they're sent
to the printer. It's an effective way of reducing one of the most common causes of queue
jams.

5.5.2. Controlling documents on slow Inkjets

Inkjet printers have very low throughput rates. A large color document can hold up a queue
preventing other users from getting their "fair share" of print time. By setting an upper page
count via the printer's Filters section, network administrators can prevent large print jobs.
The page count forces users to split up large documents and allows other users access to
the printer.
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5.5.3. Automatically deleting duplicate jobs

PaperCut NG can also monitor the print queues and automatically delete duplicate print
jobs. This option is useful on networks with novice users. New users often "double click" an
application's printer icon causing two identical print jobs to be sent to the queue. This
wastes paper and users' print quota. Network administrators can enable duplicate job de-
tection via the Filters section. A popup message warns the user and the duplicate job is
removed from the queue.

Important

This option can affect multiple prints from Microsoft Excel and some other ap-
plications. Users wishing to print multiple prints from Excel may need to reprint
the document 30 seconds apart.

5.5.4. Force sensible use

Restrictions can be set to define a maximum cost per job. This will prevent users from acci-
dentally spending all their credit/quota in one print job.

5.5.5. Automatically delete documents based on file extension or name

There are many reasons why users should not print certain files. For example, maybe a re-
port from the accounting application consists of 400 pages. Users may not be aware of this
and "accidentally" print the report expecting only a few pages. PaperCut NG can be con-
figured to match this document via its name and automatically deleted it from the queue.
Use the Filters keyword filter to implement this functionality.

Additionally it's also possible to filter documents based on file extension by entering a
keyword like .htm or .pdf.

To filter a document name based on a regex (regular expression), enclose the keyword in
forward slashes. Note that the regex matches the entire document name. For example:

• To disallow printing of any documents ending in .htm:

/.*\.htm/

• To disallow printing documents of the form account-12345.pdf:

/account-\d*\.pdf/

Important

This is not a security option. It is easy to circumvent the filter by simply renam-
ing the document. Some systems may not even report type information!
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5.5.6. Control who can print in color (Advanced)

By combining PaperCut's ability to restrict color printing (allow only grayscale), and stand-
ard printer access permissions, it's possible to control which users have access to color
printing.

To implement:

1. On the print server, install the drivers for the printer twice. Call one printer Grayscale
Only and the other Color. You will now have two printer icons (logical printers) each
connected to the same physical printer.

2. Share the printers as normal

3. Set Windows access permissions on each printer as required. Users that require color
access should be able to print to the color printer. Other users should only be provided
access to the "black and white" only printer.

4. Add the printers to PaperCut NG and define appropriate costs

5. Select Restriction for grayscale only printer. Ensure that restrictions only allow black
and white (grayscale) printing.

5.5.7. Advanced Setups

PaperCut NG provides printer management features that can be easily extended to more
advanced network setups including:

• Environments with multiple print servers

• Monitoring of locally attached network printers.

• Central monitoring over Wide Area Networks (WAN) or VPN.

These topics are an advanced subject and covered in subsequent sections.

5.6. Ignoring/Deleting a printer

By default PaperCut NG will track printing on all installed printers. Under some situations
this might not be desirable. Some examples of why an administrator may choose to not
monitor a printer include:

• The printer is a “virtual printer” such as a PDF generator, FAX, or document manage-
ment program.

• The administrator may wish to offer free printing on a selected printer and not be con-
cerned with monitoring (silent monitoring with a zero page cost will also achieve this).

• The printer may not be supported by PaperCut NG and may need to be ignored.

The Print Provider component is responsible for locating and tracking the printers. To in-
struct it to ignore a printer:

1. Open the file [app_dir]/providers/print/win/print-provider.conf in a
text editor such as Notepad.

2. Locate the line IgnorePrinters= and enter the full name of the printer on the right-
hand-side of the equals line. For example:

Advanced Printer Management

73



IgnorePrinters=Office Printer

Note: This is the printer's locally assigned name and not the name it's shared under.

3. If running on Windows, restart (stop then start) the PaperCut Print Provider
component under Start → Control Panel → Administrative Tools → Services

4. Log into PaperCut NG's admin interface and select the Printers section.

5. Click on the printer to be ignored and select the Delete printer action from the Ac-
tions list.

6. Test the changes by printing to the system and ensuring the print does not re-register
itself in the system. It if does, verify the name assigned under the IgnorePrinters=
setting is correct.

5.7. Popup Authentication

PaperCut NG normally relies on the underlying operating system and the associated print
queues to perform authentication. For example, in normal operation, a user logs into a
workstation using a domain/network level authentication method such as a username and
password. The print queues also use this authentication and PaperCut NG can trust the
supplied identity. However in some network environments, relying on network level authen-
tication may either not be possible, or may not be reliable. Common examples include:

• All users log in with a common generic username and password meaning that it's not
possible to distinguish between users.

• A print queue that does not enforce authentication.

For a detailed explanation of print authentication, please Chapter 18, Print Authentication &
Cross-Platform Networks.

5.7.1. Where Popup authentication is used

Some real life examples covering these two situations include:

5.7.1.1. The Student Lab

Some student labs are set up so everyone logs in using a generic username and pass-
word. For example, username: student, password: student. This is common in Apple Mac
labs, where enabling multi-user authentication is complex and can often prevent selected
applications from running correctly.

5.7.1.2. LPR/LPD or CUPS

The Line Printer Daemon print protocol, often used in UNIX environments, is a non-
authenticated system. The username associated with the print jobs is passed through to
the print queue, however the name is not verified and can easily be forged. An extra level
of authentication is required.

CUPS, the modern print system often used on Linux, Apple Mac and some Unix systems,
is often implemented in a non-authenticated fashion. Although CUPS can support authen-
tication, technical considerations such as the inability to interface with Active Directory do-
main authentication often prevent its use.
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5.7.1.3. Mac Print Queues

Mac OS X server use the CUPS print system. Current Apple implementations prevent ad-
ministrators from enabling CUPS authentication. This is not usually a problem in an envir-
onment where logins can be controlled at individual workstation level. It does however
pose a problem if users have local admin access - for example, individual owned laptops.
PaperCut NG popup authentication provides a way to work around the non-authentication
issue.

More information, including a discussion of platform specific issues is available in
Chapter 18, Print Authentication & Cross-Platform Networks.

5.7.2. How does popup authentication work?

The popup authentication works by authenticating the user via the PaperCut NG client soft-
ware. The client software pops up a window requesting the user's username and pass-
word. The password is sent to the server via an SSL encrypted connection and is valid-
ated. On successful validation, a session is formed that associates the user with this work-
station. The session is valid for a length of time as selected by the user - the default being
5 minutes - or until the user logs out.

5.7.3. Configuration

The following sections cover how to enable popup authentication on either the user ac-
count level or the print queue level.

5.7.3.1. Popup authentication and generic user accounts

The following notes explain how to enable popup authentication when a user logs in under
a generic user account - for example, student.

• Add the account to the domain called student. You may already have such as ac-
count set up.

• Perform a User/Group Sync or print a job from this account so the username is listed
in PaperCut NG

• Select the generic user and set the account to a zero balance and a restricted status.
This will ensure that users can't charge against this account.

• Check the Unauthenticated option and click on the Apply button to save the changes.

Figure 5.6. Turning on popup authentication at the user level

• Install client software on workstations. See Chapter 6, User Client for details.

• When a user logs in as the generic student, they will be prompted for their domain
level username and password.
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Figure 5.7. PaperCut NG client requesting for authentication

5.7.3.2. Popup authentication on a print queue

The following notes explain how to enable popup authentication when a user attempts to
print to a non-authenticated printer such as one hosted via an LPR/LPD queue or a CUPS
print queue:

• Add the printer to the system and normal. Perform a few test prints to ensure the printer
is functioning and tracking as expected.

• Log into PaperCut NG and check the Unauthenticated option under the relevant print
to enable the popup authentication.

• Install the client software on any workstation that will print to this printer. See Chapter 6,
User Client for details.

• When a user attempts to print to this printer, they will be prompted for their username
and password.

5.7.3.3. User Interaction

When running in popup authentication mode, the client makes available a number of addi-
tional options including:

• Logout

• Login as another user

The Logout option is available on Windows via either the right-click option on the task try
icon, or when running on Mac or Linux, via a right-click popup menu (Option Click) access
via the icon on the balance window.

The Login as... option is made available if the client starts as an unauthenticated user.
This option allows users to authenticate or quickly switch user identity.

5.7.3.4. Advanced Popup Configuration

The login box displayed to the user offers the choice of how long their authentication de-
tails should remain active. An administrator can control the options presented to the user
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by modifying the following system configuration keys. These configuration keys are edited
under Options → Actions → Config editor (Advanced)

Config name Description

client.config.auth.ttl-values A comma separated list of values to display
in the popup authentication login box. -1
denotes infinity.

client.config.auth.ttl-default-minutes The default time-to-live value automatically
selected when the login authentication win-
dow displays.

cli-
ent.config.auth.popup-on-startup-if-unauthe
nticated

Determine if the client should request au-
thentication when the client starts if the op-
erating system user is unauthenticated. Set
to Y (yes = enabled) or N (no = off).

Table 5.1. User Client Popup Config Keys

5.8. Printer Quick Reference

How do I view printing history?

Printing history can be quickly accessed via a number of areas. The most appropriate area
depends on the information required.

• To view a user's print history select the Print History under the user's details page.

• To view recent print jobs printed on a printer, select Recent Jobs under the appropriate
printer's details page.

• To view all print jobs printed on the network with advanced search and filtering options,
use the global Print Log under the Printers section.

How do I add a new printer?

On Windows systems, new printers will be added to the system automatically once the
printer is added to a monitored server. On a Mac or Linux system, after PaperCut NG is
enabled on the printer, it will list in the administration interface after first print. New printers
are assigned initial settings based on the configuration assigned to the [Template
Printer].

How do I delete a printer?

Once the printer has been removed from the operating system's print list, the printer may
be deleted from PaperCut NG via the delete printer action under the printer's detail page.
This action will remove the printer from the monitored list. Print history logs are still main-
tained allowing access to historical data. Always confirm your action before proceeding
with the delete!

How do I disable a printer?

Printers can be disabled indefinitely or for a specified time via the Disable option under the
printer's details section.
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How do I tell PaperCut NG to ignore (not monitor) a printer?

By default on Windows systems all printers are tracked by PaperCut NG. The Print Pro-
vider can be instructed to ignore a printer by setting the IgnorePrinters= attribute in the
print-provider.conf file. A restart may be required for this to take affect. Note: This
setting only stops monitoring. The printer will continue to be listed under the printer list sec-
tion until it is manually deleted via the Delete printer action.

For more information see Section 5.6, “Ignoring/Deleting a printer”.

What can I use the printer notes field for?

The Notes field under each printer is useful for tracking all manner of information. Typical
uses include:

• Tracking configuration changes

• Recording maintenance and/or toner replacements

• Documenting problems

• Leaving notes/comments to assist other administrators.

Advanced Printer Management
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Chapter 6. User Client
The PaperCut NG activity tracking and charging is implemented using 100% server-side
technology. User Client software is not required as part of the activity monitoring process.

Note

The use of client software for activity monitoring could open up security prob-
lems as client software is readily accessible to end-users. By design PaperCut
Software Pty Ltd developers endeavor to implement all monitoring at the serv-
er level eliminating client-side loopholes. The client software supplied with Pa-
perCut NG is simply a presentation layer around server-side implementation.

Client software is provided to facilitate three tasks:

• Allow users to view their current account balance via a popup window

• Allow users to select shared accounts via a popup, if administrators have granted ac-
cess to this feature.

• Display system messages such as the "low credit" warning message.

Figure 6.1. The User Client on Windows
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Figure 6.2. User Client account selection popup

The client software is available for most major platforms including:

• Microsoft Windows

• Macintosh OS X

• Linux and Unix

Figure 6.3. PaperCut Client on Mac OS X

The client software and deployment tools are installed automatically on the server under
the [appdir]\client directory. On a Windows based server this directory is automatic-
ally shared in read-only form providing network users with access to the client executables.

Command line options for the user client are described in Section A.5, “User Client Op-
tions”.

6.1. User Client Deployment

6.1.1. Deployment on Windows

The PaperCut NG client software may be deployed to workstations using a variety of de-
ployment methods. The deployment options are covered in details in the
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[appdir]\client\README.txt file. The recommended approach with Windows based
workstations is the "zero install" strategy. This involves configuring the workstations via
group policy or otherwise, to run the pc-client.exe program directly off the PCClient
share - a share set up during installation. This avoids the need to undertake a separate in-
stallation process on each workstation and ensures the client software is automatically up-
dated in conjunction with the server.

For more information on alternate deployment options see the
[appdir]\client\README.txt file.

6.1.2. Deployment on Mac OS X

This section covers the installation of the PaperCut NG client on Macintosh systems. The
complexities of Mac printing in general are discussed in Chapter 19, Mac Printing in Detail.
Before installing the client software, we recommend that administrators study Chapter 19,
Mac Printing in Detail.

The Mac client is a supplied as a native Macintosh .app package. It's a universal applica-
tion supporting Mac OS X 10.3+ on both PowerPC and Intel hardware.

Figure 6.4. PaperCut NG requires Mac OS X v 10.3 or later

The three common installation methods are outlined below cover most situations. The in-
structions for the "single user install" is very standard and should be able to be conducted
by any Mac end-user. The other installation methods are more technically focused and
aimed at Mac network administrators.

6.1.2.1. Single User Install

This method is suitable for a Mac computer used by a single user. For example, a personal
Mac desktop or laptop. The installation process simply involves copying or dragging the
PCClient package over to the system or user's Applications folder. The simplest way
of obtaining the client is to connect to the server's pcclient share over the network,
however alternate methods such as copying via a USB key or drive are also possible.

To install the Mac client from the server's share:

1. Start and Log into the Mac computer. Ensure it's connected to the network.

2. Open the Finder.

3. From the Go menu, select Connect to Server....
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Figure 6.5. Connecting to a Windows server

4. Enter the pcclient share's connection details like: smb://server_name/pcclient

Figure 6.6. The PCClient share's connection string

5. Enter password information if requested.

6. Drag the PCClient package over to the local hard disk's Applications folder. The
copy process will commence.

7. Test the application by double-click on the PCClient application icon.

If the user needs the client for printing - for example to use the shared account popup - it's
advisable to configure the application to automatically open upon start-up:

1. Open System Preference... from the Apple menu.

2. Select Accounts.

3. Select your login account.

4. Click the Login Items tab.

5. Click the + button and browse and locate the PCClient application.
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Figure 6.7. Add PCClient as a Login Item

6. Test by restarting the computer. The client should automatically after the reboot and
login is complete.

6.1.2.2. Multi-User Install

On a multi-user Mac system, setting up a Login Item for each user would be a tedious
task. To streamline this process, the PCClient application can be configured to start on
login via the login hook. A login hook is an advanced Mac feature that works by running a
script when a user logs in. The PCClient package includes a command script resource
that install the login hook.

To install the client on a multi-user system:

1. Start and Log into the Mac computer. Ensure it's connected to the network.

2. Open the Finder.

3. From the Go menu, select Connect to Server...

4. Enter the pcclient share's connection details like: smb://server_name/pcclient

5. Enter password information if requested.

6. Drag the PCClient package over to the local hard disk's Applications folder. The
copy process will commence.

7. Control-click on the newly copied PCClient application in the Applications directory.
Select Open Package Contents.
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Figure 6.8. Control-click and open the package contents

8. Browser to Contents/Resources/.

9. Double-click on the install-login-hook.command script.

Figure 6.9. Double-click to install the login hook

10. Restart the system and verify the client starts on login.

Important

If you're already using a login hook for other script tasks, the setup process will
be different. Instead in step 9, double-click on the set-permis-
sions.command file. Then insert the following line at the end of your current
login script:

/Applications/PCClient.app/Contents/Resources/login-hook-start $1

The set-permissions.command script ensures the software is set up with
the correct permissions, ensuring it's assessable to all users.
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The login hook, once installed, can be removed with the terminal command:

sudo defaults delete com.apple.loginwindow LoginHook

6.1.2.3. Zero-Install Deployment

This deployment method is for advanced Mac network administrators and is suitable for
medium to large Mac networks. Knowledge of the Unix underpinning of the Mac OS is re-
quired.

A more flexible option over locally installing the PCClient package on each Mac system,
is to directly launch the client from the pcclient share. The advantage of this deployment
method is that any updates applied on the server (and hence updates to the client direct-
ory) will automatically be propagated to all workstations.

The process of setting up zero-install deployment will vary form network to network de-
pending on the directory environment in use and administrator preferences. The process
can however be summarized as:

1. Configure the Macs to mount the pcclient share as a volume on login or start-up.

2. Configure a login hook to start the client. The install-login-hook.command re-
source script explained in the multi-user install above may help.

The typical way to mount the share is to use mount_smbfs in a boot script. See the Apple
documentation on mount_smbfs at: ht-
tp://developer.apple.com/documentation/Darwin/Reference/ManPages/man8/mount_smbfs
.8.html

Further information on Mac printing is available at Chapter 19, Mac Printing in Detail.

6.1.3. Deployment on Linux and Unix

The PaperCut NG user client software may be deployed on Linux and other Unix based
operating systems using the following installation procedure.

6.1.3.1. Step 1 - Install Java 5.0+

Linux and Unix workstations are supported via Java. Java version 5.0 or higher is required.
Your Linux distribution may come with Java pre-installed or have the option to install. If no
Java option exists, Sun Microsystems provides a self-install Java distribution for Linux and
other major Unix platforms.

Ensure Java 5.0 is installed and the JAVAHOME environment variable is defined on the
PATH.

6.1.3.2. Step 2 - Copy (or Mount) the PaperCut NG user client files

Like the Windows version of the client software, the Linux/Unix Java version is installed in
the ~/client directory on the server. All files in this directory need to be copied, or make
available to the Linux/Unix workstation. Common methods include:
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• Copying the files from the server using file transfer programs such as FTP or scp.

• If the server is Windows based, connecting using smbclient or the Gnome or KDE
smb:// file browsing tools. The client files are shared via a read-only share called
\\[server_name]\PCClient.

• If the server is Linux based, consider exporting the ~papercut/client directory via
NFS and mounting on the workstations. The client can then be ran directly from the
mount.

If the workstation is used by multiple users, the client directory should be copied to a com-
mon location such as /usr/local/papercut/client.

6.1.3.3. Step 3 - File permissions

Open a command prompt and set execute permissions on the pc-client-linux.sh file
as follows:

cd /usr/local/papercut/client
chmod 755 ./pc-client-linux.sh

6.1.3.4. Step 4 - Testing

Log on as a user (a user listed in the PaperCut NG system) in your preferred Linux desktop
GUI environment. Locate and execute the file /
usr/local/papercut/client/pc-client-linux.sh. The PaperCut NG client
should open displaying the user's account balance.

It is usual to configure the client as a "Startup Program" or "AutoStart Program" launched
during login. See your desktop documentation to see how to define a startup program.

A number of command-line options are available to change the client's behaviour. More in-
formation can be found in Table A.2, “User Client command-line options”.
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Chapter 7. Shared Accounts
PaperCut NG has two types of accounts - personal accounts and shared accounts. Each
user has a personal account. This is the default account charged under normal operation.
In some organizations it may be useful to provide users, or selected users with the option
to charge printing to a shared account. Some uses of shared accounts include ...

In a school or university:

• Budget staff use via shared faculty or department accounts

• Provide share accounts for classes or subjects

• Track printing costs by subject areas

In business:

• Allocate and budget printing by business areas

• Track printing by project, client or account

Shared account scenario

East Beach High School has implemented PaperCut NG to control their printing. Students
are allocated a $5.00 a month budget. Pre-paid cards are sold at the library for students
who need extra credit above this allowance.

Teachers and staff are given a small personal budget to cover casual printing with cur-
riculum material to be allocated to share accounts. Shared accounts exist for each faculty.
The network administrator has granted staff members access to the share account popup.
Access to faculty accounts is controlled via Active Directory group membership.

Sarah is a Science and English teacher at the school. When she prints she is able to alloc-
ate the print job to either her personal account or either the Science or English shared ac-
count via a drop-down list.
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Figure 7.1. Selecting a shared account with the User Client popup

7.1. Creating a Shared Account

Personal user accounts are automatically created when users are first imported into the
system. Shared accounts are created manually on an as-need basis.

To create a shared account:

1. Log into PaperCut NG as an administrator (e.g. admin account).

2. Select the Accounts tab.

3. Click the Create a new account action.

4. Enter an appropriate name for the account. Account names should be as descriptive
as possible.

5. Complete other details such as starting balance, restrictions status and notes as ap-
propriate.

6. Click the OK button to save the changes and return to the accounts list.

Shared Accounts
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Figure 7.2. Creating a shared account

By default shared accounts default to an unrestricted status. This means that the account's
balance is allowed to drop below zero. Many organizations use shared account to track
printing expense. A common strategy is to start the account off at a zero balance and let it
count down into the negative. By setting the account to restricted and allocating an initial
starting balance, shared accounts can be used as a budget control system as printing to
the account is denied once credit is exhausted.

7.2. Client Security

By default all printing is automatically charged to the user's personal account. For a user to
be able to select a shared account the user needs to be granted access to account selec-
tion popup.
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Figure 7.3. Selecting a shared account from the popup

Access to the account selection popup, as shown in the above figure, is controlled at the
user level on the user's details page. The Show the account selection popup option
needs to be selected for each user that requires access to shared accounts. System ad-
ministrators might find the Bulk user actions section under the User List screen conveni-
ent for applying this change to many users.

Figure 7.4. The user's popup settings under User -> User Details
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Important

Users need to restart their workstation (or manually restart the PaperCut client
software) for this change to take affect.

Users with the Show the account selection popup option enabled need to
be running the client software at all times. Print jobs will not print until the user
has selected the account.

In addition to granting users access to the popup they also need to be granted access to a
shared account. Shared accounts access can be controlled using two methods:

• Network group membership

• PINs (also known as security codes or passwords)

If an account is allocated a PIN (an alpha-numeric access code) users with knowledge of
the PIN can select the account. A PIN based system would be a sensible selection in an
organization when PINs are already in use for other systems such as photocopiers or door
access codes.

An alternate method is to delegate access to the shared account via network group mem-
bership. One advantage of group based control is that users do not have to remember
PINs. Most medium to large organizations will already have their network structured into
suitable groups representing their position, title, department or work area. These existing
groups may be used to control access. Access to shared accounts can also be granted on
an individual user basis, however best practice suggests group-based management for
medium to large networks.

Tip

In a Windows Active Directory environment, Organization Units are treated as
special groups. Hence they also can be used to control access to a shared ac-
count.

Controlling access to shared accounts via group membership rather than indi-
vidual user accounts is recommended. By using group based control, new
users created on the network inherit the correct account access by virtue of
their network group membership. This alleviates the need for additional user
setup inside PaperCut NG.

To grant access to a shared account or all members in a given network group:

1. Log into the system as an administrator (i.e. admin account).

2. Select the Accounts tab.

3. Select the appropriate shared account from the list.

4. Click on the Security tab.

5. Select the appropriate group from the drop-down list.

6. Click the Add button.
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Figure 7.5. Setting up shared account security

7.3. Advanced Popup Settings

The account selection popup offers four account selection types:

1. Charge to personal account.

2. Charge/allocate to a shared account selected by a PIN.

3. Charge/allocate to a shared account from list (built from security group).

4. Perform print as another user (username and password required).

When a user selects the a shared account, there is the option to:

1. Charge the print to a shared account.

2. Charge the print to personal account (and allocate to shared account for reporting).

The option to charge a to personal account allows printing to be tracked against shared ac-
counts while allowing the use of user-based quotas. When this option is selected, the cost
of the print job is deducted from the user's personal account, but the job is allocated
against the shared account which allows for account based print reporting.

System administrators can control on a per-user basis what options are available in the
user's popup.

Note

Changes to the options available in the account selection popup come into ef-
fect immediately. There is no need to restart the client software for these set-
tings to take effect.
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Figure 7.6. Client popup options defined on a per-user basis

The Charge to personal account with popup notification option displays a popup with
no account selection features. This option is useful in environments where the system ad-
ministrator desires to provide users with cost confirmation prior to printing.

Figure 7.7. The print job confirmation dialog (no account selection options)

7.4. Account Selection Non-Domain Environments (Workgroups)

Many small networks may not be controlled via a central domain server. These networks
are sometimes referred to as Workgroups or peer-to-peer networks. On these networks
users may not log on to their desktop, or computers may be shared by multiple users. The
Allow users to charge to other users option may be useful in non-domain/logon environ-
ments. User accounts can be set-up in the system hosting the printers and users can se-
lect their account using usernames and passwords for each print job, irrespective of what
user account is currently logged onto the workstation.

Figure 7.8. Configuration allowing only selection of other user accounts
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Figure 7.9. Popup requesting the user to enter their username and password

7.5. Batch Shared Account Import and Update

The batch import and update feature allows the administrator to import accounts, and op-
tionally update existing account details by reading data from a simple text file. In addition to
being able to create accounts, it enables administrators to update the following account
data:

• Account Name

• Account PIN

• Credit balance

• Restriction status

• Notes

• Groups allowed to use the account

• Users allowed to use the account

Examples of where the batch user import feature is useful include:

• When importing account and balance data from another external system.

• To reset the account balances at the end of a semester.

• To bulk update the users and groups who are allowed to use the accounts.

To perform a batch import:

1. Manually inspect your file in a text editor and ensure it's in the prescribed tab-delimited
format as detailed at Section 7.5.1, “Batch Account Import File Format”.

2. Navigate to the Accounts section.
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3. Click the Batch import ... action (on the left).

4. Click Browse to select the file to import. (The format of the file is described in Sec-
tion 7.5.1, “Batch Account Import File Format”).

5. Choose whether you want the import to create new accounts if they do not already ex-
ist. If you clear this checkbox, lines that contain users that do not exist will be ignored
and only existing users will be updated.

6. Press the Import button.

7. Upon completion you will be told how many accounts were updated and how many ac-
counts were created.

7.5.1. Batch Account Import File Format

The import file is in tab delimited format and contains the following fields in the given order.

Field Description

Account Name The Shared Account Name

Account PIN The account PIN. The account must be
unique.

Credit Balance The account balance

Restricted Status The account's restricted status. (Y/N where
Y = YES, and N = No)

Notes Notes about the shared account (placed in
the Notes field).

Groups The groups that are allowed to use the ac-
count. The list of groups is pipe (|) delim-
ited. To reference the special 'All Users'
group, use the syntax !!All Users!!.

Users The usernames of users that are allowed to
use the account. The list of users is pipe (|)
delimited.

Table 7.1. Shared Account Import File Format

Tip

A simple way to create a tab delimited file is to create a spreadsheet in Mi-
crosoft Excel, and then save it in the Text (Tab delimited) format.

7.5.1.1. Import File Format Examples

The following lines shows importing all the above fields. (The fields are separated by tabs).
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Maths 1234 500 N A Note group1|group2|group3 user1|user2|user3
Science 1235 100 N More notes group1 user3

The following lines show updating only the groups that can access the account. NOTE:
That the tabs still exist for the pin, balance, restriction and notes fields, but each entry is
blank. pin, restriction, full name fields, but each entry is blank.

Maths group1|group2|group3
Science group1
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Chapter 8. Reports
A report is a representation of data, often in a printable tabular format. PaperCut NG
provides a set of built-in reports. These include simple pre-built reports accessed via one-
click, up to more advanced reports constructed using custom filters.

Tip

PaperCut NG is an open system. System administrators with database man-
agement experience may choose to run the system on an external database
system. 3rd party reporting tools can then be used to construct customer re-
ports. The PaperCut Software Development team can also consult on custom
report development.

Many of the one-click reports are produced from data over a given date range. Common
date ranges, such as last 30-days, and the previous month can be accessed via the appro-
priate link. The ad-hoc reports may be used to generate the reports over user defined date
ranges.

Figure 8.1. Selecting ad-hoc date ranges for reports

8.1. Report types

The one-click reports accessed under the Reports section can be grouped into the follow-
ing areas.

8.1.1. User Reports

These are reports producing information about users. They range from a list of users, their
names and current account balance, to detailed reports listing all print jobs printed by a
user over a particular time-frame.
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8.1.2. Printer Reports

Printer reports produce information on printers including configuration, usage summaries
and statistics.

8.1.3. Group Reports

These reports group printer usage by network group allowing system administrators to de-
termine which group of users performs the most prints. These reports are ideal for gaining
a quick overview of printing costs performed by work area, department, floor, management
level, etc.

8.1.4. Shared Accounts Reports

Administrators may use the shared account reports to track printing allocated to shared ac-
counts via the popup.

8.1.5. Print Log Reports

The print log is a detailed list of all printing performed on the network. The print log reports
allow administrators to produce reports list all jobs over a given date range with simple
one-click version for today's print jobs and largest print jobs.

Figure 8.2. Printer log PDF report

8.2. Report Formats

All reports are available in three different formats. Access to all formats depends on the
software installed on your system. Alternate formats are accessed via the three icons loc-
ated next to the report generation links.

Figure 8.3. Report icons of alternate report formats (i.e. PDF, HTML, Excel).

There are three report formats available.
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Format Description

PDF Reports PDF is the most appropriate format for
printing. To view these reports you're com-
puter must have Adobe PDF View installed.
Adobe PDF viewer is available from
www.adobe.com.

HTML Reports HTML Reports will work on all systems and
don't require an external PDF viewer.
These reports may not print or format as
well as the PDF versions and are designed
for either a quick review of data or for sys-
tems that don't have a PDF viewer.

CSV/Excel Reports The CSV/Excel reports can be used to ac-
cess the data in plain text format. The
format is suitable for importing data into
programs such as Microsoft Excel.

Table 8.1. Report Formats

8.3. Combining Filters and Reports

All data list views in PaperCut NG have export/print option linked at the bottom of the list.
The export/print links run a report over the data currently displayed in the list. The lists
column order and filter options are taken into consideration when generating the report
data. This functionality can be used to produce ad-hoc or custom reports. This functionality
is best described by example.

To run a report to see who and how much people have printed against a shared account
over the month of September:

1. Navigate to the Accounts.

2. Click on the appropriate shared account.

3. Select the Print History tab.

4. Click the Show Filters link.

5. Select the 1st of September in the from date and enter the 30th of September in the
to date.

6. Click Apply Filter button. The data displayed in this list should be all print jobs printed
against this shared account for the month of September.

7. Click on the Summary by user link to produce the PDF report.
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Figure 8.4. Filters applied to the shared account print log

To run a report listing all transactions issued against a user's account over the month of
September ordered by transaction amount:

1. Navigate to the Users.

2. Click on the appropriate user account. The user details page will display.

3. Select the Transactions tab.

4. Click the Show Filters link.

5. Select the 1st of September in the from date and enter the 30th of September in the
to date.

6. Click Apply Filter button.

7. Click on the Amount column to order the data by amount value.

8. Click on the Export/Print button at the bottom of the list to produce the report.
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Chapter 9. Print Release Stations
In a standard network printing environment, when a user prints from an application, the job
is sent directly to the printer and starts printing immediately. In some environments it may
be advantageous to place the job in a holding state prior to printing. Some common ex-
amples include:

• Secure Printing - In a secure printing environment jobs are only printed when the user
arrives at the print area and confirms his or her identity. This ensures the user is there
to collect the job and other users can't "accidentally" collect the document.

• Approved Printing - In some organizations it may be appropriate to hold jobs until they
are approved by selected individuals. A good example would be a teacher approving
printing on an expensive color printer.

PaperCut NG provides the framework and software interface to implement hold and re-
lease queues.

Print Release Stations provide an interface to allow authorized persons to release held
jobs. In many situations, a release station is a dedicated computer terminal located next to
the printers, however release stations can take other forms such as a browser-based inter-
face. Release Stations are used for a wide variety of purposes depending on the require-
ments of the organization. This section outlines a number of these scenarios, and also how
to install and configure the release stations.

The simplest way to get started with release stations is to read through the scenarios be-
low (see Section 9.2, “Release Station Usage Scenarios”), and decide which best suits
your needs. These scenarios will outline the steps required to configure the release station.

9.1. Release Station Interfaces

PaperCut NG includes four different release station interfaces. Three of these are vari-
ations of a web-based interface and one is a software version that is typically used for ded-
icated release stations. These release station interfaces are described below.

9.1.1. Standard Release Station

The standard release station is typically used on dedicated workstations located near-by
the printers. It usually runs in a full-screen mode that cannot be exited. The release station
can be run in a number of modes that changes its behavior depending on your needs.
These modes are described in Section 9.3.3.1, “Release Station Modes”.

For more information regarding deployment of the Standard Release Station see the
[appdir]\release\README.txt file. For information regarding configuration of the
Standard Release Station see Section 9.3.3, “Standard Release Station Configuration”.

The release station scenarios below describe which mode to use for different situations.
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Figure 9.1. The Standard Release Station

9.1.2. Web-based release station (Manager mode)

The web-based release station provides functionality equivalent to the standard release
station running in "Manager mode". However, the web-based release station can be more
convenient because it can be run from anywhere using a web browser.

The web-based release station can be access by visiting the following URL, and logging in
as a user with admin or release station manager permissions.

http://[servername]:9191/release

where [servername] is the name of the PaperCut NG server. To make a user a release sta-
tion manager see Section 9.3.2, “Release Station Managers”.
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Figure 9.2. Web-based release station (Manager mode)

9.1.3. Web-based release station within the admin pages

When logged into the admin pages, an administrator can view all jobs held by release sta-
tions by:

• Navigating to the Printers section.

• Selecting the Jobs pending release tab.

This interface is identical to the full-screen web-based release station, but can be more
convenient for users already logged into the administration pages.
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Figure 9.3. Web-based release station within the admin pages

9.1.4. End-user web-based release station

When end-users are logged into the user web interface, they can view their print jobs that
are currently held by a release station. The administrator can decide whether this interface
is visible to end users. It allows users to view their jobs, but not release the jobs via this in-
terface. These options are available in the Options section under User Features.

Figure 9.4. End-user web-based release station
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9.2. Release Station Usage Scenarios

This section describes various usage scenarios for print release stations. They provide a
good starting point for implementing release stations.

9.2.1. Saving paper and toner

A large source of wasted paper in organizations are documents that were never collected
from the printer. Some of these uncollected documents are caused by accidental printing,
and others were just forgotten. But the majority of these documents end up in the bin.

If the document is not printed until a user walks to the printer to collect it, then this source
of waste can be mostly eliminated.

To implement a release station to save paper:

• Set up a low-end workstation near the printer(s).

• Run the Standard Release Station in the default mode (Release Any mode). More in-
formation can be found at Section 9.3.3.1, “Release Station Modes”.

• In PaperCut NG, enable the printer(s) for release station use. More information can be
found at Section 9.3.1, “Enabling release station support for a printer”.

9.2.2. Secure Printing

When users print documents that contain sensitive information, it is important that no one
else picks up the document from the printer. Even when the printers are close-by, people
can be distracted and accidentally leave sensitive documents on the printer. Print release
stations can be used to implement Secure Printing, which ensures that a document can
only be released by the person who printed it and only when that person is standing near
the printers.

Secure printing is implemented as follows:

• Setup a low-end workstation near the printer(s).

• Run the Standard Release Station in "Secure" mode. More information can be found at
Section 9.3.3.1, “Release Station Modes”.

• In PaperCut NG, enable the printer(s) for release station use. More information can be
found at Section 9.3.1, “Enabling release station support for a printer”.

Secure printing requires users to be authenticated on the network when printing (i.e. an
Active Directory domain). This allows the release station to enforce the secure printing so
that users can only release documents they print.

9.2.3. Pay per print (e.g. Library or Internet Cafe)

Libraries and Internet cafes usually only allow printing once a user has paid for the cost of
the printed document. Previously, implementing pay-per-print often involved deploying ex-
pensive card-based payment solutions, however PaperCut NG release stations allow this
to implemented in a more cost effective way.

An example of how print release stations would be used in this scenario is:

1. Users print documents from a workstation without any assistance from staff.

Print Release Stations

105



2. The printed documents will be held in the queue until released by a staff member.

3. The user goes to the staff desk and asks for the document to be released.

4. The staff member opens a release station, finds the user's job, notes the cost and col-
lects the payment from the user.

5. The staff member presses the "Print" button, allowing the job to be printed.

6. The user then collects the printed document from the printer.

If the user never pays for a print then the print job will be automatically deleted without any
staff interaction.

To implement a pay-per-print release station:

• In PaperCut NG, enable the printer(s) for release station use. See Section 9.3.1,
“Enabling release station support for a printer”.

• In PaperCut NG, setup the staff to be "release station managers". This will allow them
to log in to the "manager mode" release stations. See Section 9.3.2, “Release Station
Managers”.

• On the staff desk workstations, run the release station in "Manager mode". See Sec-
tion 9.3.3.1, “Release Station Modes”.

• There are release station interfaces to choose from:

• Standard Release Station in "Manager mode" - requires minimal setup.

• Web-based release station - requires only a web browser.

9.2.4. Expensive Printers (Approved Printing)

At times it is necessary to restrict access to an expensive printer (like a color laser printer),
or other printer that should only be used with an administrator's permission. Instead of lock-
ing the printer away where no one has access to it; the printer can be configured so that
only administrators or release station managers can release print jobs. In this situation:

1. The user prints the document to the restricted printer.

2. The document is held in the queue awaiting approval by an authorized person.

3. The user talks to the administrator (or approved user) who would decide whether the
user should be allowed to perform the print.

4. The administrator logs into the web-based release station from any machine on the
network, and "Release" or "Cancel" the job as appropriate.

To implement admin/manager only release station:

• In PaperCut NG, enable the printer(s) for release station use, and select the "Admin/
Manager only release" mode. See Section 9.3.1, “Enabling release station support for a
printer” for more info.

• It is not necessary to set up a dedicated release station near the printer, because the
web-based release station can be used from any machine on the network.

• It is also a good idea to put a notice on the printer that tells users how to have their doc-
uments released.
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9.2.5. Unauthenticated printing

In some environments it is not possible (or very difficult) to have users authenticated when
printing. This could be due to a technology constraint (like using Macs in mainly Windows
environment) or could be for convenience (like having kiosk computers in the library that
people can use without logging in).

In these scenarios, print jobs are printed under one name, but charging should be allocated
to another. For example, a job is printed by an generic "library user", but there is a need to
charge to the user's real account. In order to charge the correct user for printing, PaperCut
NG needs to identify the user to charge, and this can be achieved by using a release sta-
tion in "Release Any" mode.

This works as follows:

1. The user prints from a workstation but is not authenticated, so jobs are allocated to a
generic user.

2. The print job is held in the queue awaiting release.

3. The user walks to the release station and enters a username and password.

4. All jobs held by the release station are listed. Jobs can be identified by document
name or workstation machine name.

5. The user selects his or her jobs. Any jobs released are charged to that user's account.

Figure 9.5. All documents easily identifiable by document and machine name

To implement unauthenticated printing using a release station:

• Set up a low-end workstation near the printer(s).

• Run the Standard Release Station in "Release Any" mode. See Section 9.3.3.1,
“Release Station Modes”.

• In PaperCut NG, enable the printer(s) for release station use, and select the "User re-
lease" mode. See Section 9.3.1, “Enabling release station support for a printer”.
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9.3. Release Station Configuration

This section describes various aspects to configuring release stations.

Some additional installation notes can also be found in the release station README file
located here:

[appdir]\release\README.txt

9.3.1. Enabling release station support for a printer

By default, print jobs will be sent directly to the printer and will not be held by the release
station. To turn on release station support for a printer:

1. Log on to the administration section.

2. Navigate to the Printers section.

3. Select the printer to enable release station support on.

4. Select the option to Enable release station.

5. Choose the appropriate release station mode for your needs.

The two release modes available are:

• User Release - this is the standard mode that allows users to release their own jobs
from the release station.

• Admin/Manager only release - in this mode, jobs can only be released by administrators
or release station managers.

Tip

To configure multiple printers for release station support, the Copy settings to
other printers function can be used. To use this, configure one printer as re-
quired, press the Copy settings to other printers and select the printers to
copy the settings to.

9.3.2. Release Station Managers

A release station manager is a user that has additional privileges to manage release sta-
tions and jobs held by a release station. Release station managers can:

• Log on to the "manager mode" release stations (both the software and web-based re-
lease station).

• Release jobs that can only be released by managers or administrators.

• Can close the Standard Release Station.

To make a user a release station manager:

1. Log on to the administration pages.
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2. Navigate to the Options section.

3. Find the Release Station security section.

4. Enter user's username in Release station managers field. To enter multiple users, sep-
arate usernames with a comma (,).

Important

PaperCut NG administrators can automatically perform all operations that re-
lease station managers are allowed to.

9.3.3. Standard Release Station Configuration

The Standard Release Station is configured using a configuration file located in the direct-
ory where the release station executables are located. The default configuration file is:

[appdir]\release\config.properties

This configuration file allows you to configure the behavior and look of the release station
in a number of ways. Each of the configuration items are described in the table below:

Config name Description

mode The mode changes the behavior of the re-
lease station depending on the need. The
available modes are described in Sec-
tion 9.3.3.1, “Release Station Modes”.

printers Filters the list of jobs to only those printers
listed. This is a comma separated list of full
printer names (i.e. server\printer). This is
useful when there are multiple release sta-
tions, each managing the queues of a dif-
ferent set of printers.

show-release-all (Y/N) - Indicates whether the "Release All"
button should be displayed. Default: Y
(Yes)

show-cancel-all (Y/N) - Indicates whether the "Cancel All"
button should be displayed. Default: Y
(Yes)

max-idle-secs The number of seconds without user input,
before the user is logged out of the release
station. The default is 30 seconds.

background-color Allows for customizing the background col-
or of the release station to match the or-
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Config name Description

ganization's colors. The color format is the
hexadecimal color code used in HTML -
#RRGGBB (where RR is the red compon-
ent, GG is the green component and BB is
the blue component).

font-color Allows for customizing the font/foreground
color used in the release station. The color
format is the hexadecimal color code used
in HTML.

title The title that appears at the top of the re-
lease station screen.

instructions The instructions to display at the login
page. A <br> can be included to start a
new line.

logo-image Allows a custom logo image to be dis-
played. For best results the image should
be between 50 and 80 pixels in height.
PNG, JPG or GIF images are allowed.

Table 9.1. Standard Release Station config settings

Tip

When running release stations from the \\server\PCRelease share, each
workstation can have its own configuration file. The "config.properties" is used
for default settings for all release stations, but settings can be overridden by
defining another configuration file for each release station. These files should
be put in the same directory and be named using the following convention:

config.[machine-name].properties

where [machine-name] is the name of the machine running the release station.

A custom configuration file can also be specified on the command-line using
the following syntax:

pc-release.exe --config "[config file path]"

9.3.3.1. Release Station Modes
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The release station modes available are described below. The release station mode is
changed in the configuration file as described in Section 9.3.3, “Standard Release Station
Configuration”.

Mode Description

ReleaseAny This is the default mode. It allows a user
who logs onto the release station to release
any held jobs. Any jobs released will be
charged to the logged in user.

Manager Manager mode allows only administrators
or release station managers to log in to the
release station. In release station mode, all
jobs are listed and users are not automatic-
ally logged out due to inactivity.

Secure Secure mode allows users to only see and
release print jobs that they have printed.

NoPassword This works similar to the secure mode,
however users don't need to enter the
password to view jobs.

Table 9.2. Standard Release Station modes

In all modes except Manager mode, users are logged out automatically after a period of in-
activity defined in the configuration file, the default being 30 seconds.
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Chapter 10. System Management
10.1. Overview

This section discusses various options and features to assist the administrator manage
and configure the application. PaperCut NG is designed to work with minimal initial config-
uration and is self-maintaining once set up. This section outlines some of the options avail-
able to the administrator, including:

• Configuring the synchronization of users and groups

• Managing backups

• Configuring user notifications

• Exporting/import the data

• Defining security options

• Disabling features in the user web interface

• Display options (like whether to display the currency sign).

10.2. User and Group Synchronization

One of the most important parts of managing the system is to configure the User and
Group synchronization options. PaperCut NG synchronizes user and group information
from the Windows Active Directory (or Windows Domain). This simplifies the administration
of the system by avoiding the need to manage a separate database of users and groups. If
a user is added to the domain or is removed from a group then PaperCut NG will automat-
ically synchronize this information without any intervention from the administrator. For ex-
ample:

• Jason configures PaperCut NG to assign an initial credit of $10 to users that are mem-
bers of the "Students" windows security group.

• At the start of the new school year Jason, the system administrator, has just added 100
new students to the Windows Active Directory.

• Jason also adds all the users to the "Students" Windows security group.

• When PaperCut NG next synchronizes with the Active Directory, the 100 new users are
added to PaperCut and automatically assigned the $10 of initial credit. This was done
automatically without any additional work by Jason.

10.2.1. Synchronization Options

The synchronization options are located on the Options->User/Group Sync tab. There are
three options to select:

• Sync Source - this selects where the users/groups should be imported from. (Active
Directory, Windows NT Domain, LDAP, or Custom provider).

• Import from Group - allows to import from a subset of users

• Delete old users when syncing - deletes users from PaperCut NG if the user no
longer exists.
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Figure 10.1. User/group synchronization options

The "Sync Source" allows the choice between either "Active Directory" or "Windows Stand-
ard". If the PaperCut NG server is a member of an Active Directory domain it is recommen-
ded to use this option. The advantages over the "Windows Standard" include:

• Allows using Active Directory organizational units.

• Supports the nested groups for simplified user management.

• Allows importing of users from other trusted Active Directory domains.

PaperCut NG automatically re-syncs the user and group information each night, however
the sync process can also be initiated manually. To initiate a manual sync:

1. Navigate to the Options → User/Group sync tab.

2. Press the Synchronize Now button.

3. The sync process will start and a status window will open showing the status of the
sync process.
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Figure 10.2. Progress of a user/group synchronization process

Tip

By default, the Active Directory user source will import all users, including
those that are disabled. It is possible to change this behaviour using an ad-
vanced config entry. To do this:

1. Navigate to the Options tab.

2. Press the Config Editor (Advanced) action on the left.

3. Find the user-source.config-arg property.

4. Change the value to enabled-users-only .

5. Press the Update button next to the config property.

Take care when changing this option if you temporarily disable user accounts
for disciplinary or other reasons. If you do this, performing a user sync will
cause disabled users to be deleted if you also have the Delete old users
when syncing option enabled.

Important

The group membership is automatically synchronized nightly to ensure that
group-based operations (like quota allocation) operate as expected.

However, the users are not automatically synchronized, so if many users have
been added to your Active Directory, it is recommended that you perform a
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manual user/group sync operation. Alternatively a full user and group syn-
chronization can be automated as a nightly task by scheduling a script to run
the appropriate server-command command. More information on using the
server-command can be found in Appendix A, Tools (Advanced).

10.2.2. Using LDAP for user synchronization

LDAP (Lightweight Directory Access Protocol) directories usually store information about
user and groups in an organization. One of the most common uses of LDAP is to provide
single sign-on on a network that comprises multiple platforms and applications. When a
network consists of only Windows computers, then an Active Directory domain can be
used. But when there is a mix of Windows, Apple and Linux machines then LDAP can
provided the single source of user, group and authentication information. (It is worth noting
that both Active Directory and Novell eDirectory implement the LDAP protocol).

PaperCut NG can use an LDAP directory for user authentication and as a source of user
and group information. LDAP can either be enabled at installation time, or by changing the
user source option in Options → User/Group sync. When enabling LDAP, a number of
configuration settings must be specified to allow the application to connect to the LDAP
server. Please ask your LDAP administrator what values to use for the various options:

• LDAP Server Type - Determines which LDAP fields are used to get user and group in-
formation.

• LDAP Host address - The hostname or IP address of the LDAP server.

• Use SSL - Indicates if an encrypted SSL connection should be used to connect to the
LDAP server. The LDAP server requires SSL support to be enabled and should accept
connections on the standard LDAPS port 636.

• Base DN - This is the Base DN of the LDAP server. This is the equivalent of the "suffix"
config setting of the OpenLDAP server. For example, if the domain hosted by the LDAP
server is "domain.com" then the Base DN might be DC=domain,DC=com. The format
of the Base DN can differ significantly depending on configuration. Some examples:

DC=myschool,DC=edu,DC=au
DC=myorganization,DC=com
OU=OrgUnit,DC=domain,DC=com
DC=local

• Admin DN - The DN of the user who has permission to connect to and query the LDAP
server. This is typically an administrative user, although it can be a user that has full
read access to the LDAP server. An example of the DN of the Administrator user on a
Windows AD domain "domain.com", would be
CN=Administrator,CN=Users,DC=domain,DC=com. The exact format of the DN
depends on the LDAP server. Some examples:

• Windows Active Directory: CN=Administrator,CN=Users,DC=domain,DC=com

• Windows Active Directory (in organizational unit):
CN=administrator,OU=OrgUnit,DC=domain,DC=com

• Mac OpenDirectory: uid=admin,CN=users,DC=domain,DC=com

• Unix Open LDAP: uid=root,DC=domain,DC=com, or
uid=ldapadmin,DC=domain,DC=com
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• Admin password - The password for the above user.

PaperCut NG supports the following server types:

• Novell eDirectory

• Microsoft Active Directory

• Unix/NIS

However, it is easy to support other server types by adjusting the LDAP fields PaperCut
NG searches. This is discussed in Appendix C, Advanced LDAP Configuration.

10.3. System Backups

As with any application, it is important to ensure that backups are performed regularly. Pa-
perCut NG includes a built-in backup process that saves the state of the database to a file.
The backup is stored in the industry standard XML format that is compressed using the
standard ZIP format to reduce disk-space on the server and your backup medium. The use
of these open standards ensures that your data is always available and accessible.

PaperCut NG makes the process of managing backups simple by automatically performing
a weekly backup. The backup file is in the following directory:

[appdir]\server\data\backups

The weekly backups are performed at 20 minutes past midnight on Sunday morning (or as
otherwise defined by the schedule.weekly config key.)

Tip

In accordance with backup best practice, the above directory should be regu-
larly backed-up to offline media (e.g. tape or CD). This will allow the data to be
restored in the case the server hard-drive is corrupted.

On larger networks, it may be desirable to perform backups more frequently
than the in-built once a week period. The server-command tool may be used
to execute the backup task at other times. Simply write a script (e.g. batch file)
to execute server-command perform-online-backup. Schedule the
script to run at the desired intervals. More information on server-command is
available in Section A.1, “Server Commands (server-command)”.

10.3.1. Performing an Online Backup

In addition to the automated weekly backups, it is also possible to manually initiate a
backup. This might be useful to back up the system before performing an upgrade. To per-
form a manual backup:

1. Navigate to the Options → Backups page.

2. Press the Backup Now button.

3. A window will open showing the backup progress and the location where the backup
file is saved.
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10.3.2. Restoring a Backup

There are a number of situations when it might be necessary to restore a database, includ-
ing:

• Hardware or system failure requires you to rebuild the server and reinstall PaperCut
NG.

• A new print server was purchased and PaperCut NG is being moved to a new server.

• To import data into an external RDBMS (See Chapter 15, Deployment on an External
RDBMS).

To restore from a backup:

1. Locate a previous backup file.

2. Shutdown the application server (See Section A.6, “Stopping and Starting the Applica-
tion Server”). The database cannot be in-use when performing the restore, so the ap-
plication server needs to be stopped first.

3. Open a command prompt. Change to the server binaries directory. On a Windows sys-
tem the directory location is [appdir]\server\bin\win\.

4. Run the import process by executing the following:

db-tools import-db -f "backup file path"

5. The import will ask whether the existing database data should be deleted before pro-
ceeding.

6. Once the import has completed, restart the application server (See Section A.6,
“Stopping and Starting the Application Server”).

10.3.3. Performing Offline Backups

Performing an online backup (as discussed above) is a simple and convenient process, but
it is sometimes necessary to perform an offline backup. For example:

• To integrate into your existing backup procedures, it might be necessary to write a
script or batch file to perform a backup at a known point in time.

• When it is necessary to guarantee that the backup captures all the data. When perform-
ing an online backup the system is still in use so data could be modified after the
backup completes.

To perform an offline backup:

1. Stop the application server (See Section A.6, “Stopping and Starting the Application
Server”). To ensure all data is captured, the application server must be stopped to per-
form an offline backup.

2. Open a command prompt. On a Windows system change to the following directory:
[appdir]\server\bin\win\

3. Run the database export process by executing:

db-tools export-db
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(This will create a backup file in the system backups directory and the filename named
with a timestamp).

The export command has additional options that allows you to specify a different dir-
ectory or filename. See Section A.2.1, “export-db Command” for more details.

10.4. System Notifications

This section describes system notifications and how they can be configured for your organ-
ization. PaperCut NG includes built-in notifications to alert users of a important pieces of in-
formation. Examples of these notifications include:

• The user's account balance drops below a given balance.

• Printing is denied due to a variety of reasons (e.g. not enough credit; the printer is dis-
abled; the print job contains too many pages).

• A print job was successfully printed.

The message that is delivered to the user can be customized to suit your organization. For
example, if the user is denied printing for some reason, you may wish to direct the user to
the intranet page that discusses printing policies and guidelines.

Important

System notifications are important to your users because they let them know
why their print jobs were denied. If notifications are not enabled, users print
jobs might be deleted without them knowing and they will not understand what
happened. They might then contact the Administrator or Help Desk for assist-
ance. If they received a notification, then this situation is avoided.

System notifications can be delivered to the user in a number of ways, and the administrat-
or can decide the preferred option. The delivery options available include:

• Winpopup (or "net send") - this is useful in a Windows network but workstations running
other operating systems may not receive these messages.

• User Client - messages are sent to users running the PaperCut NG User Client tool.
This option is guaranteed to work in all environments where the user runs the user cli-
ent.

• Email - messages are delivered by email, to the email address defined in the system.
This is a good alternative for "low balance warning" messages but is not recommended
for real-time messages like when printing is denied.

• Custom - this allows you to develop your own message delivery mechanism. This might
be useful if your organization has an instant messaging infrastructure.

10.4.1. Configuring Notifications

PaperCut NG provides flexible options for configuring the various notifications. The admin-
istrator can choose to:

• Enable/disable each of the notification types.
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• Change the notification message to suit your organization.

• Choose the delivery method for each notification type.

To change the notification options:

1. Navigate to Options → Notifications.

2. To change print notifications, select the Print Notifications link at the top.

3. To change the low balance notification, scroll down to the "Low Balance Notification
section.

Figure 10.3. Options for a single system notification

4. Using the notification options (shown above), the notification can be enabled; the noti-
fication text; and the delivery type can be modified.

10.4.1.1. Notification Text

Notification text can be modified to suit your organization's requirements. The notification
text is a template that can include some special fields that are replaced by the system
when the message is sent. They can be used to provide more detailed information to the
user. These fields are surrounded by percent characters (%).

Field Description

%user% The username of the user delivered the
message.

%date% The date/time that the message was sent.

%balance% The user's current credit balance.

Table 10.1. Fields available in all notifications

Field Description

%cost% The cost of the print job.

%printer% The printer the job was printed to.

%document% The name of the document printed.
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Field Description

%pages% The number of pages in the document.

%paper-size% The size of the paper used to print the doc-
ument.

Table 10.2. Fields available in print notifications

The default notification text in the application shows a variety of examples using these
fields.

10.4.1.2. Configuring Email Notifications

Before sending notifications via email, the system needs to know the SMTP server to deliv-
er emails to. The SMTP server can be internal or external to your organization however it
must allow forwarding of emails to your users. The SMTP server will typically be the same
server that users set in their email application to send emails.

To set the SMTP server:

1. Navigate to Options → Notifications.

2. Find the Email Options section.

3. Enter the SMTP server in the field provided.

4. It is also recommended that the subject and from address are changed to be applic-
able for your environment.

5. Press the Apply button.

Tip

If your email server requires authentication, the username and password can
be configured using the advanced configuration editor. For further details,
please contact PaperCut Software support.

10.4.1.3. Configuring Email Addresses

To send notification messages to users via email, an email address needs to be defined for
the user. User email addresses can be entered in the User Details screen. However, if all
email addresses match the pattern [username]@yourdomain.com, then the email ad-
dresses can be defined globally using the global email suffix. An example of how this
works is as follows:

1. An email notification needs to be sent to user brian.

2. No email address has been defined in Brian's user details, but a global email suffix of
@myschool.com is defined in the Email Options section.

3. To generate Brian's email address, the username (brian) and suffix
(@myschool.com) are combined to form the email address brian@myschool.com.
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To define the global email suffix:

1. Navigate to Options → Notifications.

2. Find the Email Options section.

3. Enable the Use email suffix to build user email addresses option.

4. Enter the Email Address Suffix.

5. Press the Apply button.

To confirm that the email suffix is working as expected:

1. Navigate to the Users section.

2. Select a user from the list.

3. The Use global email suffix option should be enabled, and the email field should
contain the address constructed from the username and suffix.

10.4.2. Testing Notification Methods

Once the system notifications are configured, it is useful to test that messages can be de-
livered. PaperCut NG provides a function to send test messages to users. This allows you
to verify that notifications are working without having to try to produce notifications artifi-
cially. To send a test notification:

1. Navigate to the Options → Notifications.

2. Scroll to the bottom of the page to the Test Notifications section.

3. Enter the username of the user to send the message to.

4. Select the delivery method to use.

5. Enter the notification message to send.

6. Press the Send Test Notification button

7. Verify that the notification was received.

10.5. System Security Options

The default installation of PaperCut NG is configured to be secure by default. After initial
installation only the admin user defined during the setup process is permitted to administer
the system. To allow additional users to administer PaperCut NG follow the instructions
defined in Section 3.6, “Assigning Administrator Level Access”.

10.5.1. Application Server Connections

By default PaperCut NG runs an internal web server on port 9191. All communication with
the server uses HTTP to this port and includes connections by:

• administrators to connect to the administration interface

• users to connect to the end-user interface

• the user client to communicate with the server to get the user balance and receive noti-
fications; and

• the information providers (as discussed in Section 1.1.2, “Key Features”) to send in-
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formation to the server

It is therefore important that all of the above clients can access this port on the server from
across the entire network. If your organization uses firewalls between departments or cam-
puses then it will be necessary to allow inbound HTTP connections on port 9191 to the Pa-
perCut NG application server.

The application server port can be changed from 9191 to any other value.

Important

If the application server port is changed, the port number also must be
changed in the applications that connect to the server. i.e, the print provider
and the user client.

To change the application server port:

1. On the server, navigate to the [appdir]\server\ directory.

2. Open the file server.properties.

3. Change the server.port to setting to the desired port.

4. Change the server port in all providers installed on your network. The server port is set
in the print-provider.conf file in the provider directory.

5. Change the server port in the user client config file:
[appdir]\client\config.properties.

Important

If the client is installed locally on workstations, then the config file will need
to be changed on each workstation.

On Linux/Unix systems, the server runs under the privilege of a non-root
account. Some systems may prevent non-root users from binding to ports
lower than 1024. An alternate option is to use kernel level TCP port redir-
ection (e.g. iptables).

6. Restart the application server. (See Section A.6, “Stopping and Starting the Applica-
tion Server”).

10.5.2. Provider Connection Security

The PaperCut NG architecture (as discussed in Section 1.2.3, “Architecture Overview” and
Section 12.4, “Print Monitoring Architecture”) involves having a central application server
and multiple information providers that send data to the server to process. One example of
a provider is the print provider which monitors printing and sends the printer activity to the
central server.

PaperCut NG supports an unlimited number of information providers and they can be loc-
ated on anywhere on the network. By default PaperCut NG allows these providers to con-
nect from any machine on the network. This can be restricted to a reduced set of machines
by specifying a list of IP addresses or subnets that are allowed to submit information to the
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application server.

To define the list of addresses that providers can connect from:

1. Navigate to Options → General.

2. Scroll down to the Security section.

3. Enter the list of IP addresses or subnet masks to allow. The list of addresses is
comma separated. The format of the subnet is X.X.X.X/Y.Y.Y.Y (where X repres-
ents the address and Y the subnet mask).

4. Press Apply.

5. It is then recommended to test all providers to ensure that they can still submit inform-
ation to the application server. To test the print provider, perform a test print job to the
server that the provider is running on.
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Chapter 11. TopUp/Pre-Paid Cards
Many organizations run PaperCut NG in either a silent logging mode or as a way of enfor-
cing sensible quotas. On the other hand, other organizations choose to run PaperCut NG
in “charging mode” requiring users to make payments in advance. Recording and entering
payments can be a time consuming process for staff or system managers. PaperCut NG
offers a web interface for user account management to assist with the process, however
there is still the need for someone to manually assign credit. The TopUp/Pre-Paid Card
system included with PaperCut streamlines the payment process and moves much of the
manual handling over to the end-user.

Cards are also known as:

• Vouchers

• Re-Charge Cards

• Pre-Paid Cards

11.1. Cards by Example

The card system is best described by walking through the payment process:

11.1.1. The User's Perspective

Amy is a student at a local high school. The school uses PaperCut NG for their charging.
Amy is allocated $5.00 a week for printing and Internet use. This week she has used all her
allocation but still has one assignment to print on Friday. She purchases a $5.00 Card from
school canteen. The card contains a 16-digit identification number. She logs onto the
schools intranet site, enters the PaperCut section, and enters the card's ID number. Her
account is automatically credited $5.00.

11.1.2. The Administrator's Perspective

Andrew is a system administrator at the same high school. At the start of the term he used
the PaperCut NG card wizard to generate 500 TopUp/Pre-Paid Card of $5.00 value. These
were generated in 2 batches. The first batch was prefixed with C1 and the second batch
L1. The C1 batch was sold at the school canteen and the L1 batch sold at the school lib-
rary. The cards are kept secured at these locations.

The card wizard generated a number definition file for each batch. Andrew imported these
numbers into PaperCut. Andrew took the time to customize the look of the cards to include
the school logo and simple instructions on how to use the card.

During the year Andrew is able to track the cards sold and uses the batch prefixes to track
where students like to purchase cards. Andrew also keeps an eye on the event log and has
disciplined students attempting to guess card numbers.

11.2. The Card System

PaperCut Software Pty Ltd has worked with a number of organizations to design the
TopUp/Pre-Paid Card system. A number of payment technologies were evaluated over the
period of two years. These technologies included vending machines, smart cards, micro-
payment systems, and manual processing. The card system proved to be the most suc-
cessful and cost effective solution. The card concept is now the de facto standard in other
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industries such as pre-paid mobile phones.

The PaperCut NG card system is 100% software based. There is no need for special hard-
ware such as smart card readers or special vending machines.

The card system is included as standard with PaperCut NG. The system includes:

• A card wizard application for assisting with the process of creating new cards.

• A web page for end-users to enter card numbers.

• A security framework for tracking card use and implement fraud prevention.

11.3. Creating New Cards

11.3.1. Overview and Definitions

Cards are generated using the Card Wizard. The card wizard is a Microsoft Windows ap-
plication that integrates with Microsoft Word. The card wizard install can be downloaded
from inside the PaperCut NG administration login under the Card section. The download
link is located in the Actions area.

Important

The Card Wizard integrates with Microsoft Word. Please ensure that Microsoft
Word is installed before using the Card Wizard.

Term Definition

Card Wizard A tool to help administrators produce a set
of cards. The wizard generates cards ready
for printing and a number definition file suit-
able for importing into the PaperCut NG
system.

Card Number All cards are designated a unique number.
PaperCut uses this number to identify the
card and its value. Users enter this number
to allocate the credit to their account. An
example number:

P0409-1945-4833-5750-4452

Batch ID A batch ID is a user defined ID or number
assigned to all cards in a batch. The batch
ID will prefix all card numbers and are used
to identify the source of a card. A unique
number should be assigned to each batch.

Valid Till Date (Expiration Date) Define the date on which a card can no
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Term Definition

longer be used. It's analogous to a “use by”
date on a gift certificate. Expiration dates
ensures cards only remain in circulation for
a limited period of time. A six to 12 month
period is recommended. In a school envir-
onment it may be useful to define an expir-
ation date as the last day of the semester.

Mail Merge Mail merge is an advanced feature of Mi-
crosoft Word. The mail merge feature takes
a design template and a data source, and
merges the two together to construct a
composite document. In the card wizard's
case, the number list is the data source and
the design template is the template Mi-
crosoft Word document.

Number Definition File The number definition file contains informa-
tion on all cards in a batch including a list of
card numbers, their expiration date, and
value. The card wizard creates this file dur-
ing the generation process and the system
administrator will import this file into the
Card administration section.

Card Number Entry Page The card web entry page is a designated
page inside the user login section.

Table 11.1. Card Terminology

11.3.2. Using the Card Wizard

This section will walk you through the process of creating a batch of TopUp/Pre-Paid
Cards. The example covers creating a batch of 100 cards of value $10.00 each.

11.3.2.1. Step 1 - Install the card wizard

Log onto a desktop system with Microsoft Word installed (normally not the server!). Open a
web browser at:

http://[server_name]:9191/admin

Log into PaperCut NG as admin and navigate to the Cards section. Download the card
wizard from the Download card wizard action. Run the install program and complete the
installation process.

11.3.2.2. Step 2 - Welcome

Open the Card Wizard from the start menu, and press Next>.
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11.3.2.3. Step 3 - Batch ID

Enter a unique batch ID to define this batch and click Next>. We recommend adapting a
consistent convention. For example, choose numbers representing the date, or a sequen-
tial numbering scheme.

Figure 11.1. Entering a batch ID

11.3.2.4. Step 4 - Card Attributes

Ensure that the number of cards is set up to 100 and the value of each card is $10.00. By
default the valid till date is set 6 months in the future. We recommend defining an appropri-
ate date that corresponds to a fixed event such as the end of the year, budget year, term or
semester.
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Figure 11.2. Defining a valid till date

11.3.2.5. Step 5 - Design

To produce a set of standard cards, custom design is not required. Simply click the Next>
button to move to the next step. Modifying the custom design requires knowledge of Mi-
crosoft Word's mail merge functionality. See the Section 11.3.3, “TopUp/Pre-Paid Card
Tips” for further details.

Figure 11.3. Options to edit the card design
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11.3.2.6. Step 6 - Generate Numbers

Press Next> to generate the card numbers. The card wizard will prompt you for a location
to save the number definition file. Save the file on the local hard driver or a secure network
drive.

11.3.2.7. Step 7 - Create Cards

The card wizard will now generate a merged Microsoft Word document. Before generating
the Word document, the card wizard will ask you if Macros have been enabled in Microsoft
Word. If the answer is no, or you are unsure, please say No and the card wizard will guide
you through the process of enabling Macros. The card wizard uses Word Macros to auto-
mate much of the card generation process.

11.3.2.8. Step 8 - Printing Cards

A new Microsoft Word document will open, listing all 100 cards. The cards are standard
business card size suitable for printing on heavy paper and cutting with a paper cutter. For
a professional look, consider forwarding a PDF version to your local printing shop. See
Section 11.3.3, “TopUp/Pre-Paid Card Tips” for more ideas.

Figure 11.4. Cards ready for printing
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11.3.2.9. Step 9 - Importing

The final step is to activate the cards by importing the number definition file in the Paper-
Cut NG admin section.

1. Navigate to the Card section.

2. Select the Import New Cards action.

3. Click the Browse button and locate the number definition file as saved in step 5
above.

4. Click the Upload button.

Figure 11.5. Imported card numbers

11.3.2.10. Step 10 - Testing

It is good practice to test the card process by using one of the cards on a test account
(standard user level). Remember to destroy the spent card used for the test!

11.3.3. TopUp/Pre-Paid Card Tips

11.3.3.1. Security

The PaperCut NG card system is designed with security in mind. All fraudulent card use at-
tempts are detected, trapped and logged. The number allocation system is highly secure
and guessing a number is “statistically impossible”. With 1,000 cards in circulation, the
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chance of guessing a number is 1-in-10,000,000,000,000, or in non-mathematical terms, it
would take over 300,000 years to guess a number if a person enters one number every
second!

Like many IT security systems, the weakest link in the system is the human interface.
Cards are a form of virtual currency. Care should be taken to protect the cards from unau-
thorized access and disclosure.

• Ensure the generated Microsoft Word document is deleted or saved in a secure place
after the cards are printed.

• Always delete the number definition file after importing the batch into PaperCut.

• Never leave the cards in an unsecured or visible location. Consider sealing cards in en-
velopes.

• Check the PaperCut NG application event log on a weekly basis for security messages.
PaperCut will log and trap unauthorized card use.

• Use the card log to track card use and allocation.

• Cancel/Expire lost or stolen cards by batch number as soon as the problem is reported.

Important

The cards are like a form of cash and should be treated with the same care.
Make sure the cards are carefully secured.

11.3.3.2. Cards Design

The Edit Template... button in Step 4 of the card wizard opens the standard card template
for editing. The card wizard is able to use any standard mail merge design. It's even pos-
sible to convert the template layout to letters rather than cards. Microsoft's mail merge sup-
port is designed for Word “power users”. Consider taking the step-by-step mail merge tu-
torial provided with Microsoft Word help if you do not have experience with Word's mail
merge functionality.

Consider keeping your customizations initially simple and work up towards more complex
configuration.

To change the logo graphic:

1. Click the Edit Template... button in step 5.

2. Say Yes to Enable Macros.

3. Select the standard PaperCut logo and press the Delete button on the keyboard.

4. Select Insert → Picture → From File...

5. Locate the desired logo and click Insert.
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Figure 11.6. Inserting a new logo into a card

6. Click on the Propagate Labels button on the mail merge tool bar. The new logo
should propagate across all cards on the page.

Figure 11.7. Propagate labels button

7. Click File → Save and close Microsoft Word.

8. Test the template by running a batch in the card wizard.

Tip

Design Recommendations:

• Consider changing the logo and adding your organization name

• Change the URL reference to point to your intranet site or event your net-
work/card policy page.
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• Provide basic instructions on how to use the card or the location of an in-
formation page.

11.4. Using a Card

To use a TopUp/Pre-Paid Card to assign credit to your account (a standard user's ac-
count):

1. Purchase a card from the appropriate person or place. The network administrator cre-
ates cards specific for the organization. In schools, cards are often sold at the library,
general office or school cafeteria.

2. Open a web browser and navigate to the PaperCut NG user login page. After logging
in, your account status should display.

3. Click on the Use Card link on the left-hand navigation bar.

4. Enter the Card Number in the Card Number box and press Use Card.

5. If the card's number is valid, the credit as listed on the card will be transferred to your
account and this will list in your transaction history.

Figure 11.8. Using a card
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Chapter 12. Configuring Secondary
Print Servers and Locally Attached
Printers

This section covers the setup of a secondary print server in "Quick Start" format. For a de-
tailed explanation of the underlying technology and what's happening behind the scenes
see the subsequent sections.

A secondary print server is a system that directly hosts a printer. In many situations it may
be a dedicated server, however a secondary server may also be a desktop system hosting
a directly attached USB printer. If this printer is to be controlled and tracked by PaperCut
NG, a small monitoring component needs to be installed. The monitoring component inter-
cepts the local printing and reports this use back to the primary Application Server. A sec-
ondary server may either be:

1. A server style system hosting many printers.

2. A desktop style system hosting printer(s) also shared to other network users.

3. A desktop style system with the printer used only for local users (not shared).

The monitoring service is also referred to as a Print Provider as its task is to provide in-
formation back to the main Application Server.

The process of setting up a secondary print server, depends on the operating system.
Read the section appropriate to the required operating system.

12.1. Configuring a Windows Secondary Print Server

This section describes the process of setting up a secondary Windows print server.

12.1.1. Step 1 - Ensure primary server is set up correctly

Before installing a secondary server you should take some time to ensure the primary serv-
er (central application server) is set up and running correctly. If it is not running fine now
adding an extra server will only "add an extra variable to the equation" and complicate
troubleshooting. Take some time now to verify that the primary server is functioning cor-
rectly. For example, verify that:

• Printers on this server are being tracked.

• Users are allowed top login to user pages from their workstations.

• Administrators can access the system.

12.1.2. Step 2 - Ensure firewall software is set to allow access to port 9191

Secondary server needs to communicate (initiate a TCP connection) on port 9191. Admin-
istrators should ensure that any firewall software on the primary Application Server is not
set to block any incoming local network traffic on this port.

12.1.3. Step 3 - Install the print provider
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Install the print provider software onto the secondary server. On a Windows server, this is
done by selecting the "Secondary Print Server" option in the installation wizard.

12.1.4. Step 4 - Configuration

The Print Provider on the secondary server needs to know where the primary server is in-
stalled.

1. Open a text editor such as Notepad.

2. Open the file:

[app-dir]\PaperCut NG\providers\print\win\print-provider.conf

3. Locate the line starting with ApplicationServer= and change localhost to the
name or IP address of the primary server.

4. Restart the server so the new configuration is detected. To avoid a restart, an adminis-
trator may also choose to manually restart the PaperCut Print Provider service.

12.1.5. Step 5 - Test

The secondary server should now be configured. Log into the system as "admin" and verify
that the printers are now listed under the Printers section. Perform a multi-page test print
on each printer and verify that print jobs are tracked correctly.

12.1.6. Automated Install

The installation of the secondary server component on Windows systems can be auto-
mated. This may be handy when the Print Provider component needs to be installed on a
number of desktop systems running locally attached printers. For more information see,
Section 12.6, “Automating Secondary Server Deployment on Windows”.

12.2. Configuring a Macintosh Secondary Print Server

This section describes the process of setting up a secondary Mac print server. The primary
Application Server may either be a Windows, Mac or a Linux basis system. PaperCut NG
has full support for "mixed" or heterogeneous printing environments.

12.2.1. Step 1 - Ensure primary server is set up correctly

Before installing a secondary server you should take some time to ensure the primary serv-
er (central application server) is set up and running correctly. If it is not running fine now
adding an extra server will only "add an extra variable to the equation" and complicate
troubleshooting. Take some time now to verify that the primary server is functioning cor-
rectly. For example, verify that:

• Printers on this server are being tracked.

• Users are allowed top login to user pages from their workstations.

• Administrators can access the system.

12.2.2. Step 2 - Ensure firewall software is set to allow access to port 9191

Secondary server needs to communicate (initiate a TCP connection) on port 9191. Admin-
istrators should ensure that any firewall software on the primary Application Server is not
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set to block any incoming local network traffic on this port.

12.2.3. Step 3 - Create the host user account

PaperCut NG runs under a non-privileged user account called "papercut". This invisible
system account is created automatically upon first install. Advanced system administrators
may however have a preference to create this account manually. If you fall into this cat-
egory, create the papercut account now prior to installation.

12.2.4. Step 4 - Install the print provider

Install the print provider software onto the secondary server. Download the latest Mac
DMG disk image and execute the contained installer called PaperCut NG Secondary
Server Installation.pkg.

12.2.5. Step 5 - Configuration

The Print Provider on the secondary server needs to know where the primary server is in-
stalled. The installer may open the appropriate configuration file after the install completes.

1. Open a text editor such as TextEdit.

2. Open the file:

[app-dir]/PaperCut NG/provider/print/ mac/print-provider.conf

3. Locate the line starting with ApplicationServer= and change localhost to the
name or IP address of the primary server.

4. Save the file and exit the text editor.

Double-click on the command script [app-dir]/PaperCut NG/Configure
CUPS.command, and enable monitoring on the appropriate printers.

12.2.6. Step 6 - Test

The secondary server should now be configured. Log into the system as "admin" and verify
that the printers are now listed under the Printers section. Perform a multi-page test print
on each printer and verify that print jobs are tracked correctly.

12.3. Configuring a Linux Secondary Print Server

This section describes the process of setting up a secondary print server on a Linux sys-
tem. The primary Application Server may either be a Windows, Mac or a Linux based sys-
tem. PaperCut NG has full support for "mixed" or heterogeneous printing environments.

12.3.1. Step 1 - Ensure primary server is set up correctly

Before installing a secondary server you should take some time to ensure the primary serv-
er (central Application Server) is set up and running correctly. If it is not running fine now,
adding an extra server will only "add an extra variable to the equation" and complicate
troubleshooting. Take some time now to verify that the primary server is functioning cor-
rectly. For example, verify that:

• Printers on this server are being tracked.

• Users are allowed user login to user pages from their workstations.

• Administrators can access the system.
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12.3.2. Step 2 - Ensure firewall software is set to allow access to port 9191

Secondary server needs to communicate (initiate a TCP connection) on port 9191. Admin-
istrators should ensure that any firewall software on the primary Application Server is not
set to block any incoming local network traffic on this port.

12.3.3. Step 3 - Account setup

On the secondary server, create a user account called papercut. The papercut user's
home directory should be set to the desired install location. This is normally /
home/papercut.

12.3.4. Step 4 - Install the Print Provider

Install the Print Provider software onto the secondary server by copying all files and direct-
ories from the primary Application Server's directory:

[app_dir]/providers/print/linux-i686/*

To the location:

/home/papercut/providers/print/linux-i686/

on the secondary server. Perform the copy operation as the papercut so files are owned
by the papercut user. This process can be summarized with the following commands:

shell> su - papercut
shell> mkdir -p providers/print/linux-i686
shell> scp primary.server:/home/papercut/providers/print/linux-i686/* \

providers/print/linux-i686/

After the copy operation is performed, execute the setperms and roottasks scripts as
root:

shell> sh providers/print/linux-i686/setperms
shell> sh providers/print/linux-i686/roottasks

so all permissions are set up correctly.

12.3.5. Step 5 - Configuration

The Print Provider on the secondary server needs to know where the primary server is in-
stalled.

1. Open the file:

/home/papercut/providers/print/linux-i686/print-provider.conf

Configuring Secondary Print Servers and
Locally Attached Printers

137



in a text editor.

2. Locate the line starting with ApplicationServer= and change localhost to the
name or IP address of the primary server.

The binaries copied in step 4 now need to be integrated into the CUPS or Samba print
queues. This process is detailed in the Quick Start Guide for Linux under Section 1.5.5,
“Step 5 - Configuring Printers”.

12.3.6. Step 6 - Test

The secondary server should now be configured. Perform some test printing on all of this
secondary server's printers. Log into the system as "admin" and verify that the printers are
now listed under the Printers section. Perform a multi-page test print on each printer and
verify that print jobs are tracked correctly.

12.4. Print Monitoring Architecture

This section covers PaperCut NG print monitoring architecture from a technical perspect-
ive. Knowledge of advanced networking is expected.

PaperCut NG is designed using the latest software design principles. An important design
principle used is Service Oriented Architecture (SOA). PaperCut NG divides key operation-
al areas into components. These components communicate using an XML Web Services
standard. Two of the main services are:

Service/Component Description

The Application Server The central logic service responsible calcu-
lating user costs and providing the web and
admin interface.

Print Provider Service A service responsible for monitoring and
analyzing print jobs and reporting this in-
formation using XML Web Services to the
application server.

Table 12.1. PaperCut NG services/components

In a single server setup, an administrator does not need to be concerned with the two com-
ponents as they automatically act as one (it's only noticeable in that two processes are run-
ning on the server). On a multi-server/system environment a deeper understanding of the
architecture is required.

12.5. Multiple Print Servers

Many large networks, or even smaller networks with a legacy design, may be composed of
more than one print server. Reasons for separating printers across servers/systems in-
clude:

• Legacy design - “That's the way the previous admin set it up.”

• Networks with 100 printers or more may need multiple servers to spread the printing
load.
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• Networks spanning multiple physical sites or subnets may have separate servers min-
imize cross-site network traffic.

• Servers may exist to support different operating systems

• A local desktop printer attached to a system is also a remote print server.

One of the servers on the network needs to be nominated as the primary server. This sys-
tem runs the Application Server software responsible for providing the user interface, stor-
ing the data, and managing the application logic. The system nominated for this task is
usually a print server (but could be any server). It needs to be a system with spare capacity
to run the PaperCut NG application server software. This system should have good per-
formance, have at least 500 Mb of free hard-disk space, and be included in an off-disk
backup routine.

Other print servers are known as secondary servers. These servers run the Print Provider
component and communicate back to the central server. The following diagram illustrates
this setup.

Figure 12.1. Secondary server reporting back to primary server (application server)

When a client prints to a secondary server, the Print Provider intercepts the print job and
forwards the information to the central server for processing. Communication is via XML
Web Services over HTTP on the PaperCut Application Server's nominated port (normally
port 9191). The web services protocol is specifically designed to facilitate easy firewalling,
scalability, and will work over a wide range of network speeds.

PaperCut NG Service Oriented Architecture offers many advantages for network adminis-
trators including:
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• Secondary servers run the minimum amount of software

• Communication between servers uses minimal bandwidth. Physically separated servers
connected via WAN links, VPNs or other slow links are supported with minimal or no
impact on printing performance.

• All data, logging and configuration information is stored on one single central server fa-
cilitating central backup from one location.

• Management may be conducted centrally from one location.

PaperCut NG's SOA design allows advanced setups including:

• Decentralized deployment

• Separation of concern (servers dedicated to separate tasks such as database server,
application server and print server)

• Options to remove points of failure via clustering or fail-over

Figure 12.2. PaperCut NG Architecture - an advanced configuration

12.6. Automating Secondary Server Deployment on Windows

The secondary server installation process can also be automated via command line
switches issued to the installer program. This may be useful when there is a need to install
the Print Provider on a number of desktop systems hosting local attached printers.

To automate the installation:

1. Copy the windows installer program, pcng-setup.exe, into a directory accessible to
the target systems (i.e. A network share or mapped drive).

2. Copy the print-provider.conf file from main server. This file is located at
[app-dir]/providers/print/win. Place the file in the same directory as the in-
stall program (as performed in step 1.)
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3. Edit the print-provider.conf file and define the correct server name or IP ad-
dress of the main application server in the line starting with ApplicationServer= .

4. Use a batch file or equivalent to start the install program as follows:

pcng-setup.exe /COMPONENTS="prov_print" /SILENT

Note: The installer requires administrator level - needed to install a system service.

Note:

• The executable name of the installer program may vary depending on the version.

• Replacing the /SILENT option with /VERYSILENT will suppress all visual output during
the installation process.

• The copy of the print-provider.conf file is used during the install process to en-
sure the installation is aware of the location of the main application server.
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Chapter 13. Advanced Customization
PaperCut NG is an important part of network infrastructure at many thousands of organiza-
tions. Having the ability to seamlessly integrate PaperCut into an existing network is im-
portant. There are a number of ways to ensure end-users see the system as part of the
network rather than an add-on. These include:

• Changing the URL or link on the User Client window

• Customizing the look and feel of the use web pages

• Using the PaperCut NG back-end data in other procedures such as custom reports

This section covers some of the customization options available within PaperCut NG.

13.1. Customizing the User Client Tool window

The pc-client.exe program displays a small window highlighting the current logged in
user's current account balance. This window contains two links. One called Details that
takes the user to the User Pages login. The other defaults to the PaperCut Software web-
site. The link to the PaperCut Software website can be replaced. Some suggestions in-
clude linking to your organization's website or intranet site, or linking to a page containing
your organization's network usage policy. The logo used on the window can also be cus-
tomized.

To change the link on the User Client window:

1. Login to the system as an administrator (e.g. the built-in admin account).

2. Navigate to the Options section.

3. Click on the Config editor link in the list of actions.

4. In the quick find are enter client.config and press GO.

5. Locate the key titled config.client.link-url and enter a new value pointing to
your new destination. The link should be a complete URL including the http:// com-
ponent. e.g. http://www.myorganization.com/printpolicy.htm.

6. Press the Update button to the right to apply the change.

7. Locate the key titled config.client.link-text and enter the text that should be
displayed. e.g. Print Policy.

8. Press the Update button to the right to apply the change.

9. The next time the client tool is started on one of the workstations, the new link will be
displayed.

Figure 13.1. Customized user client link
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There are other configuration keys that allow an administrator to customize the user client
for their organization. The table below outlines all of the client customization keys avail-
able. These values are updated by following a similar process as described above.

Config name Description

client.config.link-text The text to appear on the link at the top of
the user client.

client.config.link-url The destination URL of the link displayed at
the top of the user client. For example, this
can be point to the internal intranet page
describing printing policies.

client.config.show-link Indicates whether the link at the top of the
user client should be displayed. To display
set the value to Y, to hide set the value to
N.

client.config.show-details-link Indicates whether the "Details" link that
points to the user web interface is dis-
played. To display the link set the value to
Y, to hide set the value to N.

client.config.show-document-cost Determines whether to show the document
cost to the user in print popup notifications.
To show the cost set the value to Y, to hide
set the value to N.

Table 13.1. User Client Customization Config Keys

The logo used on the User Client balance window and the account selection dialog can
also be customized by placing a file called client-logo.png in the directory
[app-path]/client - the same directory as the executable. The image must satisfy the
following requirements:

• Comply to the PNG (Portable network graphic) format.

• A size of 64px by 64px.

• Display correctly on different background colors (make use of transparencies or alpha
channels).

13.2. Customizing the User web pages

The user pages display information about the user's account and provide access to fea-
tures such as TopUp/Pre-Paid Cards. The visual design of these pages can be tailored to
make them fit into the look and feel of an existing internet or intranet site. This gives the
pages an official look ensuring your users see the system as an important part of your or-
ganization's network.
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Figure 13.2. A customized end-user web designed for Flora Hill Secondary College

Figure 13.3. A customized end-user web designed for Ross University

PaperCut Software Pty Ltd offers a service where their developers will undertake design
work based on an existing website. If you would like assistance with the customization,
please email the PaperCut Software Pty Ltd support team.

Organizations whose staff have good to advanced HTML experience may choose to cus-
tomize the pages in-house.

The design of the user pages is controlled via HTML "include" files for the header and foot-
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er areas of the page, with page styling controlled via Cascading Style Sheets (CSS). Pla-
cing the following files in the PaperCut NG directory structure at
[appdir]/server/custom/web overrides page layout and style.

Filename Description

user.css If this file exists, the contents of user.css
is included as an overriding stylesheet.
Styles in this file can be used to define
fonts, colors and sizes.

header.inc If the header include file exists, the HTML
in the header area of the pages is replaced
with the contents of the file.

footer.inc If the footer include file exists, the HTML in
the footer area of the page is replaced with
the contents of the file.

login-logo.png If this file exists, the logo on the web-based
login page is replaced with the supplied im-
age. The file should be an image of size
250px by 64px in PNG format.

Table 13.2. Files used to customize the user web pages

Tip

Any custom content placed in [appdir]/server/custom/web, such as ad-
ditional images, can be accessed via a URL beggining with /custom. For ex-
ample, if a file named header.jpeg is placed in
[appdir]/server/custom/web, it can be accessed via the URL /
custom/header.jpeg.

13.3. Data Access and Custom Reports

The default PaperCut NG installation stores data in an internal database. For the interested
person, the database is Apache Derby - an open source database written by IBM and
based on their DB2 Cloudscape Database. The internal database is very robust, ACID
compliant and scales well. PaperCut NG also has the option to use an external database
such as Microsoft's SQL Server. Running on an external database offers some advant-
ages, one of which is the ability to access the data using 3rd party reporting tools such as
Crystal Reports. For more information see Chapter 15, Deployment on an External RD-
BMS.

Tip

Note: Future versions of PaperCut NG will include direct ODBC connections to
the internal database. Currently this is disabled due to potential security is-
sues. Please contact support if you're interested in this option.
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The PaperCut NG data structure is relatively simple and people with Crystal Report or SQL
experience should have no problems extracting data or written custom reports. Report de-
velopers should keep in mind:

• Only access the data in a read-only mode. Modifying data directly underneath the ap-
plication may cause unpredictable behavior

• Always test any custom reports after an upgrade as the underlying data format may
have changed. PaperCut Software developers try to minimize data structure changes
but they are expected to occur in major upgrades.

13.3.1. Plain Text Print Log

In addition to storing print log information in the database, a real-time, plain text log is also
written into the directory:

[appdir]/server/logs

The log file is in a tab delimited format and a new log is created for each day. Files are
named with the format printlog_yyyy_mm_dd.log and files are archived for 30-days.
The tab delimited file can easily be imported into programs such as Microsoft Excel, Mi-
crosoft Access or other database.

Field Description

Field 1 Date in format yyyy-MM-dd\th:mm:ss
a/p

Field 2 Server Name

Field 3 Printer Name

Field 4 User who printed the document

Field 5 Account charged (usually the user's per-
sonal account but could be a shared ac-
count)

Field 6 Client/Workstation Name

Field 7 Document name

Field 8 Total number of pages

Field 9 Number of copies (this has already been
used to calculate the total pages).

Field 10 Cost

Field 11 Duplex status
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Field Description

Field 12 Grayscale status (Color mode)

Field 13 Paper Size (e.g. Letter, A4)

Field 14 Paper Height in Millimetres (divide by 24.5
for inches)

Field 15 Paper Width in Millimetres (divide by 24.5
for inches)

Field 16 Print job size in KB

Field 17 Printer Language

Table 13.3. Text print log file format

13.4. Automation and Scripting

PaperCut NG provides a detailed set of server commands and Web Services API's. These
services may be used to automate common operations and management tasks. Some ex-
amples of where an administrator may choose to use scripting/automation include:

• Automate tasks such as backups and domain user/group synchronization.

• Integrate account creation and management into existing scripts or processes.

• Manage account balances and transactions outside the application.

The automation and scripting tools are written for software and script developers. It is ex-
pected that readers intending on using these tools are comfortable with developing system
management and server monitoring programs.

The server-command and Web Services API's are included as standard with PaperCut
NG. More information on using these tools is detailed in Appendix A, Tools (Advanced) in
Section A.1, “Server Commands (server-command)” and Section A.3, “The XML Web Ser-
vices API”.

13.5. Custom User Directory Information Providers

PaperCut NG is a modern application designed with a modern architecture. It supports
plug-ins and extensions at a number of different levels. One such layer is the User Direct-
ory source. Organizations with very complex domains, such as those seen in large uni-
versities, can be accommodated either with the standard options, or if the standard options
are not sufficient, via a custom plug-in.

For example, a University may have multiple domains, one running Active Directory and
the other LDAP/NIS. A custom plug-in could support this by first querying Domain A, and if
the user is not found, the query Domain B via LDAP. The PaperCut NG development team
is happy to provide API documentation and sample source code to assist organizations
with custom requirements.
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For some working examples available in your current installation, look in:
[app-dir]/server/bin/linux-i686/sambauserdir,
[app-dir]/server/bin/linux-i686/authsamba and
[app-dir]/server/bin/linux-i686/src/ .
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Chapter 14. Licensing and Support
This section describes how to install the PaperCut NG license you receive after purchase,
and also provides information about gaining support and assistance.

14.1. Installing a License

PaperCut NG licenses are issued as a digitally signed file. Installing the license file into the
application enables the software for use within your organization.

To install the license file supplied by your vendor:

1. Save the license file to your hard disk. Files are typically named PaperCut NG-
[orgname].license.

Tip

There is no need to unzip the file. The file can be loaded into the system
as supplied.

2. Log into the administration interface.

3. Navigate to the About section.

4. Scroll down to the Register section and click the Browse... button.

5. Locate the license file saved in step 1 and click Open.

6. Click the Install license button.

7. Verify license information is correctly listed in the About page.

Note

The file supplied is simply a digitally signed and zipped text file containing your
license information. It's converted to ZIP format to minimize size. If you're inter-
ested in viewing the contents of the file, rename the file to .zip and simply open
it in any ZIP extraction utility.

If you have a question about your license or need assistance please email the PaperCut
Software Pty Ltd technical support team and they will be more than happy to assist you.

14.2. Technical Support & Further Information

The PaperCut Software development team is always happy to assist customers with fur-
ther technical questions. Please feel free to contact us via email or phone. The develop-
ment team may also be contacted via the live web chat feature available on the PaperCut
Software Pty Ltd website at http://www.papercut.biz/.

You may also find lots of other useful information in the Knowledge Base located at: ht-
tp://www.papercut.biz/kb

The Knowledge Base is updated regularly and is a good place to start if your question is
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not addressed in this user manual.
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Chapter 15. Deployment on an
External RDBMS
15.1. Overview

This section describes the process of running PaperCut NG on an external relational data-
base, and describes why an organization would choose to do this. By default PaperCut NG
uses an internal database product known as Apache Derby. This database engine was
donated to Apache by IBM and was previously known as IBM Cloudscape.

15.1.1. Why use an external RDBMS?

The internal PaperCut NG database is stable, scalable, self-maintaining and provides very
good performance. For this reason most organizations do not need to run PaperCut NG on
an external database system. However there are some good reasons to run PaperCut NG
on an external RDBMS, including:

• Your organization has existing database infrastructure and would like to consolidate all
applications on the same database platform.

• Your organization has an existing database maintenance and backup procedure and
would like PaperCut NG to take advantage of this.

• People would like to use 3rd party reporting and analysis tools (like Crystal Reports) to
view and analyze the PaperCut NG database.

• Your organization is very large and requires the performance benefits of a dedicated
RDBMS. This also allows the database to reside on a separate server to PaperCut NG,
which improves the system scalability.

15.1.2. Supported Databases

PaperCut Software Pty Ltd supports the following two external databases out-of-the-box:

• Microsoft SQL Server 2000 (or later)

• Microsoft SQL Express 2005 (free from Microsoft)

• PostgreSQL 7.1+ (the free open source database).

These databases were chosen to cater for the majority of our customers. Most customers
have existing SQL Server licenses so can take advantage of this support. PostgreSQL was
chosen as the second alternative RDBMS because it is free, open-source and supported
on all common platforms.

PaperCut NG also supports the following databases, but because they are less common
with our customers, supporting these databases will incur an additional fee. Contact Paper-
Cut Software Pty Ltd for details.

• Oracle 8i, 9i, 10g

• DB2 7.1, 7.2, 8.1

• Sybase 12.5

• MySQL 4.1+
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• SAP DB 7.3

• Informix

• Ingres

• FrontBase

• Mckoi SQL

• Firebird 1.5+

15.2. Upsizing to an External RDBMS

Upsizing to an external RDBMS is a simple process that should take approximately 15-30
minutes. The high-level steps to upsize are:

• Backup the existing data.

• Create and initialize the new database.

• Load the backed-up data into the new database.

• Restart the application.

These steps are discussed in detail below.

15.2.1. Step 1 - Stop the PaperCut NG application

To upsize to an external database the application server should be stopped. This allows
the data to be backed up, guaranteeing that all data is saved and ready to load into the
new database.

The instructions to stop the application server can be found in Section A.6, “Stopping and
Starting the Application Server”.

15.2.2. Step 2 - Perform a backup of the existing data

Perform a backup of the database. This data will be loaded into the application in a future
step. A detailed discussion about backups can be found in Section 10.3, “System
Backups”. To backup the database:

1. On the server, open a command prompt.

2. Change to the server binaries directory. On Windows this is:

[appdir]\server\bin\win

3. Run the following command: db-tools export-db

4. The output of the above command shows the name of the backup file created. Take
note of this because it will be required in a future step.

15.2.3. Step 3 - Create a new database in the external RDBMS

This step depends on the external database you are using, and it is assumed that the ad-
ministrator knows how to create a new database. No matter what database is used the fol-
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lowing steps must be performed:

1. Create a new empty database for dedicated use by PaperCut NG. When creating the
database make sure to select the correct character encoding for your language. For
SQL Server, the character encoding is set in the Collation field on the new database
screen. For other databases like PostgreSQL it is recommended to select a unicode
character set (like UNICODE or UTF8) that allows all possible characters to be stored.

2. Create a new database user (and password) for the PaperCut NG to use to connect to
the database.

3. Assign the appropriate permissions to the new user to give them full access to the new
database (e.g. permission to create/drop tables, and select/insert/update/delete in all
tables).

Important

The database user created for PaperCut NG should only have minimal set of
permissions required for the application. The user should have full permissions
to create/drop tables and have full access to any created tables. However, the
user should not have permissions to access other databases you have in-
stalled on the database server.

15.2.4. Step 4 - Change the PaperCut NG connection details

The next step is to configure PaperCut NG to connect to the new external database. To do
this:

1. On the server, open the server config file:

[appdir]/server/server.properties

2. On the server, open the server config file:

[appdir]/server/server.properties

in a text editor (e.g. Notepad).

3. Comment out the line:

database.type=Internal

by adding a # (hash) character to the beginning of the line.

4. Find the database connection details for the database type you require (e.g. SQL
Server or PostgreSQL), and uncomment the lines by removing the # (hash) charac-
ters.

5. Set the username and password used to connect to the database

database.username=[your-db-user]
database.password=[your-db-password]
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6. Set the database URL, which describes the location and connection details of the ex-
ternal database. See below for details of the format of the database URLs for different
database types.

Important

If using Microsoft SQL Server, the username specified in the configuration set-
tings is a SQL Server database user, not a Windows user. This user needs to
be created in the SQL Server and granted full rights to the application data-
base.

15.2.4.1. SQL Server Database Connection URL Format

The SQL Server URL format is:

jdbc:jtds:sqlserver://[server]/[database]

The [server] parameter is the name of the server running the SQL Server database, and
must be resolvable from the PaperCut NG server. If the SQL Server instance is running on
the same machine then localhost can be used.

The [database] parameter is the name of the SQL Server database you created in Step
3 above.

15.2.4.2. SQL Server 2005 Express Database Connection URL Format

The SQL Server 2005 Express format is:

jdbc:jtds:sqlserver://[server]:[port]/[database]

The [server] parameter is the name of the server running the SQL Server database, and
must be resolvable from the PaperCut NG server. If the SQL Server instance is running on
the same machine then localhost can be used.

The [port] parameter is the port the SQL Server Express edition is configured to listen
on. For more information on configuring SQL Express, please see Section 15.3,
“Configuring Microsoft SQL Express 2005”.

The [database] parameter is the name of the SQL Server database you created in Step
3 above.

15.2.4.3. PostgreSQL Database Connection URL Format

The SQL Server URL format is:

jdbc:postgresql://[server]/[database]
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The [server] parameter is the name of the server running the PostgreSQL database,
and must be resolvable from the PaperCut NG server. If the PostgreSQL instance is run-
ning on the same machine then localhost can be used.

The [database] parameter is the name of the PostgreSQL database you created in Step
3 above.

15.2.5. Step 5 - Initialize the new database

The next step is to initialize the new database, creating the required database tables and
initial data. To initialize the database:

1. On the server, open a command prompt.

2. Change to the server binaries directory. On Windows this is:

[appdir]\server\bin\win

3. Run the following command: db-tools init-db

A message will be displayed to indicate that the connection details are correct the data-
base was initialized correctly.

15.2.6. Step 6 - Load the data into the new database

This step loads the data (that was exported in Step 2) into the database. To import the
data:

1. On the server, open a command prompt.

2. Change to the server binaries directory. On Windows this is

[appdir]\server\bin\win

.

3. Run the following command: db-tools import-db "backup file name"

4. This command will show progress importing the data.

If no errors occurred then the application is ready to restart.

15.2.7. Step 7 - Restart the PaperCut NG application server

The data has now been moved to the new database and the server can be restarted.

The instructions on how to start the server can be found in Section A.6, “Stopping and
Starting the Application Server”.

Wait 30 seconds for the server to start, then log in to the admin console. If you can log in
successfully, then the upsizing process worked successfully.

15.3. Configuring Microsoft SQL Express 2005
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Microsoft SQL Express 2005 provides enterprise class database performance for free.
However it does have some limitations when compared to the full version of SQL Server.
But these limitations are not likely to adversely affect most PaperCut NG users. These lim-
itations include:

• 4GB limit on database sizes

• Limited to only use 1 CPU

• Limited to only use 1GB of RAM

This section described how to configure Microsoft SQL Express edition for use with Paper-
Cut NG. It is assumed that SQL Server Express is already installed with the default config-
uration.

Once this configuration is complete, the database can be used with PaperCut NG by fol-
lowing the instructions in Section 15.2, “Upsizing to an External RDBMS”.

15.3.1. Enable TCP/IP connections

PaperCut NG uses TCP/IP to connect to the SQL Server database, but SQL Server Ex-
press does not enable TCP support by default. To enable TCP/IP:

1. On the machine with SQL Express installed, open the SQL Server Configuration
Manager.

2. Expand the SQL Server 2005 Network Configuration node on the left.

3. Select the Protocols for SQLEXPRESS node on the left.

4. Right-click the TCP/IP item on the right and select Properties.

5. On the General tab, change Enabled to Yes.

6. On the IP Addresses tab, under the IPAll node clear the TCP Dynamic Ports field.
Also enter the port to listen on in the TCP Port field. For example, 1450. Remember
this port, because it needs to be used in the PaperCut NG connection string.

7. On the OK button to save the changes.

8. Restart the Microsoft SQL Server Express service using either the standard service
control panel or the SQL Express tools.

15.3.2. Enable SQL Server authentication

PaperCut NG requires SQL Server authentication to be enabled on the instance of SQL
Express. To do this:

1. On the machine with SQL Express installed, open the SQL Server Management Stu-
dio Express tool.

2. Right-click the instance of SQL Express to configure, and select Properties.

3. Select the Security section on the left.

4. Change the Server Authentication to SQL Server and Windows Authentication
mode.

5. Restart the Microsoft SQL Server Express service using either the standard service
control panel or the SQL Express tools.
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15.3.3. Create Database User

PaperCut NG requires a user to connect to the database. To create this user:

1. On the machine with SQL Express installed, open the SQL Server Management Stu-
dio Express tool.

2. Right-click the Security->Logins node, and select New Login ....

3. Enter the username (e.g. papercut).

4. Change the Server Authentication to SQL Server and Windows Authentication
mode.

5. Enter the user's password.

6. Disable password expiration.

7. On the OK button to create the user.

8. After creating the PaperCut NG database assign this user db_owner permissions on
the database, so that it can create the required database tables.

9. To initialize the database, follow the instruction in Section 15.2, “Upsizing to an Extern-
al RDBMS”.
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Chapter 16. Microsoft Cluster
Environments
16.1. About Clustering

PaperCut NG is designed to scale to 20,000+ users. To ensure reliability on networks of
this size, network architects may adopt strategies including:

• Load balancing - spreading tasks across multiple servers.

• Clustering - building in redundancy by implementing a failover strategy.

PaperCut NG is a cluster compatible application. It supports clustering at all levels of the
application, including

• Clustering at the print spooler service layer by integrating with Microsoft's clustering
services.

• Failover based clustering at the Application Server layer using Microsoft's clustering
services. (PaperCut NG's Application Server is web and web services based, and
hence can support other failover methods such as heartbeat driven DNS.)

• At the database layer by utilizing cluster aware databases such as Microsoft SQL Serv-
er or Oracle.

Setting up PaperCut NG in a cluster environment is an advanced operation. This chapter
assumes the reader has a high level of expertise in system and cluster configuration. The
cluster environment should be operational before undertaking the PaperCut NG installa-
tion. Readers should also have a good understanding of PaperCut NG's Service Oriented
Architecture - specifically its two main components, the Application Server and the Print
Provider and how they work together (Section 12.4, “Print Monitoring Architecture”).

16.2. Cluster Configuration Modes

In a Microsoft Cluster environment, PaperCut NG can be set up in one of two possible con-
figurations. Mode 1 is the simplest configuration and is suitable for most organizations. It
implements clustering in the “front line” - that is the printer and print monitoring layer. Mode
2 implements clustering on all levels of the application for maximum fault tolerance. Mode
2 is somewhat more demanding to configure and should only be attempted by organiza-
tions with staff experienced with advanced cluster and database management.

16.2.1. Mode 1 - Clustering at the Print Provider layer

The PaperCut NG Print Provider is the component that integrates with the print spooler
service and provides information about the print events to the PaperCut NG Application
Server. At a minimum, in a cluster environment, the Print Provider component needs to be
included and managed within the cluster group. The Application Server component (The
Standard Install option in the installer) is set up on an external server outside the cluster.
Each node in the cluster is configured to report back to the single application server using
XML Web Services over TCP/IP.

16.2.1.1. Step 1 - Application Server Setup
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Install the Application Server component (Standard Install option) on your nominated sys-
tem. This system will be responsible for providing PaperCut NG's web based interface and
storing data. In most cases this system will not host any printers and is dedicated to the roll
of hosting the PaperCut Application Server. It may be one of the nodes in the cluster;
however a separate system outside the cluster is generally recommended. An existing do-
main controller, member server or file server will suffice.

16.2.1.2. Step 2 - Installing the Print Provider components on each node

The Print Provider component needs to be separately installed on each node involved in
the print spooler cluster. This is done by selecting the Secondary Print Server option in
the installer. Follow the secondary server set up notes as detailed in Chapter 12, Configur-
ing Secondary Print Servers and Locally Attached Printers . Take care to define the correct
name or IP address of the nominated application server set up in step 1.

16.2.1.3. Step 3 - Decouple service management from nodes

By default the Print Provider component is installed under the management of the node. To
hand over management to the cluster, the service start-up type needs to be set to manual.
On each node navigate to Control Panel → Administrative Tools → Services, locate the
PaperCut NG Print Provider Service. Stop the service and set the start-up type to
Manual. Repeat for each node in the cluster.

Figure 16.1. Stopping the service and setting to Manual startup

16.2.1.4. Step 4 - Adding the Print Provider service as a resource under the print
spooler's cluster group

1. Open the Cluster Administrator.

2. Right-click on the cluster group hosting the spooler service and select New → Re-
source.
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Figure 16.2. Creating a new cluster resource

3. In the new resource wizard, enter a name of PaperCut Print Provider and se-
lect a resource type of Generic Service. Click Next.

4. Click Next at Possible Owners.

5. Ensure that the Print Spooler Service resource is set as a required depend-
ency, then click Next.

6. On the Generic Service Parameters page, enter a service name of PCPrintPro-
vider and ensure the Use Network Name for computer name option is checked.
Click Next.

Figure 16.3. Cluster service parameters configuration

7. Click Finish at the Registry Replication page.

16.2.1.5. Step 5 - Bring up all cluster resources and test

Perform operations to verify that:

1. Print jobs log as expected.

Microsoft Cluster Environments

160



2. No error message appear in the Print Providers text log located at: C:\Program
Files\PaperCut NG\providers\print\win\print-provider.log on each
node.

16.2.1.6. Special notes regarding multiple virtual servers

On large networks it is common to distribute load by hosting print spooler services under
two or more virtual servers. Virtual servers cannot share the same service on any given
node. For this reason if the virtual servers share nodes, you'll need to manually install the
PaperCut Print Provider service a second time under a different name. This can be
done via the command line as follows:

cd C:\Program Files\PaperCut NG\providers\print\win
pc-client.exe PCPrintProvider2 /install

The argument proceeding /install is the unique name to assign to the service. The re-
commended procedure is to suffix the standard service name with a sequential number.

16.2.2. Mode 2 - Clustering at all application layers

Mode 2 implements failover clustering at all of PaperCut NG's Service Oriented Architec-
ture software layers, including:

• Clustering at the Print monitoring layer

• Clustering at the Application Server layer

• Optional clustering at the database layer

Mode 2 builds upon Mode 1 by introducing failover (Active/Passive) clustering in the Ap-
plication Server layer. This involves having an instance of the application server on each of
the cluster nodes. When one node fails, the other automatically takes over the operation.
Both instances use a share data source in the form of an external database (see
Chapter 15, Deployment on an External RDBMS). Large sites should consider using a
clustered database such as Microsoft SQL Server.

16.2.2.1. Step 1 - Application Server Installation

On one of the cluster's nodes, install the PaperCut NG Application Server component by
selecting the Standard Install option in the installer. Follow the setup wizard and complete
the process of importing all users into the system.

16.2.2.2. Step 2 - Convert the system over to an external database

The system needs to be configured to use an external database as this database will be
shared between both instances of the application server. Convert the system over to the
required external database by following the procedure detailed in Chapter 15, Deployment
on an External RDBMS. The database may be hosted on another system, or inside a
cluster. As per the external database setup notes, reference the database server by IP ad-
dress by entering the appropriate connection string in the server.properties file.

16.2.2.3. Step 3 - Setup of 2nd Node

Repeat steps 1 and 2 on the second cluster node.
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16.2.2.4. Step 4 - Decouple service management from the nodes

By default the PaperCut NG Application Server component is installed under the manage-
ment of the node. It needs to be managed inside the cluster, so the service's start-up type
should be set to manual. On each node navigate to Control Panel → Administrative
Tools → Services locate the PaperCut Application Server. Stop the service and set its
start-up type to Manual. Repeat this on both nodes.

16.2.2.5. Step 5 - Create a new cluster group

The PaperCut NG Application Server should be designated to run inside its own cluster
group. Create a new cluster group containing the two nodes. Add an IP Resource and a
Network Name resource. Give the network name resource an appropriate title such as
PCAppSrv.

16.2.2.6. Step 6 - Adding the PaperCut Application Service as a resource managed un-
der the new cluster group.

1. Open the Cluster Administrator.

2. Right-click on the cluster group hosting the spooler service and select New → Re-
source.

3. In the new resource wizard, enter a name of PaperCut NG Application Ser-
vice and select a resource type of Generic Service. Click Next.

4. Click Next at Possible Owners page.

5. Click Next at Dependency page.

6. On the Generic Service Parameters page, enter a service name of PCAppServer
and ensure the Use Network Name for computer name option is checked. Click
Next.

7. Click Finish at the Registry Replication page.

16.2.2.7. Step 7 - Bring the cluster group online

Right-click on the cluster group and select Bring online. Wait until the application server
has started, then verify that you can access the system by pointing a web browser to :

http://[Virtual Server Name]:9191/admin

Login, and perform some tasks such as basic user management and User/Group Syn-
chronization to verify the system works as expected.

16.2.2.8. Step 8 - Set up the Print Provider layer

Interface the PaperCut NG Print Provider layer with the clustered spooler service by follow-
ing the same setup notes as described for Mode 1. The exception being that the IP ad-
dress of the application server will be the IP address assigned to the Virtual Server as-
signed in step 5.

16.2.2.9. Step 9 - Test

Mode 2 setup is about as complex as it gets! Take some time to verify all is working and
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that PaperCut NG is tracking printing on all printers and all virtual servers.

16.2.3. Clustering Tips

Tip

Take some time to simulate node failure. Monitoring may stop for a few
seconds while the passive server takes over the role. Simulating node failure is
the best way to ensure both sides of the Active/Passive setup is configured
correctly.

It is important that the version of PaperCut NG running on each node is
identical. Ensure that any version updates are applied to all nodes so versions
are kept in sync.

The PaperCut NG installation sets up a read-only share exposing client soft-
ware to network users. If your organization is using the zero-install deployment
method, the files in this share will be accessed each time a user logs onto the
network. Your network may benefit from exposing the contents of this share
via a clustered file share resource.

16.3. Client/Workstation Configuration

In a clustered environment the behaviour of PaperCut NG on the workstations is identical
to that of a non-clustered environment. The one exception however is in terms of configur-
ation - The clients need to be configured to connect to the Virtual Server rather that directly
connecting to a node. (i.e. network connections need to be made via virtual server's desig-
nated IP address). The changes necessary are:

1. The User Client's configuration file config.properties needs to be edited so the
server-name and server-ip directives point to the virtual server. The default in-
stall may use the node's information. The config.properties file is located at
[app-path]/client/config.properties. Networks using Mac clients may also
need to change the file located at PCCli-
ent.app/Contents/Resources/config.properties.

2. Ensure that any URL's pointing to PaperCut NG's web administration and user inter-
faces; http://[server]:9192/admin and http://[server]:9192/user user
the virtual server's name. For example, any links on the organization's intranet site or
links supplied to other system administrators.
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Chapter 17. PaperCut NG on Linux
This section is designed to supplement the Linux Quick Start guide (see Section 1.5,
“Quick Start Guide (for Linux)”). It provides an in-depth explanation of the Linux installation
process, the directory layout and tools.

Information in this chapter is technical in nature. It is expected that readers have prior ex-
perience with:

• The Unix command line environment

• Unix file permissions

• Configuring CUPS and/or Linux print queues

• Or basic Samba configuration

17.1. The Installation Process

The Linux version of PaperCut NG is supplied as a pre-compiled self-installing application.
The installation process is designed to work with all major Linux distributions. Due to the
varied nature of some installations and administrator preferences, often some manual con-
figuration is required. This section describes the installation process in detail as well as
some additional options available to system administrators.

17.1.1. Manual extraction

The Linux version of PaperCut NG is supplied in a self-extracting, self-installing archive.
The archive is simply a tar archive compressed with gzip, and headed with a shell script
to facilitate self-extracting. After extraction is complete, the installation script named in-
stall is executed to begin the install process. Some system administrators may like to in-
spect the contents of the archive, and possibly the installation process itself prior to the ac-
tual install. The self-extracting installer takes a number of command line arguments. The -
e argument will extract the archive into the current working directory ready for inspection.
Further options and documentation is available via the --help option.

Usage: pcng-setup.sh [-e|-i|-l] [-v] [-n] [list ...]
-e Extract the files and then exit without installing.
-i Install after extracting the files (default).
-l List the contents of the archive and exit without extracting.
-v Verbose. Print the names of the files as they are extracted.
list The list of files to extract."

17.1.2. The install process

Even though the majority of the installation process is completed under the identity of the
non-privileged user account called papercut, most administrators would like to know what
the install process does. The main steps are outlined below:

17.1.2.1. Extraction

The first stage in the install process extracts the archive to /tmp or a location as defined
by an environment variable TEMDIR. The command-line programs tar and gunzip are
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used during this phase.

17.1.2.2. Installation

After extraction is complete the installation script is called. The install script, called in-
stall, will present the EULA and request acceptance. The script then determines the in-
stall location. This is the papercut user's home directory. The home directory is determ-
ined by the HOME environment variable, or if not set, the result of a call to getpwnam().

Files are then copied into the papercut user's home directory. Care is taken not to over-
write any existing data or configuration files if this is an install-over-the-top upgrade.

17.1.2.3. Permissions

To ensure the default installation is secure by default, permissions are applied to key files.
The following area of the application are restricted to the papercut user only:

Area Comments

~/server/server.properties Contains server configuration including the
default admin password.

~/server/data This directory contains application data in-
cluding database files. Some of this data
may contain sensitive information.

~/server/bin/linux-i686 This directory contains a setuid-root binary.
Even though the binary is no use to an end-
user or hacker, good security practice stip-
ulates that we should only allow the pa-
percut user access to this directory.

Table 17.1. Secured Application Areas

Permissions can be checked and re-applied at any time post-install by running the scripts:

~/server/bin/linux-i686/setperms
~/providers/print/linux-i686/setperms

17.1.2.4. Firewall

The PaperCut NG Application Server (pc-app process) listens on port 9191. This port is
used for browser based administration access, for client access, and other services. En-
sure that any firewall or local IP filtering software such as iptables is set to allow local
network traffic access to this port.

17.1.2.5. Root Level Tasks

A small part of the install process needs to run as the root account. The tasks conducted
as root include:

• Setting the authpam binary as setuid-root. This binary is used for password verification.

• Installing a CUPS backend. This is done by placing a symlink in the CUPS lib/backend
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directory.

• Setting up SYSV style start scripts if the system uses this boot process. This is done by
placing symlinks in the:

/etc/init.d/
/etc/rc3.d/
/etc/rc5.d/
and so on...

If the administrator decides not to run the root-level tasks during the install process, the
tasks can be run again post-install by executing the shell scripts:

~/server/bin/linux-i686/roottasks
~/providers/print/linux-i686/roottasks

Alternatively the administrator can view the scripts and make the required changes by
hand.

17.1.3. CUPS Integration

CUPS, also known as the Common Unix Print System, is a popular system for managing
printers on Linux servers. CUPS uses a chain-of-commands concept where filters and
backends combine together to form a process steam - a workflow. PaperCut NG hooks in-
to this workflow at the backend level intercepting the job before it's passed onto physical
printer hardware.

The interception is done by wrapping or proxying the real CUPS backend. CUPS calls the
PaperCut NG backend which processes the job. If the job is approved, it passes the docu-
ment onto the real backend. If the job is denied, it is deleted and processes no further. The
PaperCut NG backend is usually set up and installed by default during the standard install-
ation.

Setting up the PaperCut NG CUPS backend proxy is a relatively simple task. All the admin-
istrator needs to do is prefix the existing DeviceURI with the papercut:. For example
the entry:

DeviceURI socket://192.168.1.200:9100

would become:

DeviceURI papercut:socket://192.168.1.200:9100

The printer will register itself with the PaperCut NG system on the first print event.

17.1.3.1. PaperCut NG CUPS Architecture

The PaperCut NG CUPS backend is a native compiled binary. In PaperCut NG document-
ation it is referred to it as a Print Provider - that is a component that provides print event in-
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formation to the Application Server. It's responsible for analyzing the print job and then
communicating this information to the Application Server component. Communication is via
an XML-RPC based Web Services call. This means that the backend does not even need
to be on the same server as the system hosting the Application Server component.

17.1.4. Samba Integration

Samba is used to provide file and print sharing to Windows systems and is a popular solu-
tion. One of the main reasons for its popularity is that it avoids the need for expensive Mi-
crosoft Windows server licenses!

Samba exposes the locally set up Linux/Unix printers as network shared Windows printers.
It does this by wrapping the underlying print system - usually CUPS or LPR/LPD. In the
case of LPR, Samba calls the standard lp command line programs to perform printing. Pa-
perCut NG works by wrapping or proxying the "print command". More information on
how Samba interacts with the underlying print system is available in the Samba document-
ation.

A typical entry in the Samba configuration file smb.conf defining the PaperCut NG print
command wrapper would be:

print command=/home/papercut/providers/print/linux-i686/samba-print-provider
-u "%u" -J "%J" -h "%h" -m "%m" -p "%p" -s "%s"
-a "[standard print command]" &

(IMPORTANT: The above information should appear all on the one line.
Note the use of the & (ampersand) on the end of the line.)

where [standard print command] is the command that would normally be called for
printing.

The %u, %p, etc., are Samba substitution variables. These are replaced with content such
as the username, printer name, etc. and are used by PaperCut NG in the reporting and
logging.

The printer will register itself with the PaperCut NG web interface after the first print is re-
ceived.

17.1.4.1. PaperCut NG Samba Architecture

The PaperCut NG Samba print command wrapper is a native compiled executable. The
PaperCut NG documentation refers to it as a Print Provider. It's responsible for analyzing
the print job and then communicating this information to the Application Server component.
Communication is via an XML-RPC based Web Services call. This means that the com-
mand does not even need to be on the same server as the system hosting the Application
Server component.

17.2. Advanced Configuration & Logs

The majority of PaperCut NG configuration is conducted in the Application Server's web in-
terface. Some additional configuration options are available in the following configuration
files:

Config File Comments

~/server/server.properites Contains server configuration including the
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Config File Comments

default admin password, the server's TCP
port and external database connection
parameters.

~/providers/print/linux-i686/pri
nt-provider.conf

The Print Provider's configuration file used
by both the Samba and CUPS Print Pro-
viders. This file defines items such as the
Application Server's IP address and port,
process timeouts and other.

Table 17.2. Advanced Configuration

Most important application logging is available via the Application Log section of the Ap-
plication Server's web interface. Some additional advanced level logging is maintained in
standard text files located at:

~/server/logs/*
~/providers/print/linux-i686/print-provider.log

Administrators may wish to consult these logs when attempting to diagnose or troubleshoot
problems.

17.3. Backups & System Management

Suggested backup procedures are detailed in Section 10.3, “System Backups”. Common
system management functions are covered in Chapter 10, System Management.

Administrators managing Linux servers should also consider adopting the following man-
agement policies:

• Regularly check for PaperCut NG updates. Updates can be applied with a simple, in-
stall-over-the-top procedure.

• Remember to add the PaperCut NG backend or command when configuring new print-
ers.

• Always check PaperCut NG's functionality after a system updates (i.e. new versions of
CUPS or Samba, or configuration changes).

17.4. User Directory and Authentication

PaperCut NG synchronizes its user directory with the underlying operating system or net-
work. The Linux version of PaperCut NG ships with two user directory implementations.
Due to the nature of Linux, some organizations may have customized user directory imple-
mentations. PaperCut NG can support customization in this area. This section details the
user/group/authentication options available as standard, as well has how one would go
about developing customized implementation.

17.4.1. Standard Unix

The Standard Unix user directory provider uses standard Unix API's to enumerate user

PaperCut NG on Linux

168



and group information. This allows group information to be defined on either the local sys-
tem or via another source as configured via nsswitch.conf. For example, the system
may be configured via nsswitch.conf to obtain user directory information from a central-
ized LDAP server or Novell's eDirectory.

User password authentication is performed via PAM. (Note: For administrators wishing to
customize the PAM authentication method at the application level, PaperCut NG reports it-
self as "papercut".)

17.4.2. Samba/Windows Domain

If the user and group information is provided by a Windows Domain such as an NT Style
Domain or Active Directory, the Samba option is most appropriate. This option would nor-
mally be used on networks where the printers are hosted on a Linux server and exposed to
Windows users via Samba.

At the technical level, the Samba support is implemented as a set of Perl script wrappers
around standard Samba commands such as net and smbclient. Administrators should
ensure these Samba commands are on the papercut user's path.

17.4.3. Custom

Some large networks, particularly those found at established universities, may have cus-
tom user directory and authentication services not directly supported by PaperCut NG. To
support these networks, administrators can use scripting and other technologies to build a
new custom User Directory Information Provider.

PaperCut NG works by handing off user, group and user authentication tasks to a separate
program/process. The external process must accept a set of commands as command-line
arguments and return the answer in a tab delimited prescribed format on standard out.
More information on the format can be found in Section 13.5, “Custom User Directory In-
formation Providers”. The source code for the standard PaperCut NG supplied User Direct-
ory Information Provider are also supplied as part of the installation, and these may prove
to be a good example. The source code is provided in:

~/server/bin/linux-i686/src/
~/server/bin/linux-i686/sambauserdir
~/server/bin/linux-i686/authsamba

Organizations wishing to build a custom User Directory Information Provider are encour-
aged to contact the PaperCut NG development team. They will be more than happy to as-
sist.

17.5. Unix Command-Line Release Station Client

In a modern Linux environment, the most commonly used print system is usually CUPS.
PaperCut NG can be configured to integrate with CUPS to conveniently track printing. On
Legacy Unix systems CUPS is often not an option and printing is performed via the Line
Printer tools such as lp or lpr. LPR/LPD is a non-authenticated printing protocol so the
identity of the user associated with a print job can't be trusted. Instead, the authentication
must be performed at the PaperCut NG application layer. The PaperCut NG client tool with
popup authentication as discussed at Section 19.2, “Scenario Two: The Multi-User Mac
with Popup Authentication” is a good option but not appropriate for a terminal-only environ-
ment. Terminal-only environments can be supported via a release station queue (see
Chapter 9, Print Release Stations for more detail). Jobs held in a release station queue are
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normally accessed and released via a dedicated terminal or a web browser based inter-
face, however for the benefit of terminal-only users, a command-line job release client is
also provided.

This process is best explained using an example:

1. John uses the lp command to print a Postscript document from his Unix terminal ses-
sion. The job arrives in the queue under the username identity "john". (Although the
name can't be trusted.)

2. The administrator has enabled the PaperCut NG release station on this print queue.
The job is placed into a holding state.

3. John must now authenticate, proving his identity and release the job. He chooses to
do this via the command-line release station client.

4. John enters the command release-print-job. This command was set up by the
system administrator.

5. John enters his username and password, confirms the job's name, cost and page
count and releases the job for print. The following is an example of the output seen:

Please enter your username: john
Please enter your password:
Current balance: $8.00
18:04:13 - Name: "Configuring Linux", Pages: 2, Cost: $0.40
Print this job? [yes]
Released 1 job(s).

6. The job prints and John's account is charged.

Enabling the release station on a printer is a global option - it affects all jobs from all users.
In some environments it may not be appropriate to have all jobs controlled via a release
station - for example, jobs originating from Windows systems are already authenticated
and should print directly. An alternate strategy is to have two queues for the same printer.
The first queue does not use the release station option and only allows printing from au-
thenticated workstations/users, while the other queue has the release station option en-
abled.

PaperCut NG managed print queues can be exposed for access via LRP/LPD using vari-
ous methods. The optional Windows system component, "Print Services for Unix" can be
used if the queues are hosted on a Windows system. An LPD interface is available for
CUPS if the queues are hosted on Linux.

Tip

Windows system administrators can control which queues are exposed via
LPR/LPD by setting printer permissions. Queues set up to explicitly deny per-
mission to access from the SYSTEM account will not be accessible via LPR.

17.5.1. Installing the Command-Line Release Station Client

The following installation instructions assume the reader has prior Unix system administra-
tion experience.
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1. Ensure that Java 1.5 or newer is installed on your system. To check, type java -
version at the terminal. If you do not have Java 5 (1.5) or higher, please install it be-
fore continuing. Java is available for all major Unix operating systems.

2. Copy the release station files from your primary server to the system for which you
wish to set up the command line release station client. These can be found in
[app-dir]/release. If your primary server is running Windows, this folder will be
shared by default (accessible via //[server]/release). You may be able to use
tools such as Samba (smbclient) to help copy these files. Ensure all files in the
folder are copied taking care to preserve the existing heirarchy.

The recommended location to install the release station command line client is /
usr/local/papercut/release/.

3. Ensure that the command line release station client has execute permissions for all
users. This can be achieved with the following command when in the release direct-
ory:

chmod 755 ./pc-release-cmd-line.sh

4. For convenience, an alias can be created for the command line release station client.
This is typically done by entering the following line in a global profiles file, or each
user's .profile file:

alias "release-print-job" = \
"/usr/local/papercut/release/pc-release-cmd-line.sh

5. Users will now be able to release their print jobs by typing release-print-job.

It may also be useful to create a 'wrapper' for lp to run the command line release station
client after a user has sent a print job. The following script print-doc provides an ex-
ample:

#!/bin/sh
echo "Printing document using lpr..."
/usr/bin/lpr "$@"
echo "Printing done, calling program to release job..."
sleep 1
cd /usr/local/papercut/release
./pc-release-cmd-line.sh
echo "Done."

For the convenience of users, the command line release station client should be installed
on all systems where printing from the terminal may be performed.

17.6. Removing PaperCut NG from a Linux server

PaperCut NG can be completely removed from a system with the following procedure:

• Remove all files from the papercut user's home directory.

• Remove the papercut user account and home directory.
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• Remove any server start scripts matching:

/etc/init.d/papercut
/etc/rc*.d/*papercut

17.7. Linux FAQ

17.7.1. Troubleshooting & Installation Questions

Q:
How can I run the root installation tasks manually?

A:
If you opt not to run the root level tasks during installation, or if they fail, they can be
manually run later by running the following shell scripts as root:

~/server/bin/linux-i686/roottasks
~/providers/print/linux-i686/roottasks

Q:
I am unable to open a browser to http://[server_name]:9191/admin. What is
wrong?

A:
The first step is to check to see if the PaperCut NG is listening on the port. The com-
mand:

netstat -anp | grep 9191

should list the pc-app as the owner of the process on port 9191. If nothing is listed,
check that the application server has started (e.g. ps -ef | grep pc-app).

If the server is already running, the next step is to ensure no IP filtering is applied to
the port. Some Linux distributions have strict iptables filters enabled by default.
Ensure that port 9191 is accessible from all local network systems.

Q:
I would like to use a custom script to start the server. Is this possible?

A:
The SYSV style start script included should work with all systems using an /
etc/rc*.d style boot process. Some administrators may wish to replace the app-
server with a custom script that better fits in with their Linux distributions style
guide. Administrators should consider storing this script outside the PaperCut NG in-
stall structure so it's not overwritten in any further upgrade.

Q:
Can I run/install PaperCut NG under an account other than "papercut"?

A:
No. At the moment the installation, and other scripts, assume the existence of a user
called papercut. This may however change in the future. E-mail your thoughts to
the development team!
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Q:
Is an RPM or .deb package available?

A:
No. At the moment we're supplying it as a self-extracting and self-installing archive.
This gives us the flexibility to support install-over-the-top for upgrades and maintain
full control over the installation process. The process will also allow PaperCut NG to
run and install on systems not using RPM or apt. We also plan on supporting other
Unix based operating systems in the future such as FreeBSD and Solaris. The cur-
rent installation method should work with all standard Linux distributions.

17.7.2. General Questions

Q:
Is PaperCut NG open source?

A:
PaperCut NG in not "open source" in reference to it being available under the GPL or
another popular open source license. Source code is however provided to customers.
As a company we are transparent in our development approach, work closely with
our users, and support a number of open source projects both financially and with
code submission. PaperCut NG however remains a commercial application with com-
mercial support at the current time.
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Chapter 18. Print Authentication &
Cross-Platform Networks

Modern large multiuser networks, like those typically seen in Higher Education, are made
up of mix of operating systems, authentication methods, print protocols and disparate net-
works. This heterogeneous mix poses problems for system administrators working towards
a unified and centralized print management system. PaperCut NG sports an array of tools
to help administrators meet their unification goals. PaperCut NG's flexibility is however a
double-edged sword and the multitude of options also bring complexity. This section dis-
cusses cross-platform support in detail, and hopes to arm the reader with the knowledge
needed to make the correct architecture decisions. Solutions are presented as "recipes"
with the aim of directing the reader to appropriate procedures and other chapters.

The objectivity of a centralized and unified PaperCut NG system in its simplest form is to
offer all users, irrespective of their operating system or access method, access to the full
array of features in a secured and authenticated way. PaperCut NG offers cross-platform
client software providing end-user features on all major operating systems, however the
need for secured and authenticated access adds an extra, somewhat complex dimension.

18.1. About Authentication and Printing

18.1.1. What is authentication?

Authentication in a printing environment is the act of confirming the digital identity of the
person who issued a print job. Knowledge of the user's identity allows PaperCut NG to of-
fer the user access to functions such as allocating the cost of a job to their account, or of-
fering them access to shared accounts. In a Window domain environment, authentication is
handled at the point of login using a username and password. A web-of-trust is then estab-
lished between servers and services.

18.1.2. Why does authentication pose a problem?

There are three common scenarios that cause authentication issues:

1. Generic, common, or shared user accounts.

2. Systems that auto-login as a set user.

3. Unauthenticated print queues or print protocols.

Generic or shared login accounts are seen in some computer lab and network environ-
ments. In these environments administrators ask users to log into selected systems using
standard user names such as "student" or "user". This practice is particularly common on
the Apple Mac operating system as a single login helps streamline system and application
management. The use of the Window auto-login feature also poses a similar problem - au-
thentication is not enforced at the time of system startup. An extra layer of authentication is
required on these systems to correctly identify the person that performs printing.

Unauthenticated print queues also pose problems in cross platform environments. In an
ideal world all computers would talk the same protocols and happily work together in a
single centrally authenticated environment. We can come close to this goal in a 100% Mi-
crosoft Windows environment, however if we mix in Unix, Linux and Mac, it's a different
story. Although initiatives such as CUPS (Common Unix Printing System) and the Internet
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Printing Protocol (IPP) offer some hope, unification in the area of authenticated printing is
still some way off. Unfortunately technical reasons often prevent networks from using
CUPS authentication or exclusively using the authenticated Microsoft printing protocol.

18.1.3. How does PaperCut NG address authentication?

If technical reasons prevent authentication at the print queue level, PaperCut NG provides
a number of alternate authentication mechanisms.

18.1.3.1. Popup Authentication (IP session based authentication)

This method involves associating the workstation's IP address with a user for a specified
period of time - a session. Any print jobs arriving from this IP address are deemed to be as-
sociated with this user. Authentication is provided by the PaperCut NG client software in
the form of a popup dialog requesting a username and password. Data is transmitted to the
server via an SSL encrypted connection. Popup authentication is not appropriate for server
based operating systems that may support multiple users at the same time - for example,
Unix SSH, Telnet or X terminal servers.

Figure 18.1. PaperCut NG client requesting authentication

More information on popup authentication can be found in Section 5.7, “Popup Authentica-
tion”.

18.1.3.2. Release Station Authentication

Release stations work by placing print jobs in a holding queue. Users must authenticate at
a release station before being given access to release their job. A release station normally
takes the form of a dedicated terminal located next to the printer(s), however the holding
queue may also be accessed via a web browser or even a Unix based command-line cli-
ent. The act of a user releasing a job causes it to be charged to their account. Release sta-
tions do not use session based authentication and hence can be used in a multi-user Unix
terminal environment.

More information on setting up and using release stations is discussed in Chapter 9, Print
Release Stations.

18.2. The Authentication Cookbook - Recipes by example

This section discusses various solutions to the "authentication problem" in recipe style. The
aim is not to provide detailed step by step instructions, but rather guide the user to the rel-
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evant procedures and chapters in other parts of the manual.

18.2.1. Windows systems with generic logins

This scenario arises either when users log into systems using a common username such
as user or student, or if the workstations auto-login as a generic user. See introduction
for details.

18.2.1.1. Preferred Method:

• Ensure all users have an account (username and password) on the server (or domain)
hosting the PaperCut NG software.

• Install client software on all systems. See Chapter 6, User Client for more detail.

• Enable popup authentication by selecting the Unauthenticated option on the corres-
ponding generic user account.

• See Section 5.7, “Popup Authentication” for more detail.

18.2.1.2. Other Methods:

1. Use release station in "Release Any" mode. See Chapter 9, Print Release Stations.

2. Consider implementing domain level logins.

18.2.2. Windows laptops that do not authenticate against a domain

Portable systems may spend most of their time outside the organization's network and
hence setting up domain authentication may not be desirable. The laptops are often owned
by a single individual.

18.2.2.1. Preferred Method:

• Teach the user how add their domain username and password to their Stored user-
names and passwords:

1. Start → Control Panel → User Accounts

2. Select the user's laptop login account

3. Click Manage my network passwords

4. Click Add

5. Enter the name of the server and the user's network domain username and pass-
word

• Teach the user how to add a network printer in the form \\server\printer.

• Optional: Locally install client software and use command-line options or the con-
fig.properties file to force the client to display as their domain user identity. See
Chapter 6, User Client for more detail.

18.2.2.2. Alternate Method:
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• Add a generic "laptop user" user account to the domain.

• Set the unauthenticated option on this user (enable popup authentication).

• Locally install client software and use command-line options or the con-
fig.properties file to force the client to display under the user's domain identity.
See Section A.5, “User Client Options” for details.

• Teach the user how to add a network printer pointing to \\server\printer.

• See the preceding scenario for more detail.

18.2.2.3. Other Methods:

1. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.

2. Consider configuring laptops to use domain authentication.

18.2.3. Windows print server using LDAP or eDirectory authentication

The Microsoft Windows operating system does not play well in non Active Directory do-
main environments such as LDAP or eDirectory. Although it is possible to configure a Win-
dows print server on any network, Windows does not normally provide the ability to use
LDAP as an authentication source. Jobs will either list under a local Windows user identity
or a guest account. PaperCut NG's popup authentication, bound to LDAP, can be used to
work around this limitation.

18.2.3.1. Preferred Method:

• Set up the Windows server and install and share printers.

• Set printer permission to allow printing from a general "guest" type account. This will
usually take the form of the built-in guest account, or a local account with a known user-
name and password (e.g. printuser).

• Configure printers on each workstation. Ensure all workstation users can print and jobs
list in the print queue under the guest account configured in the previous step.

• Install the PaperCut NG software. Select the LDAP server as your user/group source.
PaperCut NG will then use this source for the user list and authentication. See Sec-
tion 10.2.2, “Using LDAP for user synchronization” for more information about LDAP.

• Set the Unauthenticated option on each printer (print queue). This will enable popup
authentication. See Section 5.7, “Popup Authentication” for more information.

• Install client software. See Chapter 6, User Client for more detail.

18.2.3.2. Other Methods:

1. Use release station. See Chapter 9, Print Release Stations.

18.2.4. Mac OS X systems with generic user accounts

Mac OS X workstations in a lab environment are often set up so users log in using a com-
mon, generic, or standard account. For example, "macuser" or "student".
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18.2.4.1. Preferred Method:

• Install client software. See Chapter 6, User Client for more detail.

• Add a domain/network user account that matches the generic login account (i.e. "mac-
user"). This ensures that account will list in PaperCut NG.

• Set the Unauthenticated option on the "macuser" account.

• Add the printer(s) so jobs list under the "macuser" account. If the print queues are hos-
ted on Windows, add the printer using Samba. (e.g. A DeviceURI like
smb://macuser:password@servername/printer). See Chapter 19, Mac Printing
in Detail for an explanation on how to add a printer using this method.

18.2.4.2. Other Methods:

1. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.

2. Consider setting up domain-level authentication.

18.2.5. Mac OS X systems using domain authentication via Open Directory

Mac systems can be configured to authenticate users via a central Mac OS X server run-
ning Open Directory. Each user has their own login account.

18.2.5.1. Preferred Method:

• Set up print queues on the Mac OS X Server.

• Set up PaperCut NG on the server either as a primary server, or as a secondary server
reporting to another primary server (either Mac, Linux or a Windows system). See Sec-
tion 1.6, “Quick Start Guide (for Mac Servers)”.

• Add printers to each Mac workstation. Ensure the local printers point to the shared print
queue set up on the server.

• Optional: Install client software as discussed in Chapter 6, User Client.

18.2.5.2. Other Methods:

1. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.

2. Set up print queues on a Windows system and use popup authentication - see next re-
cipe.

18.2.6. Mac OS X systems using domain authentication via Windows Active
Directory

Mac system can be configured so users log in using their Windows Active Directory do-
main username and passwords. The Mac Windows printer support using Samba/SMB
however requires printers to be added using a single username and password and this is
shared by all users. An extra layer of authentication is required.

18.2.6.1. Preferred Method:
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• Host printers and the PaperCut NG system on the Windows server.

• Ensure the print server is running in Mixed mode or Pre-Windows 2000 Compatibility
Mode. Macs currently have problems with Native Mode networks.

• Add a domain/network user account that matches the generic login account (i.e. "mac-
user"). This ensures that the macuser account will appear in PaperCut NG's user list.

• In PaperCut NG, turn on the Unauthenticated option on the "macuser" account to en-
able popup authentication. Also ensure that the account has zero balance and is re-
stricted.

• Add the printer(s) so jobs list under the "macuser" account. If the print queues are hos-
ted on Windows, add the printer using Samba. (e.g. A DeviceURI like
smb://macuser:password@servername/printer). See Chapter 19, Mac Printing
in Detail for an explanation on how to add a printer using this method.

• Install client software as discussed in Chapter 6, User Client.

18.2.6.2. Other Methods:

1. Use LPR as a connection method. See Section 19.3, “Scenario Three: Multi-user
Macs using LDAP or Active Directory authentication” in detail.

2. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.

3. Host printers on a Mac Server (see the previous recipe).

18.2.7. Mac OS X laptops (or single user systems) printing to Windows print
queues

Mac systems that are owned/used by a single user can benefit from having the printers ad-
ded in such a way in that they automatically authenticate under their identity.

18.2.7.1. Preferred Method:

• Teach users how to add printers using the method described in Section 19.1, “Scenario
One: My Own Mac (Single User)”.

• Locally install client software and use config.properties file option,

user=[username]

to force the client to display their domain user identity. See Section A.5, “User Client
Options” for an explanation of client configuration options.

18.2.7.2. Other Methods:

1. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.
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18.2.8. Linux Workstations in a lab environment with printers hosted on a Win-
dows server

Linux workstations typically use the CUPS print system. CUPS, through the use of Samba,
can print directly to Windows print queues.

18.2.8.1. Preferred Method:

• Ensure the system is configured to deny remote shell access to standard users - that is,
only allow direct screen/console access. This ensures the system's IP address can be
associated with a single user providing a suitable environment for popup authentication.

• Ensure the print server is running in Mixed mode or Pre-Windows 2000 Compatibility
Mode. Some Linux distributions currently have problems with Native Mode networks.

• Add a domain/network user account that matches the generic login account (i.e. "linux-
user"). This ensures the "linuxuser" account will appear PaperCut NG's user list.

• In PaperCut NG, turn on the Unauthenticated option on the "linuxuser" account to en-
able popup authentication. Also ensure that the account has zero balance and is re-
stricted.

• Add the printer(s) so jobs list under the "linuxuser" account. If the print queues are hos-
ted on Windows, add the printer using Samba. (e.g. A DeviceURI like
smb://linuxuser:password@servername/printer). Please refer to the CUPS
or distribution documentation to read more how to add a CUPS printer using an smb
backend.

• Install client software as discussed in Chapter Section 6.1.3, “Deployment on Linux and
Unix”. If users login to the workstations using a username that matches their Active Dir-
ectory password, no additional client configuration is required. If users log in using a
generic or non-matching account, use command-line options or the con-
fig.properties file to force the client to display under the user's domain identity.
See Section A.5, “User Client Options” for more information.

18.2.8.2. Other Methods:

1. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.

2. Host printers on a CUPS server running on Linux.

3. Install "Print Services for Unix on the Windows server" and use a LPR rather than
CUPS (or CUPS with an LPR backend).

18.2.9. Linux Workstations in a lab environment with printers hosted on Linux
CUPS server

Many network administrators running Linux labs may be most comfortable hosting the
printers on a Linux server running CUPS. For convenience, CUPS is set up without au-
thentication.

18.2.9.1. Preferred Method:

• Set up CUPS print queues on a Linux server.
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• Ensure each user has an account on this system (or the domain depending on Paper-
Cut NG's selected user list source)

• Set up PaperCut NG on the server either as a primary server, or as a secondary server
reporting to another primary server (either Mac, Linux or a Windows system). See Sec-
tion 1.5, “Quick Start Guide (for Linux)”.

• Set the Unauthenticated option on each printer (print queue). This will enable popup
authentication. See Section 5.7, “Popup Authentication”.

• Ensure the system is configured to deny remote shell access to standard users - that is,
only allow direct screen/console access. This ensures the system's IP address can be
associated with a single user providing a suitable environment for popup authentication.

• Install client software as discussed in Chapter 6, User Client.

18.2.9.2. Other Methods:

1. Use release station (enabled globally at the print queue level). See Chapter 9, Print
Release Stations.

2. Use CUPS Authentication.

18.2.10. Linux laptops (or single user systems)

Modern Linux laptops will make use of the CUPS print system. This environment is equi-
valent to the Mac laptop recipes described above.

18.2.11. Multiuser Unix terminal servers

Unix or Linux systems allowing remote SSH, Telnet, VNC, or X connections differ from the
other scenarios discussed above. These systems can not use the popup authentication as
it is not possible to uniquely identify a user from the system's IP address. The only secure
option is to use the release station.

18.2.11.1. Preferred Method:

• Setup PaperCut NG on your interfered server - this does not need to be the multiuser
terminal system itself. It could be another Windows or Linux server.

• Ensure PaperCut NG sources its user list from the same source as that used by the
Multiuser terminal server - most likely an LDAP server.

• Enable the release station option on all printers that will be accessed via users of the
multiuser terminal system. Important: Enabling the release station option may be in-
compatible with objectives of other operating systems so it may be appropriate to set up
a separate set of print queues. See Further Recommendations below for more detail.

• Set up a release station. This commonly takes the form of a dedicated terminal located
near the printers, however other options worth considering include using the PaperCut
NG end-user web interface to release jobs, or the release station command-line client.
See Chapter 9, Print Release Stations for details.

• Instruct users on how to use the release station.

18.2.11.2. Other Methods:
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1. No alternate methods.

18.2.12. Further Recommendations

1. Decide on an authentication method and use it consistently throughout the organiza-
tion and network. For example, using popup authentication on some systems and re-
lease station on other may pose confusing. Try to offer a consistent user experience.

2. Where possible, configure workstations to communicate with the server using the
server's native print protocol. For example, use SMB or standard Windows printing
when printing to a Windows server, and Internet Printing Protocol (IPP) when printing
to a CUPS server. Servers are most reliable when talking their own language!

3. Consider the scope of any configuration change. For example, enabling popup au-
thentication or release station on a print queue will affect ALL users of that printer. For
example it may be desirable to ask Linux users to use the release station, however
this may be regarded as an inconvenience for Windows users. In these cases, it may
be advantageous to set up two print queues for each physical printer - the first queue
without release station enabled for Windows users and the other with the release sta-
tion option enabled for Linux users.
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Chapter 19. Mac Printing in Detail
PaperCut NG is a multi-user application designed to integrate with an authenticated net-
work. The Macintosh system has a long history. It's grown up from a single-user desktop
heritage and is now based on a full multi-user Unix kernel. However, some "single-
user-isms" remain, and these can pose challenges for Administrators. One area in particu-
lar is remote printer configuration and credential management.

Figure 19.1. PaperCut Client on Mac OS X

When a network printer, for example a shared Windows printer, is added to a Macintosh
system, the Printer Setup Utility requests printer access credentials in the form of user-
name and password. Any user that prints to this printer uses these supplied credentials.
This means that on the print server, all jobs originating from this Mac system list with sup-
plied username irrespective of who's actually using the Mac.

This chapter discussed some of the multi-user challenges and their solutions.

Macs can be set up to work with PaperCut NG in a number of configurations or scenarios.
There is no "one best" set up. The ideal solutions will vary from network to network and will
depend on factors like:

• Your existing network configuration.

• The mix and makeup of operating systems used on the network.

• The underlying directory technologies (Active Directory, LDAP, etc.) if used.

• Whether Macs are used by a single owner or multiple users.

The following sections outline common set up scenarios and their pros and cons. Your
solution may fit one of these scenarios or may be composed of a combination.

19.1. Scenario One: My Own Mac (Single User)

Many networks, particularly those in a business environment, have a dedicated desktop
system for each user. This allows the desktop system's global settings to be customized for
the user. Common examples include:

• Dedicated computers used in a business

• Staff laptops or desktops used in education

19.1.1. Requirements

• Printers hosted and shared from a Windows or Linux server.
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• Mac systems used by a single user (or small group of known users).

• Each user has a domain account and password.

• The username associated with the account on the Mac matches the domain username
(either the account used to login, or the account set up as the automatic log in account).

• Running Mac OS X 10.3 or higher.

19.1.2. Installation

Check the user account information:

1. Start up the Mac and ensure the system is connected to the network.

2. From the Apple Menu select System Preferences...

3. Select Accounts

4. Click MyAccount.

5. Ensure that the Short name associated with the account matches the user's domain
account username. If not, create a new working account as appropriate.

Set up the printers that the user requires access to:

1. Open the Printer Setup Utility from Applications -> Utilities.

2. Click the Add button to add a new printer.

Figure 19.2. Add a printer

3. Option-Click More Printers.... (Important: Hold the Option key down)

4. Select Advanced from the top drop-down list.
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Figure 19.3. Option-click for advanced printer addition types

5. Select a Device of Windows Printing via Samba.

6. In Device name, enter a friendly and informative printer name.

7. Enter a Device URL in the form:

smb://username:password@server_name/printer_name

Where username and password are the user's domain account login details. serv-
er_name is the name of the server hosting the printer, and printer_name is the
printer's share name.

Figure 19.4. Windows printer via SAMBA

8. Select the Print Model to install and configure drivers.
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9. Click the Add button.

10. Test print and ensure jobs are logged in PaperCut NG under the user's network iden-
tity.

To install the PaperCut NG client software:

1. Open the Finder and select Go -> Connect to Server....

Figure 19.5. Connecting to a Windows server

2. Enter smb://servername/pcclient where servername is the name of the server
hosting PaperCut NG.

Figure 19.6. The PCClient share's connection string

3. Drag the PCClient application across to the local Applications directory.

4. Open System Preferences... from the Apple menu.

5. Select Accounts.

6. Click the Login items tab.

7. Click the + button and select the newly installed PCClient application.
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Figure 19.7. Add PCClient as a Login Item

8. Restart the system and ensure the client starts upon login.

19.2. Scenario Two: The Multi-User Mac with Popup Authentication

Schools and universities often have Macs available for student use in dedicated computer
labs. In these environments the Macs are shared by many users and Scenario One is not
appropriate. Larger Mac networks already using LDAP or Active Directory authentication,
or planning on doing so, may wish to consider Scenario Three explained in the next sec-
tion.

Figure 19.8. Mac popup authentication dialog requesting username and password

Scenario Two uses a popup authentication model. This is discussed in detail in Sec-
tion 5.7, “Popup Authentication” and discussed further below:

The end-user's perspective:

1. The user sees the client tool (PCClient) running.

2. When the user prints a job, the client pops up a window requesting the user to enter a
username and password. See Section 5.7, “Popup Authentication”.

3. The user enters a domain username and password.

4. If the credentials are valid, the job is charged to the user account.
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The explanation:

1. The print event is performed as a generic user - for example "macuser", "student",
etc.

2. In PaperCut NG, the "macuser" account is set up to use popup authentication by en-
abling the option Unauthenticated user. See Section 5.7, “Popup Authentication” for
further details.

3. The popup requests the user to enter a username and password.

4. The password is authenticated and printing is charged against the supplied account.

19.2.1. Requirements

• Printers hosted and shared off a Windows, Mac or Linux server.

• Mac systems set up to login under a generic account name. (e.g. macuser, student,
etc.)

• The domain contains a user account matching the generic account.

19.2.2. Installation

Domain account set up:

1. Log onto the print server or the domain controller.

2. Open Active Directory Users and Computers (or equivalent user management tool)
from Start -> Administrative Tools.

3. Add a new domain user called macuser.

4. Define a password for macuser and set the password to never expire.

Mac account set up:

1. Start up the Mac and ensure the system is connected to the network.

2. From the Apple menu select System Preferences...

3. Select Accounts.

4. Create an account called macuser. Ensure the account's short name is macuser.

5. Set this account as the automatic login account, or alternatively make the password
known to all users.

Set up the printers that the user requires access to:

1. Open the Printer Setup Utility from Applications -> Utilities.

2. Click the Add button to add a new printer.
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Figure 19.9. Add a printer

3. Option-Click More Printers... (Important: Hold the Option key down).

4. Select Advanced from the top drop-down list.

Figure 19.10. Option-click for advanced printer addition types

5. Select a Device of Windows Printing via Samba.

6. In Device name, enter a friendly and informative printer name.

7. Enter a Device URL in the form:

smb://macuser:password@server_name/printer_name

Where password is the password for the macuser domain account, server_name
is the name of the server hosting the printer, and printer_name is the printer's share
name.
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Figure 19.11. Windows printer via SAMBA

8. Select the Print Model to install and configure drivers.

9. Click the Add button.

10. Test print and ensure jobs are listing in the print queue under the macuser identity.

To install the PaperCut NG client software:

1. Start and Log into the Mac computer. Ensure it's connected to the network.

2. Open the Finder.

3. From the Go menu, select Connect to Server...

Figure 19.12. Connecting to a Windows server

4. Enter the pcclient share's connection details like:

smb://server_name/pcclient

Where server_name is the name of the server hosting the PaperCut NG server soft-
ware.
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Figure 19.13. The PCClient share's connection string

5. Enter password information if requested.

6. Drag the PCClient package over to the local hard disk's global Applications folder.
The copy process will commence.

Figure 19.14. Command-click and open the package

7. Command-click on the newly copied PCClient application in the Applications direct-
ory. Select Open Package Contents.

8. Browser to Contents/Resources/.

9. Double-click on the install-login-hook.command script.
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Figure 19.15. Double-click to install the login hook

10. Restart the system and verify the client starts on login.

Configure the popup settings:

1. Log on to PaperCut NG's administration interface as built-in admin user.

2. Select the macuser account from Users.

3. On the macuser's details screen, set the account balance to zero.

4. Ensure the user is set to Restricted.

5. Check the Unauthenticated option and save the changes.

Figure 19.16. Turning on popup authentication at the user level

6. Click the Apply button to save the changes.

Testing:

1. Log on to a Mac. Verify that the PCClient program starts automatically.

2. Print to the newly set up printer. On the server's print queue the job appears under the
user identity of macuser.

3. The popup should display on the Mac. Enter a valid domain username and password.
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Figure 19.17. PaperCut NG client requesting for authentication (Sorry: Windows screen-shot!)

4. The corresponding user should be charged for the job.

19.3. Scenario Three: Multi-user Macs using LDAP or Active Directory
authentication

Larger networks often run the Macs in a domain environment either authenticating with an
Active Directory or an LDAP network. In an authenticated domain environment, the identity
of the user (the user's username) is known and verified at the time of login. With the help of
the TCP/IP Printing Services for Microsoft Windows, and the LPR/LPD support on the Mac,
print jobs can be identified on the server and associated with the user's login name. This
avoids the need for the popup authentication used in Scenario Two.

19.3.1. Requirements

• Macs set up in multi-user mode authenticating off a domain. Either Active Directory or
LDAP.

• Printers hosted on a Windows print server.

• The server needs the TCP Printing Services installed (also known as Print Services for
Unix).

19.3.2. Installation

On the server hosting the printers, setup TCP/IP Printing:

1. Log into the server as a system administrator.

2. Select Control Panel → Add Remove Programs.

3. Click on Add/Remove Windows Components.

4. Select Other Network File and Print Services
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Figure 19.18. Windows Component: Other Network File and Print Service

5. Click Details... and ensure Print Services for Unix is selected.

6. Click Next to complete the installation.

Tip

Some systems running firewall software may block LPD printing. On systems
running firewall software, ensure that incoming connections from the local net-
work are allowed on port 515.

On each Mac, add the required printers:

1. Open the Printer Setup Utility from Applications -> Utilities.

2. Click the Add button to add a new printer.

Figure 19.19. Add a printer

3. Click the IP Printing button at the top toolbar.

4. From the Protocol dropdown, select Line Printer Daemon - LPD.

5. Enter the IP address of the server hosting the printers in the Address field.

6. Enter the printer's share name in the Queue field.
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Figure 19.20. Adding an LPR/LPD printer

7. Define a user friendly name in the Name field and select the printer type.

8. Click the Add button.

9. Repeat for other printers as necessary.

To install the PaperCut NG client software:

1. Open the Finder.

2. From the Go menu, select Connect to Server...

Figure 19.21. Connecting to a Windows server

3. Enter the pcclient share's connection details like:

Mac Printing in Detail

195



smb://server_name/pcclient

Where server_name is the name of the server hosting the PaperCut NG server soft-
ware.

Figure 19.22. The PCClient share's connection string

4. Enter password information if requested.

5. Drag the PCClient package over to the local hard disk's global Applications folder.
The copy process will commence.

6. Control-click on the newly copied PCClient application in the Applications directory.
Select Show Package Contents.

7. Browse to Contents/Resources/.

8. Double-click on the install-login-hook.command script.

Figure 19.23. Double-click to install the login hook

9. Restart the system and verify the client starts on login.

Testing:

1. Restart the system and ensure the client starts on login and lists the user's account
balance.

2. Ensure print jobs correctly account under the user's PaperCut NG account.

19.4. Scenario Four: Mac OS X Server
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If the printers used by Mac clients are hosted/shared from a Mac server system (or Mac
workstation system acting as a server), then the preferred solution is to install PaperCut
NG's Mac server software. The Mac server may either be set up as the primary server or
as a secondary server reporting back to an existing primary server.

The Macintosh server support is new to PaperCut NG. Initial documentation is located at
Section 1.6, “Quick Start Guide (for Mac Servers)”. Further documentation is pending.

19.5. Additional information and tips

The client install process is also covered in Chapter 6, User Client. After the first Mac is set
up and the printing process is tested, the simplified client install notes covered in Sec-
tion 6.1.2, “Deployment on Mac OS X” may be appropriate to provider to end-users or oth-
er system administrators.

The Mac client makes use of Java. Users running Mac OS X 10.4 are advised to install
Java 5.0. Java 5.0 is installed by default on Mac OS X 10.4.5 and higher. Java 5.0 for earli-
er Mac OS versions is available as a dmg from the Apple website. Java 5.0 contains new
features that allow the client to display popups in an always-on-top mode above all other
application windows.

Mac client can accept command line options as explained at Table A.2, “User Client com-
mand-line options”. If the client is started via the login hook, the command-line options can
be defined in the file:

/Applications/PCClient.app/Contents/Resources/login-hook-start

Look for the line starting with client_args and the associated comments above.
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Chapter 20. Running in a Workgroup
Environment

A workgroup environment differs from a network domain model. In the domain model,
users authenticate using a common username/password as defined in a central server.
Users can typically access and use any PC on the network by using their username and
password. In a workgroup, the PC's are loosely coupled and user identity is validated loc-
ally rather than centrally. The PC's are either set up to automatically log in as a general
"user", or user accounts are set up on the PC's as required.

PaperCut NG offers a number of options for running and authenticating users in a work-
group. The two common options are:

20.1. Option 1: Common username and passwords on all systems

This option is suitable for networks running Windows 2000 or Windows XP Pro.

1. Nominate a system to host the printers and the PaperCut NG server software.

2. Set up the printers and share with appropriate names.

3. Windows XP only: Turn off simple file sharing by opening Windows Explorer, select
Tools → Folder Options..., and un-ticking the appropriate option on the View tab.

Figure 20.1. Turn off simple file sharing

4. On the nominated host system, set up user accounts for all users. This can be done
via under User Accounts in the Windows Control Panel.

5. Set permission on the printer so only these users can access the printer shares (i.e.
don't allow guest).
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6. Install the PaperCut NG server software and complete the configuration wizard.

7. Instruct each user should log onto their workstation use an account with the same
username and password as set up for them on the nominated host system. This will
ensure that their jobs list in the queue under their username.

20.2. Option 2: Authenticating via popup

Option 1 may not be appropriate for some environments. For example, Windows XP Home
edition has a limitation that ensures that all users list as "guest" when printing to a remote
printer. This limitation can be worked around with popup authentication.

1. Nominate a system to host the printers and the PaperCut NG server software.

2. Windows XP only: Turn off simple file sharing by opening Windows Explorer, select
Tools → Folder Options..., and un-ticking the appropriate option on the View tab.

Figure 20.2. Turn off simple file sharing

3. On the nominated system, set up user accounts for all users.

4. Install the PaperCut NG server software and complete the configuration wizard.

5. Print from another workstation. The job should list in PaperCut NG under the user
"guest".

6. In the PaperCut NG admin interface, enable the account selection popup and turn
off the Allow user to charge to their personal account option and enable the Allow
user to perform printing as another user.
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Figure 20.3. Enable perform printing as other user

7. Install the client software on each workstation. See Chapter 6, User Client.

8. When the user prints to the shared printer, a popup will now ask users to enter their
username and password.
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Appendix A. Tools (Advanced)
This appendix outlines the command line tools and advanced programming tools that come
with PaperCut NG. Using these tools has been discussed throughout this manual, however
this provides a reference guide to these tools and their use.

Caution

The advanced tools provided with PaperCut NG are very powerful and offer
opportunities for all manner of customizations and enhancements. However, if
used incorrectly, these tools could lead to unexpected results. Many of the ad-
vanced tools are written for software and script developers. It is expected that
readers intending to use advanced tools are comfortable with using the com-
mand-prompt, and developing system management and server monitoring pro-
grams.

A.1. Server Commands (server-command)

The server-command tool provides access to dozens of server operations ranging from
user management, system maintenance, account manipulation and printer control. The
server-command tool is ideal for controlling the PaperCut NG Application Server via the
command-line or automating via scripts.

Some examples of how an Administrator may choose to use the server-command tool:

• Scheduling of online backups and data snapshots.

• Scheduling user and/or group synchronization tasks.

• Automating the addition of new users after the accounts are added to the network.

• Performing account transactions such as adding funds/quota to user accounts.

• Automating user account creation using custom scripts.

• Disabling/Enabling printers.

• Disabling/Enabling printing for users.

• Controlling user restriction levels.

• Managing shared accounts.

The server-command program is a command-line tool. It accepts the commands as argu-
ments and outputs the results of the command on the console (standard-out). For security
reasons only users with read access to the server.properties (normally only the Ad-
ministrators group) have rights to execute the commands.

Typical use on a Windows system:

Add $10.00 to a user named 'testuser':

C:\> cd [app-dir]\server\bin\win
C:\> server-command adjust-user-account-balance "testuser" 10.00 \

"Added $10.00 to your account"
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Note: backslash indicates text should be on the same line.

A.1.1. Available Commands

A full list of commands is available via server-command --help.

Usage: server-command COMMAND [ARGS...]

COMMAND : The server command name.
ARGS : A list of arguments to supply to the command.

COMMANDS:
user-exists <username>

Test to see if a user exists.
<username> - the username to test.

shared-account-exists <account_name>
Test to see if a shared account exists.
<account_name> - the shared account name to test.

get-user-account-balance <username>
Get a user's current account balance.
<username> - the user's username.

get-shared-account-account-balance <account_name>
Get shared account's current account balance.
<account_name> - the shared acount's full name.

adjust-user-account-balance <username> <adjustment> <comment>
Adjust a user's account balance.
<username> - the user's username.
<adjustment> - the adjustment amount as a number. +ve or -ve.
<comment> - a comment to be associated with the transaction.

adjust-user-account-balance-by-group <group> <adjustment> <comment>
Adjust the account balance for all users in a group.
<group> - the group for which all users' accounts are to be adjusted.
<adjustment> - the adjustment amount as a number. +ve or -ve.
<comment> - a comment to be associated with the transaction.

adjust-shared-account-account-balance <account_name> <adjustment> <comment>
Adjust a shared account's account balance.
<account_name> - the shared account's full name.
<adjustment> - the adjustment amount as a number. +ve or -ve.
<comment> - a comment to be associated with the transaction.

set-user-account-balance <username> <balance> <comment>
Set a user's account balance to a set value.
<username> - the user's username.
<balance> - set the account to this value. +ve or -ve.
<comment> - a comment to be associated with the transaction.

set-shared-account-account-balance <account_name> <balance> <comment>
Set a shared account's balance to a set value.
<account_name> - the shared account's full name.
<balance> - set the account to this value. +ve or -ve.
<comment> - a comment to be associated with the transaction.

set-user-restriction <username> <restricted>
Set a user's restriction status.
<username> - the user's username.
<restricted> - TRUE if restricted. FALSE for unrestricted
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set-shared-account-restriction <account_name> <restricted>
Set a shared account's restriction status.
<account_name> - the shared account's full name.
<restricted> - TRUE if restricted. FALSE for unrestricted

get-user-print-stats-page-count <username>
Get a user's current page count value.
<username> - the user's username.

get-user-print-stats-job-count <username>
Get a user's current print job count value.
<username> - the user's username.

reset-user-counts <username> <reset_by>
Reset the page and job counts associated with a user.
<username> - the user's username.
<reset_by> - name of the user/script/process resetting the counts.

reset-printer-counts <server_name> <printer_name> <reset_by>
Reset the page and job counts associated with a printer.
<server_name> - the name of the server hosting the printer.
<printer_name> - the printer's name.
<reset_by> - name of the user/script/process resetting the counts.

disable-printing-for-user <username> <minutes_disabled>
Disable printing for a user for a set period of time.
<username> - the name of the user to disable printing for.
<minutes_disabled> - the time in minutes to disable. -1 indicates
forever.

enable-printing-for-user <username>
Enable printing for a user.
<username> - the name of the user to enable printing for.

disable-printer <server_name> <printer_name> <minutes_disabled>
Disable a printer for a set period of time.
<server_name> - the name of the server hosting the printer.
<printer_name> - the printer's name.
<minutes_disabled> - the time in minutes to disable. -1 indicates
forever.

enable-printer <server_name> <printer_name>
Enable a disabled printer.
<server_name> - the name of the server hosting the printer.
<printer_name> - the printer's name.

perform-online-backup
Start an online backup. The back file is written to
~/server/data/backups. as a dated, zipped XML file. This process
happens in the background.

perform-group-sync
Start the process of synchronizing the system's group membership with
the OS/Network/Domain's group membership. This process happens in the
background.

perform-user-and-group-sync
Start a full user and group synchronization. This is equivalent to
pressing on the "Synchronize Now" button in the admin user interface.
The of the sync process, such as deleting old users, is
determined by the current system settings as defined in the admin
interface. This process happens in background.
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perform-user-and-group-sync-advanced <delete_old_users> <update_details>
An advanced version of the user and group synchronization process
providing control over the sync This process will happen in
the background.
<delete_old_users> - set to TRUE remove old users, else FALSE.
<update_details> - set to TRUE if exist users details (e.g. email,

full-name, etc. ) are to be updated.

add-new-users
Calling this method will start a specialized user and group
synchronization process optimized for tracking down adding any new
users that exist in the OS/Network/Domain user directory and not in
the system. Any existing user accounts will not be modified. A group
synchronization will only be performed if new users are actually added
to the system.

add-new-user <username>
Trigger the process of adding a new user account. Assuming the user
exists in the OS/Network/Domain user directory, the account will be
created with the correct initial settings as defined by the rules
set up in the admin interface under the Groups section.
<username> - the user's system username.

add-new-shared-account <shared_account_name> <pin> <balance> <restricted> <notes>
Add a new shared account with the given initial settings.
<shared_account_name> - the name of the shared account.
<pin> - the pin required to access the shared account (blank for none).
<balance> - the shared account's initial balance. +ve or -ve.
<restricted> - whether or not users should be able to print to the shared

account when its balance reaches 0. (true or false).
<notes> - a description of this shared account.

add-shared-account-access-user <shared_account_name> <username>
Allow the given user access to the given shared account without using a pin.
<shared_account_name> - the name of the shared account to allow access to.
<username> - the name of the user to give access to.

add-shared-account-access-group <shared_account_name> <group_name>
Allow the given group access to the given shared account without using a pin.
<shared_account_name> - the name of the shared account to allow access to.
<group_name> - the name of the group to give access to.

set-shared-account-access-users <shared_account_name> <usernames>
Allow the given users access to the given shared account without using a pin.
<shared_account_name> - the name of the shared account to allow access to.
<usernames> - the comma separated names of the users to give access to.

E.g. "user1,user2,user3"

set-shared-account-access-groups <shared_account_name> <group_names>
Allow the given groups access to the given shared account without using a pin.
<shared_account_name> - the name of the shared account to allow access to.
<group_names> - the comma separated names of the groups to give access to.

E.g. "group1,group2,group3"

remove-shared-account-access-user <shared_account_name> <username>
Revoke the given user'- access to the given shared account.
<shared_account_name> - the name of the shared account to revoke access to.
<username> - the name of the user to revoke access for.

remove-shared-account-access-group <shared_account_name> <group_name>
Revoke the given group's access to the given shared account.
<shared_account_name> - the name of the shared account to revoke access to.
<group_name> - the name of the group to revoke access for.
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delete-existing-user <username>
Delete a user account from the system. Use this method with care.
Calling this will perminently delete the user account from the user
list (print history records remain).
<username> - the user's system username.

delete-existing-shared-account <shared_account_name>
Delete a shared account from the system. Use this method with care. Calling
this will permanently delete it from the shared account list (print history
records will remain).
<shared_account_name> - the name of the shared account to delete.

batch-import-shared-accounts <import_file> <add_new_accounts>
<delete_non_existent_accounts>

Import the shared accounts contained in the given tab-delimited import file.
<import_file> - the import file location relative to the application server.
<add_new_accounts> - (true or false) If true, accounts that exist in the import

file but not in the system will be created. If false, they
will be ignored.

<delete_non_existent_accounts> - (true or false) If true, accounts that do not
exist in the import file but exist in the system will be
deleted. If false, they will be ignored.

Tip

server-command is ideal for scripting via batch files or shell scripts. Adminis-
trators wishing to control PaperCut NG using a programming language such as
C#, Java, Visual Basic, Perl or Python should consider the XML Web Services
API's. All commands available via the server-command tool are also access-
ible via calls to the Web Services layer.

More information on the XML Web Services API is available in Section A.3,
“The XML Web Services API”.

A.2. Database Tool (db-tools)

This tool provides a variety of functionality manipulating the PaperCut NG database and
data. The syntax of the command is:

db-tools command [options]

The valid commands are:

• export-db - export/backup the database data

• import-db - import/restore the database data

• init-db - create tables and initial data in a new database

A.2.1. export-db Command
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The export-db command exports the data from the database. The application server must
be stopped before performing the export. The syntax and options for the export-db com-
mand are:

usage: db-tools export-db [options]
-d,--dir <dir> Exports the database to the given directory.
-f,--file <file> Exports the database to the given file.
-h,--help Displays this help.

If no options are specified then the database export file is created in the
[appdir]\server\data\backups directory and the file is named export-
[date-time].zip.

The --dir option is used to override the default backup directory. The filename will still be
named export-[date-time].zip.

The --file option is used to specify the full path and filename where the backup is
saved.

Caution

If the directory or filename parameters contains space, then the argument
needs to be quoted.

A.2.2. import-db Command

The import-db command imports the data (from a previous export) into the database.
The application server must be stopped to perform the import. The syntax and options for
the import-db command are:

usage: db-tools import-db [options] import-file
-f,--force Deletes any existing data before loading the data.
-h,--help Displays this help.

The --force option is required when the data is loaded into a database that already con-
tains data. In this situation, the force option indicates that existing data will be deleted first.

Caution

If the import-file contains spaces this argument will need to be quoted.

A.2.3. init-db Command

The init-db command initializes a database, creating the required tables and initial data.
The application server must be stopped before you initialize the database. The syntax and
options for the init-db command are:
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usage: db-tools init-db [options]
-f,--force Re-initializes the database even if it already exists.
-h,--help Displays this help.

The --force option is required to initialize a database that already contains the tables
and data. In this case the force option will drop the existing tables before recreating the
tables.

A.3. The XML Web Services API

Over the past few years, Web Services has been one of the IT industry's "buzz words" -
and rightly so! Web Services provide a standardized way to transfer data and call functions
across different operating system, programming languages, and networks. Web Services
data is transmitted over standard HTTP and uses standardized XML mark-up.

There are two main Web Services implementations used for Remote Procedure Call
(RPC):

• SOAP/WSDL

• XML-RPC

PaperCut NG uses XML-RPC. XML-RPC is a lightweight web services implementation and
has good support for all major programming and scripting languages such as C#, Java,
Visual Basic, Perl and Python. The list of XML-RPC methods exposed by PaperCut NG at
the URL http://[server_name]:9191/rpc/api/xmlrpc are summarized below:

Method Description

api.addNewUser Triggers the process of adding a new user
account defined by a given username. As-
suming the user exists in the OS/Net-
work/Domain user directory, the account
will be created with the correct initial set-
tings as defined by the rules set up in the
admin interface under the Group's section.
Calling this method is equivalent to trigger-
ing the "new user" event when a new user
performs printing for the first time.

api.isUserExists Test to see if a user exists in the system/
database.

api.addNewUsers Calling this method will start a specialized
user and group synchronization process
optimized for tracking down and adding any
new users that exist in the OS/Net-
work/Domain user directory and not in the
system. Any existing user accounts will not
be modified. A group synchronization will
only be performed if new users are actually
added to the system.
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Method Description

api.performGroupSync Start the process of synchronizing the sys-
tem's group membership with the OS/
Network/Domain's group membership. The
call to this method will start the synchroniz-
ation process. The operation will com-
mence and complete in the background.

api.performUserAndGroupSync Start a full user and group synchronization.
This is equivalent to pressing on the "Syn-
chronize Now" button in the admin user in-
terface. The behavior of the sync process,
such as deleting old users, is determined
by the current system settings as defined in
the admin interface. A call to this method
will commence the sync process and the
operation will complete in the background.

api.performUserAndGroupSyncAdvan
ced

An advanced version of the user and group
synchronization process providing control
over the sync behavior. A call to this meth-
od will commence the sync process and the
operation will complete in the background.

api.adjustUserAccountBalance Adjust a user's account balance by an ad-
justment amount. An adjustment may be
positive (add to the user's account) or neg-
ative (subtract from the account).

api.adjustUserAccountBalanceByGr
oup

Adjust the account balance for all users in a
group by an adjustment amount. An adjust-
ment may be positive (add to the user's ac-
count) or negative (subtract from the ac-
count).

api.setUserAccountBalance Set the balance on a user's account to a
set value. This is conducted as a transac-
tion.

api.deleteExistingUser Delete/remove an existing user from the
user list. Use this method with care. Calling
this will perminently delete the user account
from the user list (print and transaction his-
tory records remain).

api.getUserAccountBalance Get the user's current account balance.

api.getUserPrintStatsJobCount Get the user's current printing statistics job
count as an integer.

api.getUserPrintStatsPageCount Get the user's current printing statistics
page count as an integer.
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Method Description

api.disablePrintingForUser Disable printing for a user for selected peri-
od of time.

api.enablePrintingForUser Enable printing for a user with printing dis-
abled.

api.setUserRestriction Set a user's restriction status. (Restricted
or Unrestricted)

api.addNewSharedAccount Create a new shared account with the giv-
en name.

api.isSharedAccountExists Test to see if a shared account exists in the
system/database.

api.deleteExistingSharedAccount Delete a shared account from the system.
Use this method with care. Deleting a
shared account will permanently delete it
from the shared account list (print history
records will remain).

api.getSharedAccountAccountBalan
ce

The current account balance associated
with a shared account.

api.adjustSharedAccountAccountBa
lance

Adjust a shared account's account balance
by an adjustment amount. An adjustment
may be positive (add to the account) or
negative (subtract from the account).

api.setSharedAccountAccountBalan
ce

Set the balance on a shared account to a
set value. This is conducted as a transac-
tion.

api.setSharedAccountRestriction Set the restriction status on a shared ac-
count.

api.addSharedAccountAccessUser Allow the given user access to the given
shared account without using a pin.

api.removeSharedAccountAccessUse
r

Revoke the given user's access to the giv-
en shared account.

api.setSharedAccountAccessUsers Set access to the given shared account to
the given users (a comma separated list).
Any users who currently have access but
do not exist in the list will have their access
revoked.

api.addSharedAccountAccessGroup Allow the given group access to the given
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Method Description

shared account without using a pin.

api.removeSharedAccountAccessGro
up

Revoke the given group's access to the giv-
en shared account.

api.setSharedAccountAccessGroups Set access to the given shared account to
the given groups (a comma separated list).
Any groups who currently have access but
do not exist in the list will have their access
revoked.

api.batchImportSharedAccounts Import the shared accounts contained in
the given tab separated import file (located
on the server).

api.disablePrinter Disable a printer for select period of time.

api.enablePrinter Enable a disabled printer.

api.resetPrinterCounts Reset the counts (pages and job counts)
associated with a printer.

api.resetUserCounts Reset the counts (pages and job counts)
associated with a user account.

api.performOnlineBackup Instigate an online backup. This process is
equivalent to pressing the manual backup
button in the web based admin interface.
The data is exported into the server/
data/backups directory as a timestamped,
zipped XML file.

Table A.1. XML Web Services Methods

A.3.1. Web Services Example Code

The best way to demonstrate how to use the Web Services interface is using example
code. PaperCut NG ships with example code located in:

[app_path]/server/examples/webservices/

The C# and Java examples also include a full documented Proxy class - a proxy is a com-
mon program design pattern. The Proxy wraps and exposes the Web Services methods as
standard methods. The setup and use of the underlying XML-RPC library is all handled in
the proxy class meaning you can just focus on calling the methods.

Please see the README.txt files in the examples directories for more information. The
Java example includes full JavaDoc style documentation under examples/webser-
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vices/java/docs/api.

Developers using other languages such as Perl or Python will need to use an XML-RPC
library to call the methods directly. All methods are exposed via the URL ht-
tp://[server_name]:9191/rpc/api/xmlrpc.

Tip

All the XML Web Services commands are also accessible via the server-
command program. An alternative to using a full programming environment to
automate PaperCut NG via Web Services is to use the server-command pro-
gram to call the commands via a script such as a batch file or shell script. This
may be a simpler solution for common automation tasks such as scheduling a
User/Group synchronization each night.

More information on the server-command program can be found in Sec-
tion A.1, “Server Commands (server-command)”.

A.3.2. Security

The Web Services API's provide full access to the system's internals and hence need to be
secured. PaperCut NG secures access using two security layers:

1. IP address level security

2. Authentication tokens - required for each method call

The IP address level security is used to control which systems, denoted by IP address, are
allowed to connect to the server and call the API's. By default this is restricted to local-
host (127.0.0.1) only. If the program/script making use of the API's resides on another
system, then this system's IP address will need to be added to the list of approved ad-
dresses under Options → General → Allowed XML Web Services callers.

The first argument to all method calls is an authentication token (authToken). In the cur-
rent release the authentication token is the built-in admin user's password (This is pass-
word defined in the server.properties file). The password must be supplied to all
method calls.

A.4. SSL/HTTPS Key Generation

Configuring SSL can be a confusing experience of encryption keys, certificates, protocols
and formats. During the install process, PaperCut NG generates an unsigned key/
certificate issued for the host's name. This is used by default when the system is accessed
via HTTPS on port 9192. On some networks it may be desirable access the server via a
fully qualified domain name rather than just the server's local name. Most browsers will al-
low access to an HTTPS server under a different name however the user will be notified of
a domain mismatch error. The tool create-ssl-keystore can be used to re-issue the
key/certificate (stored in a keystore file) under a different hostname eliminating the mis-
match error. An example of the command's use:

cd [app_path]/server/bin/win
create-ssl-keystore -f "myserver.fullname.com"
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More information is available via the --help command line option.

Usage: create-ssl-keystore [-f] [-k FILE] [SYSTEM_NAME]

-f Force. Overwrite any existing keystore file.

-k FILE: Defile a keystore file location. If not set the keystore
is created in the default location
(server/data/default-ssl-keystore).

SYSTEM_NAME: The name of the computer/server used to generate keystore.
If not defined, the current computer name is used.

A.4.1. Using a custom SSL Key

Large organizations may wish to use their own SSL key signed and trusted certificate au-
thority (CA). Such trusted CAs include: AddTrust, Entrust, GeoTrust, RSA Data Security,
Thawte, VISA, ValiCert, Verisign, beTRUSTed, among others.

Caution

Configuring SSL and generating signed keystores is complex! The following
documentation assumes that the reader has a good understanding of the SSL/
HTTPS process and has configured SSL on other web based application serv-
ers such as Apache, IIS, or secured mail servers.

A good summary of the process of generating a PaperCut NG compatible certificate key-
store is explained in detail on the Jetty HTTP Server website at: ht-
tp://jetty.mortbay.org/jetty5/faq?s=400-Security&t=ssl

To configure the PaperCut NG Application Server to use the new key/certificate:

1. Copy your signed keystore onto the server running the PaperCut NG Application Serv-
er. The suggested location is in the directory [app_path]/server/custom/.

2. Open the file [app_path]/server/server.properties with a text editor (e.g.
Notepad).

3. Locate the section titled SSL/HTTP Configuration

4. Remove the # (hash) comment maker from all server.ssl lines.

5. Define the location of your keystore and the keystore and key password. The file
should look something like this:

server.ssl.keystore=custom/server/my-ssl-keystore
server.ssl.keystore-password=mypassword
server.ssl.key-password=mypassword

6. Restart the PaperCut NG Application Server and verify all is working. If the server fails
to start, error messages will be recorded in logs located in the server's logs directory.

A.5. User Client Options
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The user client is used to display user balances, system notifications and request informa-
tion from the users. This is discussed in more detail in Chapter 6, User Client. The user cli-
ent implements a number of command-line options that change it's behavior.

Option Description

--silent The silent option tells the client not to report
errors if it has problems connecting to the
server. If the server is unavailable at time of
startup (e.g. the client is not connected to
the network), or if the user does not cur-
rently exist in the database, the client will
simply sleep waiting for the condition to
change.

--minimized The minimized option tells the client to start
minimized. On windows the client will be
minimized to the task tray.

This option is recommended if the user's
balance is not important to the user. For ex-
ample, if a user is only allowed to assign
print jobs to a shared account, then their
personal balance is of little importance, so
the user client should be minimized.

--user <username> The user option allows the client to be run
using a different username.

This can be useful if the user is logged into
a machine as a different user than he or
she is authenticated to the server/printers.
For example, if a user is using a laptop that
is not a part of the domain.

Table A.2. User Client command-line options

The command-line arguments listed above are usually used in the area/method used to
start the client - a login script, shortcut, or the relevant registry key in
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run\.

The command-line arguments may also be set in the config.properties file. This is
particularly helpful on Apple Mac systems where command-line arguments are difficult to
implement. The config.properties file is located in the same directory as the client ex-
ecutable on Linux and Windows. On the Mac it can be found at:

[app-dir]/PCClient.app/Contents/Resources/config.properties

Additionally settings may be changed at the user-level by placing a file in the user's Library
Preferences folder located at:

~/Library/Preferences/PCClient/config.properties
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The file should contain the options in a properties file form like:

user=mary
minimized=Y

The line starting with user= allows the client to be run using a different username. The
minimized= causes the client window to start minimized if set to Y.

A.6. Stopping and Starting the Application Server

Most of the time it will not be necessary to stop or start the server; however there are some
circumstances where this is required:

• Performing an offline backup

• Upsizing the database to an external database

• Upgrading the application

The procedure for stopping the server depends on the platform the server is run on.

A.6.1. Stopping/Starting the server on Windows

The PaperCut NG application server runs as a Windows service when installed on Win-
dows, and it can be stopped and started using the Services control panel applet. To stop/
start/restart the application server:

1. Open the services control panel. (Start → Control Panel → Administrative Tools →
Services)

2. Find the service name PaperCut Application Server.

3. Right-click on the service.

4. Select the option you want to perform (e.g. Stop/Start/Restart).

Important

When you start the application server, wait approximately 15-20 seconds for
the service to start before accessing the admin interface. This gives the sys-
tem time to initialize.

An alternative to using the services applet is to run the batch files located in the directory
[appdir]\server\bin\win. Using the batch files might be more convenient when the
process needs to be automated (like scripting a database backup). The batch files to stop/
start the server are called:

• start-server.bat - starts the service

• stop-server.bat - stops the service
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Appendix B. Troubleshooting &
Technical FAQ's

There are a number of problems you may run into in the course of installing and using Pa-
perCut NG. Many will be resolved once you get a better idea of how PaperCut NG works,
while others may require you to dig deeper into the application's workings.

The following list has been compiled over the course of years of PaperCut NG usage. If
you can't find a reference to the problem you're having here, look at the most up-to-date
version of the FAQ and Knowledge Base [http://www.papercut.biz/kb] at the PaperCut NG
website [http://www.papercut.biz/].

In addition to this section, some platform specific FAQ's are available at Section 17.7,
“Linux FAQ”.

B.1. Troubleshooting & Installation Questions

Q:
I am running the PaperCut NG server and/or clients on Windows XP Professional
Edition, and users are unable to authenticate. What's causing this?

A:
If your server or client machines are running Windows XP Professional you must en-
sure that each has 'simple file sharing' disabled. Otherwise, they will not be able to
authenticate to the PaperCut NG server (as they try to authenticate as the Guest
user). To disable 'simple file sharing', for each of your machines running Windows XP
Professional:

1. Open Windows Explorer or Network Connections.

2. Open the folder options screen: Tools → Folder Options...

3. Right-click a printer and select Properties.

4. Select the View tab.

5. Scroll down the list and ensure that Use simple file sharing (Recommended)
is unchecked.

6. Press the OK button.

Q:
I am running PaperCut NG clients on Windows XP Home Edition, and users are un-
able to authenticate. What's causing this?

A:
Windows XP Home uses 'simple file sharing', forcing client machines to try to authen-
ticate as the Guest user. For this reason, we do not recommend the use of Windows
XP Home in multi-user environments.

Users may still authenticate with PaperCut NG on Windows XP Home by entering
their details into the User Client utility. This is similar to how user authentication is
performed with Mac clients. For more information see Section 19.2, “Scenario Two:
The Multi-User Mac with Popup Authentication”.

Q:
PaperCut NG is not detecting jobs printed from a network clients. How can I fix this?
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A:
There are two main causes of this problem:

• Users are not correctly logging on to your network domain or computer. If the do-
main server does NOT authorize users, PaperCut NG has no way of knowing who
submitted the print job. With system policies, login onto the domain can be made
mandatory, eliminating this problem. Alternatively printer permissions can be set
on the print server to ensure only valid users may print to the printers.

• Alternatively the client computer may be configured to print directly to the network
interface printer. Ensure all network clients are configured as outlined in the Pa-
perCut NG installation guide. All print jobs must pass through the print server run-
ning PaperCut NG.

Q:
PaperCut NG is not counting/detecting pages correctly. What's causing this?

A:
PaperCut NG currently supports about 90% of printers on the market. If a printer's
language is not recognized, PaperCut NG will not detect any pages and record the
print job as a zero page count. This is usually accompanied with an error message in
the Application Event Log. We recommend you try the following problem resolution
actions in this order:

1. Many printers come with a variety of driver options. Install the Postscript drivers
if one is available for the printer. Do this on both the Print Server and all network
clients.

2. Try the drivers included with the Windows CD. PaperCut NG supports the major-
ity of drivers distributed with recent Windows releases.

3. Try turning Enable advanced printing features as follows:

a. On the print server, Start->Settings->Printers.

b. Right-click on the printer and select Properties...

c. Select the Advanced Tab.

d. Turn off (disable) the Enable advanced printing features.
More information is available in our Knowledge Base
[http://www.papercut.biz/kb/Main/EnableAdvancedPrintingFeatures].

4. If you're still having problems, email PaperCut Software support. The develop-
ment team may be able to recommend a suitable set up or even supply a recent
update supporting your hardware.

5. Specific information on printer compatibility is discussed in the PaperCut Know-
ledge Base [http://www.papercut.biz/kb]. Information here might be of assist-
ance.

Q:
How do I ignore (not monitor) a printer?

A:
The Print Provider may be configured via its configuration to ignore a printer. For
more information see Section 5.6, “Ignoring/Deleting a printer”.

Q:
The system is not displaying the correct currency sign.

A:
PaperCut NG will format the currency based off the operating system's default re-
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gional settings. If the default regional settings are incorrect, the format can be
changed by defining your location under Options → General → Display Settings →
Location.

Q:
I've setup a secondary print server. The printers on this server are not listed and not
being monitored. What's wrong?

A:
There are a number of possible explanations. The first step is to open the Print Pro-
vider's log file on the secondary server. This file will often contain error messages in-
dicating the cause or type of error. On a Windows system the log file is located at:
[app-dir]\providers\print\win\print-provider.log The file can be
opened from any text editor such as Notepad.

Some common issues are:

1. Verify that the secondary server's name is correctly defined in the print-
provider.conf file. Open a command prompt on the secondary server and
use the ping command to verify that the server can be contacted under this
name. A server restart (or a manual restart of the PaperCut Print Provider ser-
vice) is required for any changes to the file to take effect.

2. Ensure that firewall software on the primary server is not preventing the second-
ary server from connecting on port 9191. Firewalls should be configured to allow
all local network traffic on this particular port.

A quick way to see if the secondary server can connect to the primary server is
to use the command-line telnet program. Simply type: telnet servername
9191 at a command prompt.

• If you receive an error like Could not open connection to host, then
there is probably a network/firewall issue not letting the connection through.

• If the screen goes blank then the connection was established successfully.
Press Ctrl+] then type quit to close the telnet session.

3. Check that the Print Provider process/service is in fact installed and running. On
a Windows system this is located under: Start → Control Panel → Administrat-
ive Tools → Services

Q:
The client software is not displaying the user's account balance and is displaying a
network error. How do I fix this?

A:
The client software needs to contact the application server. For the technical readers,
the client makes an XML web services request to the server on port 9191. Most prob-
lems relate to either firewalls blocking access or the application server's name is not
correctly defined. Ensure that:

1. Any firewalling software on the server allows local network access to port 9191.

2. The client.properties file (a text file) lists the correct server name or IP ad-
dress of the server. If you've used the zero-install deployment option, this file is
located on the server in the directory:
[app-dir]/client/client.properties
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B.1. General Questions

Q:
How do I change the built-in admin user's password?

A:
The admin user's password is set up on initial install during the configuration wizard.
This password can be changed post-install by editing the text file located at
[app_dir]/server/server.properties. The password is defined in the prop-
erty admin.password.

Q:
I run a small peer-to-peer network and my users don't log onto the workstations. Can
I still use PaperCut NG?

A:
PaperCut NG is primarily designed for networks managed under a domain and/or au-
thenticated environments. Peer-to-peer networks or Workgroups are however sup-
ported. The first option should be to consider requiring users to log onto the worksta-
tions using their username and password. If this is not possible, an alternate option is
to set up the user accounts on system hosting the printers (system running the Pa-
perCut NG server software) and configuring the account selection popup with the
Charge to other users option selected. Users can then enter their username and
password in the popup that displays each time they print.

Q:
I would like to start the user inquiry tool (client software) with the window minimized.
Is this possible?

A:
Yes. The client software can be started minimized by executing the program with a
command-line switch -minimized. See Section A.5, “User Client Options”.

Q:
How do I stop users from closing/shutting down the client software?

A:
If the user running the client software is configured to either:

• select shared accounts

• confirm the print job via a popup

the client software must be running at all times. If the user is configured in either of
these modes, the client software's exit option is disabled. Note: The client software
will need to be restarted to pick up this option after the user's options have been
changed.

Q:
Why does PaperCut NG cache the group membership?

A:
PaperCut NG caches group membership by replicating the user/group relationship
structure internally in the system. Typically network group membership is relatively
static, and is usually set up when a user account is initially created. PaperCut NG
tries to be a good network application by avoiding common no-no's such as flooding
domain controllers with group lookup requests. This is achieved by caching. Opera-
tions such as Bulk user operations, quota allocations, group reports and group fil-
tering all need to do group membership lookups. Caching speeds up these opera-
tions and prevents excessive callouts to the domain servers.

The downside to caching is that group membership changes are not immediately re-
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flected inside PaperCut NG. To force PaperCut NG to detect the change perform a
User/Group synchronization under the Options section. The system will also automat-
ically refresh group membership overnight during low network activity.

Q:
I have noticed a lot of extra options available under the Config Editor (Advanced)
area. Can I change these?

A:
The config area contains all of the PaperCut NG system wide settings. Some of these
can be changed via the normal options interface while others are designed for intern-
al developer use and tuning and are only accessible via the config editor. Any
changes made in the config editor should be done with care as an invalid entry may
require you to reinstall the system!

Q:
I'd like to write some custom extensions. Do you support this?

A:
One of the business objectives of PaperCut NG was openness. The development
team actually encourages this and can assist with detailed API documentation and
source code. If you would like feedback on your ideas, please email our support
team. They would be more than happy offer advice.

Q:
What external databases are supported?

A:
Running PaperCut NG on top of an external database is an advanced option. This is
discussed in details in system management section.

Q:
What is the internal database format?

A:
PaperCut NG's internal database is Apache Derby - an open source database written
by IBM and based on IBM's DB2 Cloudscape database system. The internal data-
base has proven to scale very well and is suitable for networks of all sizes.

Q:
What language is PaperCut NG developed in?

A:
PaperCut NG is developed under a number of languages and development environ-
ments. The printer monitoring component and other native operating system inter-
faces such as user authentication are written in C/C++. The application server and
web services are written in server-side Java.

Q:
I'd like to investigate server cluster support?

A:
The PaperCut NG is designed as a cluster compatible application and supports clus-
tering at all layers of the application. For more information on configuring PaperCut
NG in a Microsoft Cluster environment, please see Chapter 16, Microsoft Cluster En-
vironments. If you'd like to investigate clustering options on other platforms (Linux)
please contact our support team.
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Appendix C. Advanced LDAP
Configuration

PaperCut NG supports the following LDAP server types out-of-the-box:

• Novell eDirectory

• Microsoft Active Directory

• Unix/NIS/Posix

and basic configuration options for these platforms/environments are discussed at Sec-
tion 10.2.2, “Using LDAP for user synchronization”.

However, other server/schema types can be supported by defining the fields to query and
the LDAP searches to perform. These options are configured by adjusting config entries in
the Config Editor, which can be opened from the Options tab. The following config items
are available:

Config name Description

ldap.schema.user-name-field The LDAP field that contains the user's
username.

ldap.schema.user-full-name-field The LDAP field that contains the user's full
name.

ldap.schema.user-email-field The LDAP field that contains the user's
email address.

ldap.schema.user-name-search The LDAP search to retrieve the user. The
{0} in the search is replaces with * when
listing all users, and [username] when
searching for a specific user. If no search is
defined, the default is
([userNameField]={0}).

ldap.schema.group-name-field The LDAP field that contains the group's
name.

ldap.schema.group-member-field The LDAP field that contains the group
members.

ldap.schema.group-search The LDAP search to retrieve the group.
The {0} in the search is replaced with * for
all group searches. If no search is defined,
the default is
([groupMemberField]={0}), which
means get all entries with at least one
member.

ldap.schema.posix-groups If Y, then the group member field contains
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Config name Description

the user's username. If N, then the group
member field contains the user's DN.

Table C.1. LDAP Config entries

C.1. LDAP Server Default Configuration

When a particular LDAP server type is selected (e.g. Novell eDirectory), PaperCut NG
uses the following defaults to query the LDAP server. These defaults can be used as a
starting point for customizing the LDAP searches or for supporting other server types.

C.1.1. Unix / NIS Defaults

If the LDAP server is configured to support Unix based authentication then this schema
type can be used. The following defaults are used.

Config name Default value

ldap.schema.user-name-field uid

ldap.schema.user-full-name-field cn

ldap.schema.user-email-field mail

ldap.schema.user-name-search (uid={0})

ldap.schema.group-name-field cn

ldap.schema.group-member-field memberUid

ldap.schema.group-search (memberUid={0})

ldap.schema.posix-groups Y

Table C.2. Unix / NIS LDAP default settings

C.1.2. Novell eDirectory Defaults

If the LDAP server is a Novell eDirectory then the following defaults are used.

Config name Default value

ldap.schema.user-name-field cn

ldap.schema.user-full-name-field fullName

ldap.schema.user-email-field mail

ldap.schema.user-name-search (&(cn={0})(objectClass=person))
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Config name Default value

ldap.schema.group-name-field cn

ldap.schema.group-member-field member

ldap.schema.group-search (&(member={0})(objectClass=group
OfNames))

ldap.schema.posix-groups N

Table C.3. Novell eDirectory LDAP default settings

C.1.3. Microsoft Active Directory Defaults

If the LDAP server is a Microsoft Active Directory then the following defaults are used.

Config name Default value

ldap.schema.user-name-field sAMAccountName

ldap.schema.user-full-name-field displayName

ldap.schema.user-email-field mail

ldap.schema.user-name-search (&(sAMAccountName={0})(objectCat
egory=person)(objectClass=user)(
sAMAccountType=805306368))

ldap.schema.group-name-field sAMAccountName

ldap.schema.group-member-field member

ldap.schema.group-search (&(member={0})(objectCategory=gr
oup))

ldap.schema.posix-groups N

Table C.4. Active Directory LDAP default settings
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Appendix D. Capacity Planning
This section discusses capacity planning considerations to allow administrators to plan fu-
ture infrastructure requirements and make decisions about how to deploy the application.

PaperCut NG is designed to be self-maintaining, however it is important that the adminis-
trator understands the disk-space requirements and how this changes overtime.

D.1. Database Sizing and Growth

The most important part of capacity planning for PaperCut NG is the size and growth of the
underlying database. All other aspects of the system manages itself, but care must be
taken to ensure there is enough disk space to hold the growing database.

The size and growth of the database depends on the database being used. Each database
uses a different format to store their data, therefore the growth characteristics of databases
will differ. This section outlines the database growth characteristics of:

• The internal database (Apache Derby)

• Microsoft SQL Server

For more information on running PaperCut NG on external databases, see Chapter 15, De-
ployment on an External RDBMS.

Database growth is very dependent on the usage patterns and therefore differs signific-
antly from site to site. The best way to predict database growth is based on the rate of print
jobs performed. Although, there is some overhead for other data (like users, groups, print-
ers, etc.), this data is static and does not grow over-time. The majority of database growth
is caused by print and transaction logs.

The growth calculations performed below provide an indication of growth per 1000 or
10000 print jobs. Then using these numbers and your estimate of the rate of printing in
your organization a growth estimate can be made. See Section D.1.3, “Sample database
growth calculation” for an example of this calculation.

D.1.1. Internal database growth

Most PaperCut NG installations use the internal database. This database is suitable for
most organizations, however some prefer to run using an external database (as discussed
in Chapter 15, Deployment on an External RDBMS).

The following graph shows the database size increase with the number of print jobs.
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Figure D.1. Database growth using the internal database

These results show that the internal database grows by approximately 8.5MB per 10,000
print jobs.

D.1.2. SQL Server database growth
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Figure D.2. Database growth using a Microsoft SQL Server database

These results show that the internal database grows by approximately 4.5MB per 10,000
print jobs.

D.1.3. Sample database growth calculation

This section provides a sample of how to estimate the database growth for your environ-
ment. To perform this calculation we need to make a number of assumptions. These as-
sumptions should be adjusted to suit your organization. The assumptions are:

• 1 print job per user per day

• 20 working days in a month

• Therefore, 20 print jobs per user per month

Here is a sample database growth calculation based on a 500 user site using the internal
database:

1. Calculate the total number of print jobs expected for the month. (i.e. the total number
of users multiplied by the number of print jobs). 500 * 20 = 10,000. So in this example,
PaperCut NG is handling 10,000 print jobs a month.

2. Calculate the monthly growth rate by dividing the jobs per month by 10,000 and then
multiplying by the database growth rate (i.e. for the internal DB this is 8.5MB for
10,000 jobs). So, 10,000 / 10,000 * 8.5 = 8.5MB/Month. Therefore in this situation the
internal database will grow by approximately 8.5MB per month.

3. To estimate the growth per year, multiply the above by 12. Therefore in this situation,
the database will grow by 10.2 * 12 = 122.4MB per year.
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Appendix E. Upgrading From a
Previous Version

This appendix describes the PaperCut NG standard upgrade procedure. PaperCut NG
supports upgrades using a simple install-over-the-top procedure. We recommend review-
ing all steps prior to commencing the upgrade procedure.

E.1. The recommended upgrade procedure

1. Download the PaperCut NG installer for your platform. In accordance with best prac-
tice we recommend that you archive your install programs just in case you need to re-
install in the future or roll back to a previous version.

2. Schedule approximately 10 minutes downtime. It is suggested to choose a time of day
with minimal network activity.

3. Take a point-in-time backup of the data by pressing the Backup Now button located
under Options → Backups. This will ensure you have a copy of the important data.

4. As a precaution on very large systems, we recommend backing up the whole Paper-
Cut NG directory. Existing overnight backups may have taken care of this task,
however take a few moments to grab an up-to-date backup now. For example, create
a zip archive of the directory:

C:\Program Files\PaperCut NG\

or the equivalent path on Linux or Mac.

5. Run the installer downloaded in step 1 and install into the same location as the exist-
ing install.

6. After the install is complete, log into the system and perform some tests to ensure all
is working as expected and the system is monitoring user activity as expected.
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Appendix F. Upgrading from
PaperCut Quota

This appendix describes the process for moving from PaperCut Quota to PaperCut NG,
and includes instruction of importing user balances and restriction settings from the old Pa-
perCut Quota installation.

These instructions assume that PaperCut NG will be installed on the same machine as Pa-
perCut Quota, however the instructions can also be applied when PaperCut NG is installed
on a new machine.

F.1. Upgrade process

F.1.1. Step 1 - Stop and disable PaperCut Quota

Firstly the PaperCut Quota services should be stopped to ensure that they do not interfere
with PaperCut NG. You should not uninstall PaperCut Quota at this stage because we
need the user database to import user balances into PaperCut NG.

To stop and disable the PaperCut Quota services:

1. Open the Windows services manager ( Start → Control Panel → Administrative
Tools → Services).

2. Find the PaperCut Print Charging service.

3. Right-click on the server and select the Properties menu.

4. Change the Startup Type to Disabled

5. Press the Stop button to stop the service.

6. Press OK to save the settings changes.

F.1.2. Step 2 - Install PaperCut NG

Install PaperCut NG as discussed in Section 1.4, “Quick Start Guide (for Windows)”.

During the setup wizard, it is recommended that the user import settings be set up in the
same way as was configured in PaperCut Quota. For example, if you import users from the
full Active Directory domain in PaperCut Quota, also set this up in PaperCut NG.

Check that the users have been imported correctly. To adjust the user import settings and
re-perform the user synchronization process, go to the Options → User/Group Sync
screen. This is similar to the Tune-up function in PaperCut Quota.

Once installed it is recommended that the groups are set up in the same way as in Paper-
Cut Quota. Groups are used to determine the default settings for new users and also how
quotas are allocated. For more information on groups see Section 4.1, “Groups in Paper-
Cut NG”.

F.1.3. Step 3 - Configure and test printers

The next step is to set up the printers in PaperCut NG to reflect the require page costs and
print restrictions. To do this:
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1. Navigate to the Printers section.

2. Select the printer to adjust by clicking on the printer name.

3. Enter the cost and filter settings.

4. Press the OK or Apply buttons to save the changes.

For a detailed explanation of setting printer costs and restrictions, see Chapter 5, Ad-
vanced Printer Management.

Tip

If all your printers are configured with similar costs and filters then the settings
can be copied from one printer to the other printers. This is discussed in Sec-
tion 5.2, “Copying Printer Settings”.

Tip

It is recommended that the administrator set up the [template printer].
This printer is used as a template when new printers are added to the system.
The template printer is discussed in detail in Section 5.1, “The Template Print-
er”.

To ensure that the printers are setup correctly, perform a test print to one of the configured
printers. Once printed, check the print log (Printers → Print Log) that the job was recor-
ded and the correct cost calculated.

F.1.4. Step 4 - Import User Balances from PaperCut Quota

Moving the user balances and restricted status from PaperCut Quota to PaperCut NG is a
simple process. If the server is running Windows then:

1. Navigate to the Users section.

2. Click the Batch import ... action (on the left).

3. Press the Browse and locate the PaperCut Quota user database (PCUserDB.mdb).
This is typically located at: C:\Program
Files\PaperCut\Database\PCUserDB.mdb

4. Press the Import button to start the import process.

5. Upon successful completion, the number of users updated and created will be dis-
played.

6. Perform some checks of the user balances and restricted statuses to ensure they are
set to the values from PaperCut Quota.

If the PaperCut NG server is not running on Windows, the PaperCut Quota database con-
verter can be run manually on a Windows system, and the resulting text file can then be
imported in a process similar to the above. To convert the PaperCut Quota user database
manually:

1. Copy the [appdir]/server/bin/win/PCQuotaExport.exe file from the server
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(running the non-windows OS), to the Windows machine running PaperCut Quota.
Copy the exporter to the PaperCut Quota database directory (usually c:\Program
Files\PaperCut\Database).

2. Open the command prompt, by running cmd.exe from Start → Run.

3. Change to the PaperCut Quota database directory. e.g.

cd "c:\Program Files\PaperCut\Database"

4. Run the converter, with the location of the PCUserDB.mdb as the argument. For ex-
ample:

PCQuotaExport.exe "PCUserDB.mdb" > quota-export.txt

If running the exporter from a different directory to the database, the full path to the
database should be provided.

5. The above command creates a text file called quota-export.txt that contains the
user data from PaperCut Quota. The file can be opened in a text editor to review the
contents.

6. The file can then be imported into PaperCut NG. First log in to PaperCut NG.

7. Navigate to the Users section.

8. Click the Batch import ... action (on the left).

9. Press the Browse and locate the quota-export.txt file, created in the above step.

10. Press the Import button to start the import process.

11. Upon successful completion, the number of users updated and created will be dis-
played.

12. Perform some checks of the user balances and restricted statuses to ensure they are
set to the values from PaperCut Quota.

F.1.5. Step 5 - Optionally uninstall PaperCut Quota

Once the PaperCut NG installation is completed and tested you can optionally uninstall Pa-
perCut Quota. If you would like to view historical print data then we recommend keeping
PaperCut Quota installed so you can view the data. If this is not important then PaperCut
Quota can be uninstalled.

To uninstall:

1. On the Windows server running PaperCut Quota, go to: Start → Control Panel →
Add or Remove Programs).

2. Find and select PaperCut Quota in the list of installed programs.

3. Click the Remove button to start the uninstall process.
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Appendix G. Software License
Agreement

THE PROGRAM IS COPYRIGHTED AND LICENSED (NOT SOLD). BY PURCHASING
THE PROGRAM, YOU ARE ACCEPTING AND AGREEING TO THE TERMS OF THIS LI-
CENSE AGREEMENT. THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE
AGREEMENT CONCERNING THE PROGRAM, BETWEEN YOU AND PaperCut Software
Pty Ltd, (REFERRED TO AS "LICENSOR"), AND IT SUPERSEDES ANY PRIOR PRO-
POSAL, REPRESENTATION, OR UNDERSTANDING BETWEEN THE PARTIES.

1. License Grant. Licensor hereby grants to you, and you accept, a nonexclusive license to
use the program in machine-readable, object code form only, for use only as authorized in
this License Agreement. The Programs may be used only on computers owned, leased or
otherwise controlled by you. The program shall only manage the number of user accounts
specified in the purchase agreement. You agree that you may not reverse assemble, re-
verse compile, or otherwise translate the Program.

2. Term (Evaluation Version Only). This License commences upon the installation of the
software and is effective for 30 days following the date you install the software. This Li-
cense terminates automatically without notice from PaperCut Software Pty Ltd upon the
expiration of the evaluation term or if you fail to comply with any provision of this License.
Upon termination you shall remove the SOFTWARE from your computer(s).

3. Licensor's Rights. You acknowledge and agree that the Program is proprietary to Li-
censor and protected under copyright law. You further acknowledge and agree the all right,
title, and interest in and to the Program, including associated intellectual property rights,
are and shall remain with Licensor. The License Agreement does not convey to you an in-
terest in or to the Program, but only a limited right of use revocable in accordance with the
terms of this License Agreement.

4. No Warranty; Limitation of Liability. YOU ACKNOWLEDGE THAT THE PROGRAM IS
PROVIDED ON AN "AS IS" BASIS WITHOUT WARRANTY OF ANY KIND. LICENSOR
MAKES NO REPRESENTATIONS OR WARRANTIES REGARDING THE USE OR PER-
FORMANCE OF THE PROGRAM. LICENSOR EXPRESSLY DISCLAIMS THE WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. LI-
CENSOR SHALL HAVE NO LIABILITY TO CUSTOMER OR ANY THIRD PARTY FOR
ANY LOSS OR DAMAGE CAUSED, DIRECTLY OR INDIRECTLY, BY THE PROGRAM,
INCLUDING, BUT NOT LIMITED TO, ANY INTERRUPTION OF SERVICES, LOSS OF
BUSINESS, LOSS OF DATA OR SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAM-
AGES.

5. Severability. Should any term of this License Agreement be declared void or unenforce-
able by any court of competent jurisdiction, such declaration will have no effect on the re-
maining terms hereof.

6. No Waiver. The failure of either party to enforce any rights granted hereunder or to take
action against the other party in the event of any breach hereunder shall not be deemed a
waiver by that party as to subsequent enforcement of rights or subsequent actions in the
event of future breaches.

7. Update Checks. You acknowledge and agree to allow version and license status details
to be sent to PaperCut Software Pty Ltd when you request to "Check for updates". This al-
lows PaperCut Software Pty Ltd to determine whether software updates are available in
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real-time.
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